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第 1 編 DR2AD model の構造 

1 DR2AD modelの概要 

1.1 DR2AD modelの概要 

Disaster Risk Reduction investment Accounts for Development (DR2AD) model は、長期的

視野にて防災投資効果の定量的評価が可能なラムゼイ型マクロ経済成長モデルである。防災投資

効果と費用を定量的に比較することにより、防災投資の最適配分が可能となる。DR2AD model 
は、災害リスクの軽減や持続可能な開発に資する政策決定ツールとしての役割を果たす。 

DR2AD model 開発の主な目的は以下のとおりである。 

 

 

図 1-1 防災投資の有無による経済成長の評価 

  

１. 防災投資の経済的インパクトを評価すること 
・DR2AD model は、災害被害と家計の所得・消費、企業の生産を関係付ける動学

モデルである。 
２. 複数ある防災投資政策の各々の経済的インパクトを評価すること 
・DR2AD model は、防災投資政策におけるハード対策およびソフト対策のベスト

ミックスを検討可能である。 
３. MDG’s 等の国際目標に対する防災投資の寄与度を評価すること 
・DR2AD model は、災害による所得階層別の影響や社会的格差への影響を評価可

能である。 
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1.2 DR2AD model開発の背景 

2015 年に第 3 回国連防災世界会議において制定された仙台行動枠組では、「人命・暮らし・健

康と、個人・企業・コミュニティ・国の経済的、物理的、社会的、文化的、環境的資産に対する

災害リスク及び損失の大幅な削減」が今後 15 年の成果として期待されている。上記成果を達成

するため、7 つの目標（ターゲット）と 4 つの優先行動を示している。特に、目標においては、

世界の GDP に関連付けての災害による経済損失の減少、優先行動においては、強靭化に向けた

防災への投資が掲げられている。 
実際に、開発途上国における自然災害は国家の経済発展・国家の安定・貧困解消に対して負の

影響を与えやすい。特に、貧困層は一般的に災害被害の影響を受けやすいが、保険や社会保障制

度によってほとんど守られていない。 
国連防災白書 2015 では、例えば適切な災害リスク管理戦略に年間 60 億ドルの投資を世界全

体で行なうことで、新たな都市インフラのわずか 0.1％を占める額でありながらリスク削減の観

点からは総額で 3,600 億ドルのリスク削減、つまり利益となることや、こうした災害リスク軽減

への投資を行なうことで、貧困の撲滅、医療制度および教育制度の拡充、持続可能かつ公平な成

長の保証という国家的および国際的目標の達成の道筋に決定的な違いが生まれる可能性がある

と謳われている。 
こうした状況は、防災に対する必要性の認識が高まっていながら、事前の防災投資効果を評価

する手法が確立されていないために生じていると考えられる。現状で事前の防災投資効果の評価

については、国連開発計画（UNDP）で「被災程度を軽減するため予め 1 ドルを投ずる毎に、災

害時に生じる経済損失の 7 ドル分を回避できる」と謳われる程度の情報にとどまっている。この

ように、国家レベルの防災の事前投資の水準や、防災投資効果が経済成長および貧困問題へどの

程度貢献をしているかなどを明確にする手法は確立されてないと言える。 
以上から、開発途上国における事前の防災投資効果を表す手法を開発し、事前の防災対策の実

施に導くことは、開発途上国の経済発展にとっても、貧困問題の解決のためにも重要と考えられ

る。 
そこで JICA におけるプロジェクト研究を通じて、開発途上国における事前の防災投資による

経済成長及び貧困削減等の効果の評価が可能な防災投資効果評価モデルとして“DR2AD model
（Disaster Risk Reduction investment Accounts for Development）”を開発した。  
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2 DR2AD modelの基本構造 

2.1 DR2AD Model(ver 1.4)の基本構造 

DR2AD model は、新古典派経済成長理論のラムゼイ型最適成長モデルに防災投資の概念を取

り入れたマクロ経済モデルである。本モデルは、開発途上国の経済成長に防災投資がどのように

貢献するかを示す政策決定ツールとして活用することを目的としている。本モデルの基本構造は

以下のとおりである。 
 

 

図 2-1 DR2AD model の構造 

 
DR2AD model は、防災投資の有無で長期的な経済成長の水準が異なることを定量的に示すこ

とが可能なモデルである。防災投資を行うことにより、自然災害に対するレジリエンシーを高め、

人的投資や貯蓄のための資産を自然災害から守ることが可能となり、その結果として長期的な経

済成長が実現可能となる。一方で、防災投資を行わない場合は、自然災害による資産被害の連続

が人々の生活を追い詰め、それが負のスパイラルを導いて人々を貧困の罠へと陥れる。 
次図に、DR2AD model で表現可能な防災投資の有無別の経済成長のイメージを示す。 
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図 2-2 DR2AD model が表現する災害発生による影響のイメージ 
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2.2 DR2AD model(ver1.4)の特徴 

DR2AD model(ver1.4)の特徴として下記があげられる。 
 

2.2.1 全体構造 

・経済成長及び貧困削減等の観点から防災投資効果を評価する。 
・家計と企業の 2 つの経済主体で構成される閉鎖型経済を仮定する。 
・家計を 5 つの所得階層に分類することで、貧困等の階層別の問題を評価可能とする。 
・経済は各階層内で閉じられており、各階層内で家計と企業との市場均衡が達成される。 

 

2.2.2 家計行動 

・家計は 5 つ所得階層が存在する。 
・家計行動は各所得階層における代表的個人を想定する。 
・家計行動は災害のリスク認識を含めて完全合理的であることを前提とする。（すなわち、家計

は災害が起こるというリスクを踏まえたうえで、消費、物的投資、人的投資、貯蓄を行い、

生涯の生涯期待効用を最大化する） 
・家計は、企業に生産要素（労働力、生産資本、土地）を供給し、その対価として所得（労働

所得、利子所得、地代所得）を得る。 
・人的資本の蓄積が貧困削減へ繋がる状況を示すために人的資本をモデルに導入する。教育が

人的資本を成長させるという前提に立ち、就学年数等の教育に係る指標を人的資本の代理変

数として設定することで、人的資本の向上が生産効率を高めるという状況を再現する。 
 

2.2.3 企業行動 

・所得階層毎に代表的企業が存在すると仮定する。 
・企業の生産技術は、規模に関する収穫一定を仮定する。 
・企業は 1 期のみの視野を持つ完全合理的な主体を想定し、毎期の期待利潤の最大化を目的と

して行動する。 
・企業は、家計から生産要素（労働力、生産資本、土地）を需要し、生産により最終財（耐久

財、非耐久財）を家計へ供給する。（なお、家計の貯蓄は、銀行を通じて企業の生産資本に回

るものと仮定する） 
・社会経済構造の変革による急激な技術成長は起こらないものとする。 

 

2.2.4 市場均衡 

・財市場及び生産要素市場が存在し、完全競争的であると仮定する。 
 

2.2.5 災害 

・災害は災害種類毎に、災害発生なしを含む 5 つの災害規模を設定し、毎期いずれかの規模の
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災害（災害なしを含む）が定常的な確率過程に従って発生するものと仮定する。 
・災害は災害種毎に独立した発生過程に従って発生するものとし、2 種の災害が個別に発生す

るケースと、その 2 種類の複合災害を考慮するケースの計 3 ケースを対象とする。 
・保険を含む個人の防災行動概念は含まれていないため、災害被害率の低減は外生的に与えら

れる防災投資によってのみ実現すると仮定する。ただし、防災投資にかかるコストはモデル

では考慮しない。 
 

2.2.6 アウトプット 

・GDP 関数は、人的資本、生産資本、土地からなる Cobb=Douglas 型を仮定する。 
・災害の発生は確率過程に従って発生するため、平均的な防災投資効果の分析にはモンテカル

ロシミュレーションを利用する。 
・次の図に示すように、災害発生時には人的資本や生産要素に被害が生じるため、生産能力の

低下が GDP の減少を導く。 
・防災投資を行った場合には、被害を減少させることが可能となり、生産能力の低下を軽減す

ることが可能である。 
・DR2ADmodel では、災害対策の有無により得られる GDP の差異を防災投資効果として捉え

る。 
 

 
図 2-3 災害発生時の GDP の減少イメージ 

  

 

 
＜通常時＞ 
 
 
 
 
 
 
 
 
＜災害時＞ 
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2.3 DR2AD model(ver1.4)の定式化 

2.3.1 内生変数のリスト 

本モデルで用いた内生変数を以下の表にまとめる。 
 
通番 名称 記号 単位 定義 補足 

1 瞬時的効用 𝑢 ― 代表的家計の効用 Stone-Geary 型を仮定 

2 生涯期待効用 V ― 代表的家計の生涯期待効用  

3 消費 𝑐𝑙 $ 
非耐久財（家屋・家財を除く）の

消費額 

消費額は災害ランク𝑙の

災害発生後に決定 

4 人的資本 ℎ 年 平均就学年数 

代理変数として平均就

学年数を使用 

平均就学年数の向上が

即座に労働生産性の向

上につながると仮定 

5 人的資本形成 𝑚𝑙 年 教育に投じた時間 
教育時間は災害ランク𝑙

の災害発生後に決定 

6 人的投資額 𝜂𝑙(𝑚𝑙) $ 教育に投じた費用 
教育投資額は災害ラン

ク𝑙の災害発生後に決定 

7 物的資産 𝑧 $ 耐久財（家屋や家財）の資産額  

8 物的資産形成 𝜉 $ 物的資産への投資額  

9 金融貯蓄 b $ 

金融貯蓄額 

（所得から支出を差引いた額が

各期の新たな貯蓄額） 

金融貯蓄は、銀行を通じ

て全て生産資本に利用

されると仮定 

10 総資産 𝑎𝑎 $ 
家計が保有する資産の総額 

（物的資産と金融貯蓄の和） 
 

11 賃金率 𝑤𝑙 $/年 1 単位の人的資本に対する賃金 
賃金率は災害ランク𝑙の

災害発生後に決定 

12 利子率 𝑟𝑙 ― 
生産資本（金融貯蓄）に対する利

子 

利子率は災害ランク𝑙の

災害発生後に決定 

13 地代 𝜋𝑙 $/ha 
1 単位の生産可能な土地に対す

る地代 

地代は災害ランク𝑙の災

害発生後に決定 

14 所得 In $ 
賃金所得、資本所得、地代収入の

合計 
 

15 支出 Ex $ 
消費、物的資産形成、教育投資の

合計 
 

16 現在割引率 𝛬 ― 将来の効用に対する現在割引率  

17 生産額(GDP) 𝑌 $ 企業の生産額（GDP） Cobb=Douglas 型を仮定 

18 技術進歩 𝐵 ― 全要素生産性（TFP） 労働、生産資本、土地以



 

8 

外の生産への寄与分を

表現 

19 
人的資本投入

量 
𝐻 年 階層別の人的資本の総和  

20 
生産資本投入

量 
𝐾 $ 階層別の生産資本の総和  

21 生産費用 TC $ 企業の生産費用  

22 企業利潤 Π�𝑙 $ 階層別の企業利潤 

企業利潤は災害ランク𝑙

の災害発生後に決定 

地代として家計に分配 
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2.3.2 外生変数のリスト 

本モデルで用いた外生変数を以下の表にまとめる。 
 

通番 名称 記号 単位 定義 補足 

1 階層別人口 𝑛 人 各所得階層の総人口 
今回は各階層の人口が等しく

なるように設定 

2 
生存最低必要消

費額 
𝑐̅ $ 

生存に最低限必要な消費

額 

貧困の罠を考慮可能とするた

めに導入 

3 時間選好率 𝜌 ― 効用に対する時間選好率 
数値が大きいほど現在の効用

を重視する傾向 

4 
相対的危険回避

度 
𝜃𝜃 ― 家計のリスク選好度 

数値が大きいほどリスクを回

避する傾向 

5 
消費のシェアパ

ラメータ 
𝛾𝑖 ― 消費と物的資産の選好率 

産業連関表またはキャリブレ

ーションにより算出 

𝑖 ∈ {1,2} 

6 人的投資係数 𝜂𝑖 ― 
教育投資額と教育年数の

関係を示す関数の係数 

キャリブレーションにより算

出 

𝑖 ∈ {0,1,2} 

7 
人的資本形成の

補正係数 
𝜍 ― 

教育投資額と教育年数の

関係を補正する係数 

パラメータの特定（キャリブ

レーション）の調整のために

設定 

8 
経済空間の総土

地面積 
𝑇� ha 総土地面積 𝑇� = 𝑇� × 階層数 

9 
各階層の総土地

面積 
𝑇� ha 各階層の総土地面積 𝑇� = 𝑇 × 𝑛 

10 
代表的家計が保

有する土地面積 
𝑇 ha 

代表的家計が保有する土

地面積 

保有する土地面積に応じて地

代配分が決定 

11 人的資本減耗率 𝛿ℎ ― 
毎期の人的資本が減耗す

る割合 

知識の劣化や世代の入替りを

表現 

12 物的資産減耗率 𝛿z ― 
毎期の物的資産が減耗す

る割合 
 

13 生産資本減耗率 𝛿𝑘 ― 
毎期の生産資本が減耗す

る割合 
 

14 外生的成長係数 𝐵0 ― 期初の全要素生産性 
キャリブレーションにより算

出 

15 外生的成長率 𝑔𝑏 ― 技術進歩の程度 
キャリブレーションまたはデ

フォルト値により設定 

16 生産関数のシェ 𝛼𝑖 ― 生産要素の投入割合 𝑖 ∈ {1,2,3} 
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通番 名称 記号 単位 定義 補足 

アパラメータ 

17 災害発生確率 𝜇𝑙 ― 
ランク𝑙の災害が発生する

確率 
 

18 物的資産被害率 𝜑𝑙 ― 
災害により失われる物的

資産の割合 
 

19 生産資本被害率 𝜓𝑙 ― 
災害により失われる生産

資本（金融貯蓄）の割合 
 

20 人的資本被害率 𝜔𝑙 ― 
災害により被害を受ける

人的資本の割合 
 

21 土地被害率 𝜏𝑙 ― 
災害により被害を受ける

土地の割合 
 

22 価値関数の係数 𝜈𝜈𝑖 ―  

キャリブレーションにより算

出 

𝑖 ∈ {0,1,2} 

23 総資産（期初） 𝑎𝑎(0) $ 

期初の家計が保有する資

産の合計額 

（物的資産と金融貯蓄の

和） 

 

24 人的資本（期初） ℎ(0) 年 期初の平均就学年数  
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2.3.3 基本構成式 

 本モデルで用いた基本構成式を以下の表にまとめる。 
 

通番 名称 基本構成式 

1 
瞬時的効用関

数 
𝑢�𝑐𝑙(𝑡), (1 − 𝜑𝑙)𝑧(𝑡)�: =

[(𝑐𝑙(𝑡) − 𝑐̅)γ1{(1 −φ𝑙) ∙ 𝑧(𝑡)}γ2]1−𝜃 − 1
1 − 𝜃𝜃

 

2 
人的資本の蓄

積過程 

ℎ(𝑡 + 1) = (1 − 𝛿ℎ) ∙ ℎ(𝑡) + 𝜍 ∙ 𝑚𝑙(𝑡) 

= ℎ(𝑡) + 𝐻𝑙(𝑡) 

𝐻𝑙(𝑡): = −𝛿ℎ ∙ ℎ(𝑡) + 𝜍 ∙ 𝑚𝑙(𝑡) 

3 教育費用関数 𝜂𝑙(𝑚𝑙) = 𝜂0 + 𝜂1 ∙ 𝑚𝑙 + 𝜂2𝑙 ∙ (𝑚𝑙)2 

4 
物的資産の蓄

積過程 
𝑧(𝑡 + 1) = (1 − 𝛿z)(1 − 𝜑𝑙)𝑧(𝑡) + 𝜉(𝑡), 

5 所得 In(𝑡) = 𝑟𝑙(𝑡)(1－𝜓𝑙)b(t)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(t) +𝜋𝑙(𝑡) ∙ (1 − 𝜏𝑙)𝑇 

6 支出 Ex(𝑡) = 𝑐𝑙(𝑡)  + 𝜂𝑙�𝑚𝑙(𝑡)� + 𝜉(𝑡) 

7 
金融資産の蓄

積過程 

𝑏(𝑡 + 1) = (1－𝜓𝑙)𝑏(𝑡) + In(𝑡) − Ex(𝑡) 

={1+𝑟𝑙(𝑡)}(1－𝜓𝑙)b(𝑡)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +𝜋𝑙(𝑡) ∙ (1 − 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)

− 𝜂𝑙�𝑚𝑙(𝑡)�－𝜉(𝑡) 

8 
総資産の蓄積

過程 

𝑎𝑎(𝑡 + 1) = 𝑎𝑎(𝑡) + 𝑤𝑙(𝑡) ∙ (1 − 𝜔𝑙)ℎ(𝑡) + [𝑟𝑙(𝑡) − {1 + 𝑟𝑙(𝑡)} ∙ 𝜓𝑙] ∙ 𝑎𝑎(𝑡)

+ [(1 − 𝜑𝑙)(1 − 𝛿𝑧) − {1 + 𝑟𝑙(𝑡)}(1 −𝜓𝑙)]𝑧(𝑡) +  𝜋𝑙(𝑡)

∙ (1 − 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡) − 𝜂𝑙�𝑚𝑙(𝑡)� 

= 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 
𝑙(𝑡) ≔ 𝑤𝑙(𝑡) ∙ (1−𝜔𝑙)ℎ(𝑡) + [𝑟𝑙(𝑡)− {1 + 𝑟𝑙(𝑡)} ∙ 𝜓𝑙] ∙ 𝑎𝑎(𝑡)

+ [(1− 𝜑𝑙)(1− 𝛿𝑧) − {1 + 𝑟𝑙(𝑡)}(1− 𝜓𝑙)]𝑧(𝑡) + 𝜋𝑙(𝑡)

∙ (1− 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)� 

9 価値関数 
V�𝑎𝑎(𝑡), ℎ(𝑡),𝐵(𝑡)� ∙ �

1
1 + 𝜌

�
𝑡

= max  E �� 𝑢�𝑐𝑙(𝑡′), (1 − φ𝑙)𝑧(𝑡′)� ∙ �
1

1 + 𝜌
�
𝑡′∞

𝑡′=𝑡

� 

10 現在割引率 𝛬 =  �
1

1 + 𝜌
� 

11 

生涯期待効用

最大化の一階

条件 

（消費） 

𝑢𝑐(𝑐𝑙 , (1 − 𝜑𝑙)𝑧) = 𝛬 ∙ 𝑉𝑉𝑎 
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通番 名称 基本構成式 

12 

生涯期待効用

最大化の一階

条件 

（物的資産） 

�𝜇𝑙
𝑙

{𝑢𝑧(𝑐𝑙 , (1 − 𝜑𝑙)𝑧) + 𝛬 ∙ 𝑉𝑉𝑎 ∙ (1 − 𝜑𝑙)(1 − 𝛿𝑧)}

= 𝛬 ∙ 𝑉𝑉𝑎�𝜇𝑙{𝐹𝑏 + (1 − 𝜓𝑙)(1 − 𝛿𝑘)}
𝑙
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生涯期待効用

最大化の一階

条件 

（教育時間） 

𝑉𝑉ℎ ∙ 𝜍＝𝑉𝑉𝑎 ∙ 𝜂𝑙′(𝑚𝑙) 

14 生産関数 
𝑌(𝑡) = 𝐹�𝐵(𝑡), (1 −𝜔𝑙)𝐻(𝑡), (1 − 𝜓𝑙)𝐾(𝑡), (1 − 𝜏𝑙)𝑇�� 

=  𝐵(𝑡){(1 − 𝜔𝑙)𝐻(𝑡)}α1{(1 − 𝜓𝑙)𝐾(𝑡)}α2{(1 − 𝜏𝑙)𝑇�}α3 

15 全要素生産性 𝐵(𝑡) = 𝐵0 ∙ (1 + 𝑔𝑏)𝑡−1 

16 
人的資本投入

量 
𝐻(𝑡) = 𝑛 ∙ ℎ(𝑡) 

17 
生産資本投入

量 
𝐾(𝑡) = 𝑛 ∙ 𝑏(𝑡) 

18 費用関数 C(t) = 𝑤𝑙(𝑡) ∙ (1 −𝜔𝑙)𝐻(𝑡) + {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1− 𝜓𝑙)𝐾(𝑡) 

19 利潤関数 
Π�𝑙(𝑡) = 𝑌(𝑡) − 𝑇𝐶(𝑡) 

=  𝐹�𝐵(𝑡), (1 −𝜔𝑙)𝐻(𝑡), (1 −𝜓𝑙)𝐾(𝑡), (1 − 𝜏𝑙)𝑇�� − 𝑤𝑙(𝑡) ∙ (1 − 𝜔𝑙)𝐻(𝑡)

− {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1 − 𝜓𝑙)𝐾(𝑡) 

20 

利潤最大化の

一階条件 

（人的資本投

入量） 

∂𝐹�𝐵(𝑡), (1 − 𝜔𝑙)𝐻(𝑡), (1 − 𝜓𝑙)𝐾(𝑡), (1 − 𝜏𝑙)𝑇��
∂𝐻

= 𝑤𝑙(𝑡) ∙ (1 − 𝜔𝑙) 

21 

利潤最大化の

一階条件 

（生産資本投

入量） 

∂𝐹�𝐵(𝑡), (1 − 𝜔𝑙)𝐻(𝑡), (1 − 𝜓𝑙)𝐾(𝑡), (1 − 𝜏𝑙)𝑇��
∂𝐾

= {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1 − 𝜓𝑙) 

22 

生産可能な土

地あたりの地

代 
𝜋𝑙(𝑡)=

Π�𝑙(𝑡)
(1 − 𝜏𝑙)𝑇�

=
Π�𝑙(𝑡)

(1 − 𝜏𝑙)𝑛𝑇
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2.3.4 基本構成式の展開 

（1）家計 

代表的家計は、以下の生涯期待効用が最大になるように行動する。その際、代表的家計は災害

リスクを認知しながら行動し、毎期の所得（労働所得、利子所得、地代収入）と総資産（これま

でに蓄積した資本）を、消費、物的投資、人的投資、金融貯蓄に配分する。 

𝐸 ��𝑢(𝑐𝑙(𝑡), (1− φ𝑙)𝑧(𝑡)) �
1

1 + 𝜌
�
𝑡∞

𝑡=0

�, 

(1) 

where 
E：期待値操作 
𝑢：瞬時的効用 
𝑐𝑙：消費（非耐久財）（災害ランク𝑙の災害発生後） 
𝑧：物的資産（耐久財） 
𝜌：時間選好率 

 
瞬時的効用関数は、代表的家計が貧困の罠に陥ることを表現可能な Stone-Geary 型を用いる。

すなわち、災害被害により消費𝑐𝑙が生存最低必要消費額𝑐̅に接近すると、消費の限界効用が高まっ

て消費が優先されるようになり、人的資本や金融貯蓄などの資本形成が後回しにされる結果、貧

困の罠から抜け出せなるという状況を表現可能とする。また、全ての階層で同じ選好を持つとす

る。 

𝑢 �𝑐𝑙(𝑡), (1− 𝜑𝑙)𝑧(𝑡)� : =
[(𝑐𝑙(𝑡) − 𝑐̅)γ1{(1− φ𝑙) ∙ 𝑧(𝑡)}γ2]1−𝜃 − 1

1− 𝜃𝜃
, 

(2) 

s.t. 
𝛾1 + 𝛾2 = 1   (0 < 𝛾1, 𝛾2 < 1), 
𝜃𝜃 > 0, 

where 
𝑐̅：生存最低必要消費額 

𝛾𝑖：消費のシェアパラメータ、𝑖 ∈ {1,2} 

𝜃𝜃：相対的危険回避度 

 
 代表的家計は、将来の消費に備えて金融貯蓄を行う。代表的家計の各期の所得（労働所得、利

子所得、地代収入）をIn(𝑡)、支出（消費、人的投資、物的投資）をEx(𝑡)と置くと、所得と支出の

差額が各期の新たな金融貯蓄∆𝑏となる。 
∆𝑏(𝑡) = In(t)− Ex(t), 

In(𝑡) = 𝑟𝑙(𝑡)(1－𝜓𝑙)b(t)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(t) +𝜋𝑙(𝑡) ∙ (1 − 𝜏𝑙)𝑇, 

Ex(𝑡) = 𝑐𝑙(𝑡)  + 𝜂𝑙�𝑚𝑙(𝑡)� + 𝜉(𝑡). 
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(3) 

where 
h：人的資本 
b：金融貯蓄（生産資本） 
𝑇：代表的家計が保有する土地の面積 
𝑤𝑙：賃金率（災害ランク𝑙の災害発生後） 
𝑟𝑙：利子率（災害ランク𝑙の災害発生後） 
𝜋𝑙：地代（災害ランク𝑙の災害発生後） 
𝛿𝑘：生産資本減耗率 
𝜔𝑙：人的資本被害率（災害ランク𝑙） 
𝜓𝑙：生産資本被害率（災害ランク𝑙） 
𝜏𝑙：土地被害率（災害ランク𝑙） 
𝜂𝑙：人的投資額（災害ランク𝑙の災害発生後） 
𝑚𝑙：人的資本形成 
𝜉：物的資産形成 

災害ランク𝑙の災害により、人的資本、金融資産（生産資本）、土地は、それぞれ𝜓𝑙 ,𝜔𝑙 , 𝜏𝑙の被害

を受けるため、災害規模が大きいほど代表的家計の所得は減少する。 

上述を踏まえ、金融貯蓄𝑏の蓄積過程を記述すると以下のとおりになる。 
𝑏(𝑡 + 1) = (1－𝜓𝑙)𝑏(𝑡) + ∆𝑏(𝑡) 

= (1－𝜓𝑙)𝑏(𝑡) + In(t)− Ex(t), 

={1 + 𝑟𝑙(𝑡)}(1－𝜓𝑙)b(𝑡)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�－𝜉(𝑡), 

(4) 

 
 消費は非耐久財であるのに対し、物的資産は耐久財を指し、具体的には家屋や家財といったス

トックを表す。物的資産は毎期の𝛿zの割合で減耗するとともに、災害発生時には𝜑𝑙の割合が失わ

れるものとする。 
物的資産の蓄積過程は以下のとおりになる。 

𝑧(𝑡 + 1) = (1 − 𝛿z)(1− 𝜑𝑙)𝑧(𝑡) + 𝜉(𝑡), 
(5) 

 
人的資本は、労働生産性に関する資産であり、人的資本が大きいほど多くの労働所得を得るこ

とができるものとする。災害による損失はないが、災害が起きた期の人的資本は一時的に低下し

て労働生産性の低下へ繋がるものと仮定する。 
また、物的資産と同様に、人的資本も毎期𝛿ℎの割合で減耗する。これにより、知識は放ってお

くと一様に劣化するという状況を表現するとともに、知識の陳腐化による取り替え、労働人口の

入れ替わりを含む減耗を考慮することにより世代の入れ替わり（人的資本の高い世代が死亡し、

低い世代が誕生する）を反映している。 
 人的資本の蓄積過程は以下のとおりになる。 
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ℎ(𝑡 + 1) = (1 − 𝛿ℎ) ∙ ℎ(𝑡) + 𝜍 ∙ 𝑚𝑙(𝑡) 
= ℎ(𝑡) +𝐻𝑙(𝑡), 

𝐻𝑙(𝑡): = −𝛿ℎ ∙ ℎ(𝑡) + 𝜍 ∙ 𝑚𝑙(𝑡), 
(6) 

where 
𝛿ℎ：人的資本減耗率 
𝜍：人的資本形成の補正係数 

人的資本を表す労働生産性の実データの取得が困難なため、平均就学年数を代理変数として置く。

代理変数として他にも平均就学率や平均識字率などが考えられるが、ストックとしての扱い考慮

した場合、就学年数が適切と考え代理変数として選択した（就学率や識字率は、個人レベルで考

えると 1 又は 0 のいずれかとなる）。本来は人的資本の成長と労働生産性の向上とは時間的なギャ

ップが存在するが、データ制約の関係から、ここでは人的資本の向上が、即時に労働生産性の向

上へ繋がるものと仮定する。 
なお、ケーススタディの際に必要となるパラメータの特定（キャリブレーション）の調整のた

め、時間的調整費用に関連した補正係数として𝜍を設定したが、調整が不要な場合は𝜍 = 1とする。 
 
 代表的家計は、地主として、初期時点から一定の土地を所有しているものとし、全ての土地を

企業に貸与することで、その対価としての地代収入を得る。 

𝑇＝
𝑇�
𝑛

, 

𝑇� = �𝑇�
𝑗

, 

(7) 

where 
𝑇�：各階層の総土地面積 
𝑇�：経済空間の総土地面積 
𝑛：階層別人口 

 
 

  



 

16 

（2）企業 

 企業は、以下の Cobb=Douglas 型関数に従って生産を行い、生産には労働、資本、土地の 3 生

産要素を要するものと仮定する。生産は、災害発生後に行われるものとし、生産要素の投入量は

災害の被害を考慮したものとする。 
𝑌(𝑡) = 𝐹�𝐵(𝑡), (1 −𝜔𝑙)𝐻(𝑡), (1− 𝜓𝑙)𝐾(𝑡), (1− 𝜏𝑙)𝑇�� 

=  𝐵(𝑡){(1−𝜔𝑙)𝐻(𝑡)}α1{(1− 𝜓𝑙)𝐾(𝑡)}α2{(1− 𝜏𝑙)𝑇�}α3, 

𝐵(𝑡) = 𝐵0 ∙ (1 + 𝑔𝑏)𝑡−1, 

𝐻(𝑡) = 𝑛 ∙ ℎ(𝑡), 

𝐾(𝑡) = 𝑛 ∙ 𝑏(𝑡), 

(8) 

s.t. 
𝛼1 + 𝛼2 + 𝛼3 = 1 (0 < 𝛼1,𝛼2,𝛼3 < 1), 

where 
𝑌：生産関数 
𝐵：全要素生産性 
𝐵0：外生的成長係数 
𝑔𝑏：外生的成長率 
𝐻：人的資本投入量 
𝐾：生産資本投入量 
𝛼𝑖：生産関数のシェアパラメータ、𝑖 ∈ {1,2,3} 

生産関数のシェアパラメータ𝛼𝑖は、完全競争下における各生産要素の分配率を表している。 
 
企業は、家計が供給する労働と生産資本に対する対価として賃金と利子を支払う。また、生産

資本ストックは毎期𝛿𝑘の割合で減耗すると仮定し、その充填分の費用も考慮に入れる。 
TC(t) = 𝑤𝑙(𝑡) ∙ (1 −𝜔𝑙)𝐻(𝑡) + {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1− 𝜓𝑙)𝐾(𝑡), 

(9) 

where 
TC：生産費用 

 
 これらを踏まえて、企業の利潤関数を以下のとおり設定する。企業は、生産額から生産費用を

差し引いた利潤が最大となるように行動する。利潤は、各家計へ地代として分配される。 
Π�𝑙(𝑡) = 𝑌(𝑡)− 𝑇𝐶(𝑡) 

=  𝐹�𝐵(𝑡), (1 −𝜔𝑙)𝐻(𝑡), (1− 𝜓𝑙)𝐾(𝑡), (1− 𝜏𝑙)𝑇�� − 𝑤𝑙(𝑡) ∙ (1−𝜔𝑙)𝐻(𝑡)− {𝑟𝑙(𝑡) + 𝛿𝑘}

∙ (1− 𝜓𝑙)𝐾(𝑡). 
(10) 
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（3）市場均衡 

1）効用最大化 

 代表的家計が保有する金融資産と物的資産を合計したものを総資産とする。総資産を設定する

ことで、制御変数の一つである物的資本形成をキャンセルアウトすることが可能となる。 
𝑎𝑎(𝑡) ≔ 𝑏(𝑡) + 𝑧(𝑡), 

(11) 

where 
𝑎𝑎：総資産 

 (11)を𝑡 + 1期にて計算すると、𝑏(𝑡 + 1)に関する式(4)、𝑧(𝑡 + 1)に関する式(5)を用いることで 
𝑎𝑎(𝑡 + 1) = 𝑏(𝑡 + 1) + 𝑧(𝑡 + 1) 

={1 + 𝑟𝑙(𝑡)}(1－𝜓𝑙)b(𝑡)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)−

𝜂𝑙 �𝑚𝑙(𝑡)�－𝜉(𝑡) + (1− 𝛿z)(1− 𝜑𝑙)𝑧(𝑡) + 𝜉(𝑡) 

={1 + 𝑟𝑙(𝑡)}(1－𝜓𝑙)b(𝑡)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�+

(1− 𝛿z)(1− 𝜑𝑙)𝑧(𝑡) 
(12) 

ここで、(12)に𝑏(𝑡) = 𝑎𝑎(𝑡)− 𝑧(𝑡)を代入して、右辺を整理すると、総資産の蓄積過程は以下のよう

に記述できる。 
𝑎𝑎(𝑡 + 1) = 𝑎𝑎(𝑡) + 𝑤𝑙(𝑡) ∙ (1−𝜔𝑙)ℎ(𝑡) + [𝑟𝑙(𝑡)− {1 + 𝑟𝑙(𝑡)} ∙ 𝜓𝑙] ∙ 𝑎𝑎(𝑡)

+ [(1− 𝜑𝑙)(1− 𝛿𝑧) − {1 + 𝑟𝑙(𝑡)}(1− 𝜓𝑙)]𝑧(𝑡) + 𝜋𝑙(𝑡) ∙ (1 − 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)

− 𝜂𝑙 �𝑚𝑙(𝑡)� 

= 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 
𝐴𝑙(𝑡) ≔ 𝑤𝑙(𝑡) ∙ (1 −𝜔𝑙)ℎ(𝑡) + [𝑟𝑙(𝑡)− {1 + 𝑟𝑙(𝑡)} ∙ 𝜓𝑙] ∙ 𝑎𝑎(𝑡)

+ [(1−𝜑𝑙)(1− 𝛿𝑧) − {1 + 𝑟𝑙(𝑡)}(1− 𝜓𝑙)]𝑧(𝑡) + 𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�. 

(13) 

 
代表的家計の最適化問題は、以下のように記述される。価値関数は、代表的家計が毎期、最適

な消費、人的投資、物的資産形成を行った結果達成される生涯期待効用の最大値を表す。価値関

数を設定することにより、生涯期待効用最大化問題を解くことが可能になる。 

V�𝑎𝑎(𝑡),ℎ(𝑡),𝐵(𝑡)� ∙ �
1

1 + 𝜌
�
𝑡

= max  E �� 𝑢 �𝑐𝑙(𝑡′), (1− φ𝑙)𝑧(𝑡′)� ∙ �
1

1 + 𝜌
�
𝑡′∞

𝑡′=𝑡

�, 

(14) 

s.t. 
𝑏(𝑡 + 1) = {1 + 𝑟𝑙(𝑡)}(1－𝜓𝑙)b(𝑡)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +𝜋𝑙(𝑡) ∙ (1 − 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)

− 𝜂𝑙 �𝑚𝑙(𝑡)�－𝜉(𝑡), 
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𝑧(𝑡 + 1) = (1− 𝛿z)(1−𝜑𝑙)𝑧(𝑡) + 𝜉(𝑡), 
ℎ(𝑡 + 1) = ℎ(𝑡) +𝐻𝑙(𝑡). 

(15) 

金融貯蓄と物的資産を合計して総資産とすると、(15)の制約条件式は以下の 2 本の方程式で表さ

れる。 
𝑎𝑎(𝑡 + 1) = 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 
ℎ(𝑡 + 1) = ℎ(𝑡) + 𝐻𝑙(𝑡). 

(16) 

 
これ以降、時間選好率の項を以下のように置くものとする。 

𝛬 =  �
1

1 + 𝜌
�. 

(17) 

 
 (14)のBellman方程式 1

 (18) 

を求めると、 

𝑉𝑉�𝑎𝑎(𝑡),ℎ(𝑡),𝐵(𝑡)� = max 𝐸 �𝑢 �𝑐𝑙(𝑡), (1− 𝜑𝑙)𝑧(𝑡)�+ 𝛬 ∙ 𝑉𝑉�𝑎𝑎(𝑡 + 1),ℎ(𝑡 + 1),𝐵(𝑡 + 1)�� 

= max 𝐸 �𝑢 �𝑐𝑙(𝑡), (1 −𝜑𝑙)𝑧(𝑡)�+ 𝛬

∙ 𝑉𝑉 �𝑎𝑎(𝑡) + 𝐴𝑙(𝑡),ℎ(𝑡) + 𝐻𝑙(𝑡),𝐵(𝑡) + 𝐵°(𝑡)��, 

where 𝑩°(𝒕) = 𝑩(𝒕 + 𝟏) −𝑩(𝒕).  さらに Taylor 展開にて、(18)の右辺第二項を一次近似すると、 

𝑉𝑉�𝑎𝑎(𝑡),ℎ(𝑡),𝐵(𝑡)� = max �𝜇𝑙
𝑙

�
𝑢 �𝑐𝑙(𝑡), (1− 𝜑𝑙)𝑧(𝑡)�

+𝛬 ∙ {𝑉𝑉 + 𝑉𝑉𝑎 ∙ 𝐴𝑙(𝑡) + 𝑉𝑉ℎ ∙ 𝐻𝑙(𝑡) + 𝑉𝑉𝐵 ∙ 𝐵°(𝑡)}
�. 

(19) 

(19)より、以下のように目的関数を記述することができる。 
(1− Λ) ∙ 𝑉𝑉�𝑎𝑎(𝑡),ℎ(𝑡),𝐵(𝑡)�

= max  �𝜇𝑙
𝑙

�𝑢 �𝑐𝑙(𝑡), (1 −𝜑𝑙)𝑧(𝑡)�+ 𝛬 ∙ {𝑉𝑉𝑎 ∙ 𝐴𝑙(𝑡) + 𝑉𝑉ℎ ∙ 𝐻𝑙(𝑡) + 𝑉𝑉𝐵 ∙ 𝐵°(𝑡)}�. 

(20) 

 
 生涯期待効用を最大化するための(20)の一階条件（目的関数を c, m, z にて偏微分）より、 

𝜕𝑉𝑉(𝑎𝑎, ℎ,𝐵)
𝜕𝑐𝑙

= 0, 

𝜕𝑉𝑉(𝑎𝑎, ℎ,𝐵)
𝜕𝑧

= 0, 

                                                   
 
1 参考：新しいマクロ経済学(p.223-225)、齊藤誠、有斐閣 
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𝜕𝑉𝑉(𝑎𝑎, ℎ,𝐵)
𝜕𝑚𝑙 = 0. 

(21) 

(21)より、以下の 3 本の方程式が得られる。 
𝑐𝑙： 𝑢𝑐(𝑐𝑙 , (1− 𝜑𝑙)𝑧) = 𝛬 ∙ 𝑉𝑉𝑎 , 

(22) 

 𝑧： �𝜇𝑙
𝑙

{𝑢𝑧(𝑐𝑙 , (1− 𝜑𝑙)𝑧) + 𝛬 ∙ 𝑉𝑉𝑎 ∙ (1− 𝜑𝑙) ∙ (1− 𝛿𝑧)} = 𝛬 ∙ 𝑉𝑉𝑎�𝜇𝑙(1 −𝜓𝑙){𝑟(𝑡) + 1}
𝑙

, 

(23) 

𝑚𝑙： 𝑉𝑉ℎ ∙ 𝜍＝𝑉𝑉𝑎 ∙ {𝜂𝑙(𝑚𝑙)}′. 

(24) 
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2）利潤最大化 

 企業は、以下の利潤関数を最大にするよう行動する。 
Max   Π�𝑙(𝑡) = 𝑌(𝑡)− 𝑇𝐶(𝑡) 
= 𝐹�𝐵(𝑡), (1 −𝜔𝑙)𝐻(𝑡), (1− 𝜓𝑙)𝐾(𝑡), (1− 𝜏𝑙)𝑇�� − 𝑤𝑙(𝑡) ∙ (1−𝜔𝑙)𝐻(𝑡)− {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1− 𝜓𝑙)𝐾(𝑡) 

(25) 

where 
Π�𝑙：企業利潤（災害ランク𝑙の災害発生後） 

 
利潤を最大化するための(25)の一階条件（目的関数を H, K にて偏微分）より、 

𝜕Π�𝑙
𝜕𝐻

= 0, 

𝜕Π�𝑙
𝜕𝐾

= 0. 

(26) 

(26)より、以下の 2 本の方程式が得られる。 

𝐻：
∂𝐹�𝐵(𝑡), (1−𝜔𝑙)𝐻(𝑡), (1− 𝜓𝑙)𝐾(𝑡), (1 − 𝜏𝑙)𝑇��

∂𝐻
= 𝑤𝑙(𝑡) ∙ (1−𝜔𝑙), 

(27) 

𝐾：
∂𝐹�𝐵(𝑡), (1 −𝜔𝑙)𝐻(𝑡), (1− 𝜓𝑙)𝐾(𝑡), (1− 𝜏𝑙)𝑇��

∂𝐾
= {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1− 𝜓𝑙), 

(28) 

s.t. 
0 < 𝜇𝑙 < 1, 

where 
𝜇𝑙：災害発生確率（災害ランク𝑙） 

一階条件式は、それぞれ労働と生産資本に関して、要素投入量はその限界生産量と限界費用が等

しくなるよう決定されることを示している。 
 
企業利潤Π�𝑙は全て地代として家計に配分され、その配分額は保有する土地面積の割合に応じて

決定される。 

𝜋𝑙(𝑡)=
Π�𝑙(𝑡)

(1− 𝜏𝑙)𝑇�
=

Π�𝑙(𝑡)
(1− 𝜏𝑙)𝑛𝑇

. 

(29) 
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3）市場均衡 

 生涯期待効用最大化の一階条件(22)、(23)、(24)と利潤最大化の一階条件(27)、(28)により導出

された計 5 本の方程式を同時に解くことにより、市場均衡解が一意に定まる。以下、各方程式の

再掲である。 
𝑐𝑙： 𝑢𝑐(𝑐𝑙 , (1− 𝜑𝑙)𝑧) = 𝛬 ∙ 𝑉𝑉𝑎 , 

 𝑧： �𝜇𝑙
𝑙

{𝑢𝑧(𝑐𝑙 , (1 −𝜑𝑙)𝑧) + 𝛬 ∙ 𝑉𝑉𝑎 ∙ (1− 𝜑𝑙) ∙ (1− 𝛿𝑧)}

= 𝛬 ∙ 𝑉𝑉𝑎�𝜇𝑙(1 −𝜓𝑙){𝑟(𝑡) + 1}
𝑙

, 

𝑚𝑙： 𝑉𝑉ℎ ∙ 𝜍＝𝑉𝑉𝑎 ∙ {𝜂𝑙(𝑚𝑙)}′, 

𝐻：
∂𝐹�𝐵(𝑡), (1−𝜔𝑙)𝐻(𝑡), (1− 𝜓𝑙)𝐾(𝑡), (1 − 𝜏𝑙)𝑇��

∂𝐻
= 𝑤𝑙(𝑡) ∙ (1 −𝜔𝑙), 

𝐾：
∂𝐹�𝐵(𝑡), (1−𝜔𝑙)𝐻(𝑡), (1− 𝜓𝑙)𝐾(𝑡), (1− 𝜏𝑙)𝑇��

∂𝐾
= {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1− 𝜓𝑙). 

(30) 
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（4）社会最適化 

本モデルでは外部性を入れていないため、市場均衡解は社会最適解と等価になる。その際、生

産額と分配額が等しくなることから、以下の方程式が成り立つ。 
𝐹(𝐵(𝑡), (1−𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇) 

= 𝑤𝑙(𝑡) ∙ (1−𝜔𝑙)ℎ(𝑡) + {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1− 𝜓𝑙)𝑏(𝑡) + 𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇. 
(31) 

 
(31)を用いると、(4)は次のように書き換えられる。 

𝑏(𝑡 + 1) = {1 + 𝑟𝑙(𝑡)}(1－𝜓𝑙)b(𝑡)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�－𝜉(𝑡) 

= {𝑟𝑙(𝑡) + 𝛿𝑘}(1－𝜓𝑙)b(𝑡)+ 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�－𝜉(𝑡)

+ (1－𝛿𝑘)(1－𝜓𝑙)b(𝑡) 

= 𝐹(𝐵(𝑡), (1−𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇)− 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�－𝜉(𝑡)

+ (1－𝛿𝑘)(1－𝜓𝑙)b(𝑡). 
(32) 

 
また、(31)より、(12)は次のように書き換えられる。 

𝑎𝑎(𝑡 + 1) = 𝑏(𝑡 + 1) + 𝑧(𝑡 + 1) 

=  𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +{1 + 𝑟𝑙(𝑡)}(1－𝜓𝑙)b(𝑡)+𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�

+ (1− 𝛿z)(1− 𝜑𝑙)𝑧(𝑡) 

= 𝑤𝑙(𝑡)∙(1－𝜔𝑙)h(𝑡) +{𝑟𝑙(𝑡) + 𝛿𝑘}(1－𝜓𝑙)b(𝑡)+𝜋𝑙(𝑡) ∙ (1 − 𝜏𝑙)𝑇 − 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)� +

(1− 𝛿z)(1− 𝜑𝑙)𝑧(𝑡) + (1 − 𝛿𝑘)(1－𝜓𝑙)b(𝑡) 
=𝑎𝑎(𝑡) + 𝑤𝑙(𝑡) ∙ (1−𝜔𝑙)ℎ(𝑡) + {𝑟𝑙(𝑡) + 𝛿𝑘} ∙ (1− 𝜓𝑙)b(𝑡) + 𝜋𝑙(𝑡) ∙ (1− 𝜏𝑙)𝑇 − {𝛿𝑘 +

(1− 𝛿𝑘) ∙ 𝜓𝑙}𝑎𝑎(𝑡)− 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)� − {(1− 𝜓𝑙)(1− 𝛿𝑘)− (1− 𝜑𝑙)(1− 𝛿𝑧)}𝑧(𝑡) 

=𝑎𝑎(𝑡) + 𝐹(𝐵(𝑡), (1−𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇)− {𝛿𝑘 + (1− 𝛿𝑘) ∙ 𝜓𝑙}𝑎𝑎(𝑡)− 𝑐𝑙(𝑡)−

𝜂𝑙 �𝑚𝑙(𝑡)� − {(1− 𝜓𝑙)(1− 𝛿𝑘)− (1− 𝜑𝑙)(1− 𝛿𝑧)}𝑧(𝑡) 

= 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 

𝐴𝑙(𝑡) ≔ 𝐹(𝐵(𝑡), (1−𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇)− {𝛿𝑘 + (1− 𝛿𝑘) ∙ 𝜓𝑙}𝑎𝑎(𝑡)− 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�

− {(1− 𝜓𝑙)(1− 𝛿𝑘)− (1− 𝜑𝑙)(1− 𝛿𝑧)}𝑧(𝑡). 
(33) 
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 一般に市場均衡解よりも社会最適解の方が、式と変数が少なくなり計算が容易になるため、本

モデルでは社会最適化問題にて解析を行う。よって、これ以降は代表的家計の生涯期待効用を最

大にしようと努める善意の社会的計画者によって経済が運営されていると想定し、家計側のみに

着目して問題を解くものとする。 

V�𝑎𝑎(𝑡),ℎ(𝑡),𝐵(𝑡)� ∙ �
1

1 + 𝜌
�
𝑡

= max  E �� 𝑢 �𝑐𝑙(𝑡′), (1− φ𝑙)𝑧(𝑡′)� ∙ �
1

1 + 𝜌
�
𝑡′∞

𝑡′=𝑡

�, 

(34) 

s.t. 

𝑏(𝑡 + 1) = 𝐹(𝐵(𝑡), (1−𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇)− 𝑐𝑙(𝑡)− 𝜂𝑙 �𝑚𝑙(𝑡)�－𝜉(𝑡)

+ (1－𝛿𝑘)(1－𝜓𝑙)b(𝑡), 
𝑧(𝑡 + 1) = (1− 𝛿z)(1−𝜑𝑙)𝑧(𝑡) + 𝜉(𝑡), 

ℎ(𝑡 + 1) = ℎ(𝑡) + 𝐻𝑙(𝑡). 
(35) 

金融貯蓄と物的資産を合計して総資産とすると、(35)の制約条件式は以下の 2 本の方程式で表さ

れる。 
𝑎𝑎(𝑡 + 1) = 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 
ℎ(𝑡 + 1) = ℎ(𝑡) + 𝐻𝑙(𝑡). 

(36) 

 
また、時間選好率の項を以下のように置くものとする。 

𝛬 =  �
1

1 + 𝜌
�. 

(37) 

 (34)のBellman方程式 2

(38) 

を求めると、 

𝑉𝑉�𝑎𝑎(𝑡),ℎ(𝑡),𝐵(𝑡)� = max 𝐸 �𝑢 �𝑐𝑙(𝑡), (1− 𝜑𝑙)𝑧(𝑡)�+ 𝛬 ∙ 𝑉𝑉�𝑎𝑎(𝑡 + 1),ℎ(𝑡 + 1),𝐵(𝑡 + 1)�� 

= max 𝐸 �𝑢 �𝑐𝑙(𝑡), (1 −𝜑𝑙)𝑧(𝑡)�+ 𝛬

∙ 𝑉𝑉 �𝑎𝑎(𝑡) + 𝐴𝑙(𝑡),ℎ(𝑡) + 𝐻𝑙(𝑡),𝐵(𝑡) + 𝐵°(𝑡)��, 

where 𝐵°(𝑡) = 𝐵(𝑡 + 1)− 𝐵(𝑡).  さらに Taylor 展開にて、右辺第二項を一次近似すると、 
𝑉𝑉�𝑎𝑎(𝑡),ℎ(𝑡),𝐵(𝑡)�

= max �𝜇𝑙
𝑙

�𝑢 �𝑐𝑙(𝑡), (1− 𝜑𝑙)𝑧(𝑡)�+ 𝛬 ∙ {𝑉𝑉 + 𝑉𝑉𝑎 ∙ 𝐴𝑙(𝑡) + 𝑉𝑉ℎ ∙ 𝐻𝑙(𝑡) + 𝑉𝑉𝐵 ∙ 𝐵°(𝑡)}� 

(39) 

                                                   
 
2 参考：新しいマクロ経済学(p.223-225)、齊藤誠、有斐閣 
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(39)の左辺を𝑉𝑉で括ると、以下のように目的関数を記述することができる。 
(1− Λ) ∙ 𝑉𝑉�𝑎𝑎(𝑡),ℎ(𝑡),𝐵(𝑡)�

= max  �𝜇𝑙
𝑙

�𝑢 �𝑐𝑙(𝑡), (1 −𝜑𝑙)𝑧(𝑡)�+ 𝛬 ∙ {𝑉𝑉𝑎 ∙ 𝐴𝑙(𝑡) + 𝑉𝑉ℎ ∙ 𝐻𝑙(𝑡) + 𝑉𝑉𝐵 ∙ 𝐵°(𝑡)}�, 

(40) 

 
 目的関数(40)に対し、社会最適化の一階条件より、 

𝜕𝑉𝑉(𝑎𝑎, ℎ,𝐵)
𝜕𝑐𝑙

= 0, 

𝜕𝑉𝑉(𝑎𝑎, ℎ,𝐵)
𝜕𝑧

= 0, 

𝜕𝑉𝑉(𝑎𝑎, ℎ,𝐵)
𝜕𝑚𝑙 = 0. 

(41) 

 
これより、以下の 3 本の方程式が得られる。 

𝑐𝑙： 𝑢𝑐(𝑐𝑙, (1− 𝜑𝑙)𝑧) = 𝛬 ∙ 𝑉𝑉𝑎 , 
(42) 

𝑧： �𝜇𝑙
𝑙

{𝑢𝑧(𝑐𝑙 , (1 − 𝜑𝑙)𝑧) + 𝛬 ∙ 𝑉𝑉𝑎 ∙ (1 − 𝜑𝑙)(1 − 𝛿𝑧)} = 𝛬 ∙ 𝑉𝑉𝑎�𝜇𝑙{𝐹𝑏 + (1 − 𝜓𝑙)(1 − 𝛿𝑘)}
𝑙

, 

(43) 

𝑚𝑙： 𝑉𝑉ℎ ∙ 𝜍＝𝑉𝑉𝑎 ∙ {𝜂𝑙(𝑚𝑙)}′. 
(44) 
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ゆえに、社会最適解は以下の方程式を解くことにより得られる。 

𝑐𝑙： 𝑢𝑐(𝑐𝑙, (1− 𝜑𝑙)𝑧) = 𝛬 ∙ 𝑉𝑉𝑎 , 

𝑧： �𝜇𝑙
𝑙

{𝑢𝑧(𝑐𝑙 , (1 − 𝜑𝑙)𝑧) + 𝛬 ∙ 𝑉𝑉𝑎 ∙ (1 − 𝜑𝑙)(1 − 𝛿𝑧)} = 𝛬 ∙ 𝑉𝑉𝑎�𝜇𝑙{𝐹𝑏 + (1 − 𝜓𝑙)(1 − 𝛿𝑘)}
𝑙

, 

𝑚𝑙： 𝑉𝑉ℎ ∙ 𝜍＝𝑉𝑉𝑎 ∙ {𝜂𝑙(𝑚𝑙)}′, 
𝑏： 𝑏(𝑡) = 𝑎𝑎(𝑡)− 𝑧(𝑡), 

s.t. 
𝑎𝑎(𝑡 + 1) = 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 
𝐴𝑙(𝑡) = 𝐹(𝐵(𝑡), (1−𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇)− {𝛿𝑘 + (1− 𝛿𝑘) ∙ 𝜓𝑙}𝑎𝑎(𝑡)− 𝑐𝑙(𝑡)

− 𝜂𝑙 �𝑚𝑙(𝑡)� − {(1− 𝜓𝑙)(1− 𝛿𝑘)− (1− 𝜑𝑙)(1− 𝛿𝑧)}𝑧(𝑡) 

ℎ(𝑡 + 1) = ℎ(𝑡) + 𝐻𝑙(𝑡), 
𝐻𝑙(𝑡) = −𝛿ℎ ∙ ℎ(𝑡) + 𝜍 ∙ 𝑚𝑙(𝑡). 

(45) 
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2.3.5 計算を簡素化するための定式化等 

(1) 価値関数の形状の設定 

 価値関数は形状が不明な関数であるため、上記一階条件はそのままでは解くことができない。

そのため、限界効用は逓減するものと仮定し、以下のような形状を与えるものとする。 
𝑉𝑉(𝑎𝑎, ℎ,𝐵) = 𝜈𝜈0 + 𝜈𝜈1 ∙ (𝐵𝑎𝑎)1−𝜃 + 𝜈𝜈2 ∙ (𝐵ℎ)1−𝜃. 

(46) 

 
(46)を一階微分すると、以下のようになる。 

𝑉𝑉𝑎 =
𝜕𝑉𝑉(𝑎𝑎,ℎ,𝐵)

𝜕𝑎𝑎
= (1− 𝜃𝜃) ∙ 𝜈𝜈1𝐵 ∙ (𝐵𝑎𝑎)−𝜃, 

(47) 

𝑉𝑉ℎ =
𝜕𝑉𝑉(𝑎𝑎,ℎ,𝐵)

𝜕ℎ
= (1− 𝜃𝜃) ∙ 𝜈𝜈2𝐵 ∙ (𝐵ℎ)−𝜃. 

(48) 

 
 

(2) 教育費用関数の形状の設定 

人的投資に関する費用関数は、就学年数が増加するほど、教育費用も増加するものと仮定して、

以下のような二次関数の形状を仮定する。𝑚𝑙の二次式の項の係数𝜂2𝑙は、災害のランクにより決定

されるものとする。 
𝜂𝑙(𝑚𝑙) = 𝜂0 + 𝜂1 ∙ 𝑚𝑙 + 𝜂2𝑙 ∙ (𝑚𝑙)2. 

(49) 

 
(49)を一階微分すると、以下のようになる。 

𝜕𝜂𝑙(𝑚𝑙)
𝜕𝑚𝑙 = 𝜂1 + 2𝜂2𝑙 ∙ 𝑚𝑙 . 

(50) 

 
教育費用関数の形状は、他にも対数型、ロジスティック型などが想定されるが、データの制約

もあり統計的に関数形を特定できていないため、今回は簡便性を重視し、二次関数にて関数形を

設定した。 
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2.3.6 結果としての基本構成式とその展開 

 一階微分式(47)、(48)、(50)を社会最適化の一階条件式(42)、(43)、(44)に代入すると、一階条件

式は以下のように書き換えられる。 
𝑐𝑙： 𝑢𝑐(𝑐𝑙, (1− 𝜑𝑙)𝑧) = 𝛬 ∙ (1− 𝜃𝜃) ∙ 𝜈𝜈1𝐵 ∙ (𝐵𝑎𝑎)−𝜃, 

(51) 

𝑧： �𝜇𝑙
𝑙

�𝑢𝑧(𝑐𝑙 , (1 − 𝜑𝑙)𝑧) + 𝛬 ∙ (1 − 𝜃𝜃) ∙ 𝜈𝜈1𝐵 ∙ (𝐵𝑎𝑎)−𝜃 ∙ (1 − 𝜑𝑙)(1 − 𝛿𝑧)�

= 𝛬 ∙ (1 − 𝜃𝜃) ∙ 𝜈𝜈1𝐵 ∙ (𝐵𝑎𝑎)−𝜃�𝜇𝑙{𝐹𝑏 + (1 −𝜓𝑙)(1 − 𝛿𝑘)}
𝑙

, 

(52) 

𝑚𝑙 ： (1− 𝜃𝜃) ∙ 𝜈𝜈2𝐵 ∙ (𝐵ℎ)−𝜃 ∙ 𝜍＝(1− 𝜃𝜃) ∙ 𝜈𝜈1𝐵 ∙ (𝐵𝑎𝑎)−𝜃 ∙ �𝜂1 + 2𝜂2𝑙 ∙ 𝑚𝑙�. 
(53) 

 
𝑐𝑙について、(51)より、 

𝑐𝑙 − 𝑐̅ = �
𝛾1

𝛬 ∙ (1− θ) ∙  𝜈𝜈1 ∙  𝐵1−𝜃
�

1
1−𝛾1(1−𝜃)

∙ (1− 𝜑𝑙)
𝛾2(1−𝜃)

1−𝛾1(1−𝜃) ∙ 𝑎𝑎
𝜃

1−𝛾1(1−𝜃) ∙ 𝑧
𝛾2(1−𝜃)

1−𝛾1(1−𝜃) 

= Q0
𝑃0 ∙ (1 −𝜑𝑙)𝑃1 ∙ 𝑎𝑎𝑃2 ∙ 𝑧𝑃1 

 (54) 

 
𝑧について、(52)より、 

�𝜇𝑙
𝑙

{𝑢𝑧 + 𝛬 ∙  𝑉𝑉𝑎(1− 𝜑𝑙)(1− 𝛿𝑧)} = 𝛬 ∙ 𝑉𝑉𝑎 ∙�𝜇𝑙
𝑙

{𝐹𝑏 + (1− 𝜓𝑙)(1− 𝛿𝑘)} 

�𝜇𝑙
𝑙

[𝑢𝑧 − 𝛬 ∙  𝑉𝑉𝑎{(1− 𝜓𝑙)(1− 𝛿𝑘)− (1− 𝜑𝑙)(1− 𝛿𝑧)}] = 𝛬 ∙ 𝑉𝑉𝑎 ∙�𝜇𝑙
𝑙

∙ �𝐹𝑏� 

�𝜇𝑙
𝑙

[𝑢𝑧 − 𝛬 ∙  𝑉𝑉𝑎{(𝛿𝑧 − 𝛿𝑘) + 𝜑𝑙 − 𝜓𝑙 + 𝜓𝑙𝛿𝑘 − 𝜑𝑙𝛿𝑧}] = 𝛬 ∙ 𝑉𝑉𝑎 ∙�𝜇𝑙
𝑙

∙ �𝐹𝑏 �. 

 (55) 

ここで、瞬時的効用関数(2)の𝑧に関する一階微分を求めると、 

𝑢𝑧 = 𝛾2 ∙ 𝑧𝛾2(1−𝜃)−1 ∙ �𝑄0
𝑃0 ∙ (1− 𝜑𝑙)𝑃1 ∙ 𝑎𝑎𝑃2 ∙ 𝑧𝑃1�

𝛾1(1−𝜃)
∙ (1− 𝜑𝑙)𝛾2(1−𝜃) 

= 𝛾2 ∙ 𝑄0
𝑃0𝛾1(1−𝜃) ∙ 𝑎𝑎𝑃2𝛾1(1−𝜃) ∙ {(1− 𝜑𝑙) ∙ 𝑧}𝛾2(1−𝜃)−1+𝑃1𝛾1(1−𝜃) ∙ (1− 𝜑𝑙). 

 
(56) 

(1− 𝜑𝑙) ∙ 𝑧の次数は、𝛾2(1− 𝜃𝜃)− 1 + 𝑃1 ∙ 𝛾1(1− 𝜃𝜃) = − 𝜃
1−𝛾1(1−𝜃) = −𝑃2となるので、(56)は次のよ

うに書き換えられる。 
𝑢𝑧 = 𝑄1 ∙ 𝑎𝑎𝑃2𝛾1(1−𝜃) ∙ (1 −𝜑𝑙)−𝑃2+1 ∙ 𝑧−𝑃2 . 

(57) 

(57)を(55)に代入すると、 

= 𝑄1 

= 𝑃0 = Q0 =𝑃1 = 𝑃2 

= 𝛿𝑧𝑘  = 𝜑𝑠𝑙 
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�𝜇𝑙
𝑙

�𝑄1 ∙ 𝑎𝑎𝑃2𝛾1(1−𝜃) ∙ (1− 𝜑𝑙)−𝑃2+1 ∙ 𝑧−𝑃2� = 𝛬 ∙ V𝑎 �𝛿𝑧𝑘 +�𝜇𝑙
𝑙

∙ 𝜑𝑠𝑙 + �𝜇𝑙
𝑙

∙ 𝐹𝑏�. 

 
(58) 

(58)の右辺第 3 項目を整理すると、 

�𝜇𝑙
𝑙

𝐹𝑏 = �𝜇𝑙
𝑙

∙ 𝛼2 ∙ (1−𝜔𝑙)𝛼1(1− 𝜓𝑙)𝛼2 ∙ (1− 𝜏𝑙)𝛼3 ∙ 𝐹(∙) ∙ (𝑎𝑎 − 𝑧)−1 

=
𝑆0 ∙ 𝐹(∙)
𝑎𝑎 − 𝑧

. 

(59) 

よって、(59)を(58)に代入すると、 

Q1 ∙ 𝑎𝑎𝑃2𝛾1(1−𝜃) ∙ 𝑧−𝑃2 ∙�𝜇𝑙
𝑙

∙ (1− 𝜑𝑙)−𝑃2+1 = 𝛬 ∙ (1− θ) ∙ ν1 ∙ 𝐵1−𝜃 ∙ 𝑎𝑎−𝜃 �𝑄3 +
𝑆0 ∙ 𝐹(∙)
𝑎𝑎 − 𝑧

�. 

 
(60) 

𝑎𝑎の次数は、P2 ∙ 𝛾1(1− 𝜃𝜃) + 𝜃𝜃 = 𝑃2となることから、(60)を整理すると次のようになる。 
𝑄1 ∙ 𝑄2

𝑄3 ∙ 𝛬(1− 𝜃𝜃)𝜈𝜈1𝐵1−𝜃
∙ 𝑎𝑎𝑃2 = 𝑧𝑃2 �1 +

𝑆0 ∙ 𝐹(∙)
𝑄3 ∙ (𝑎𝑎 − 𝑧)�

 

 
 

�
𝑄1 ∙ 𝑄2

𝑄3 ∙ 𝛬(1− 𝜃𝜃) ∙ 𝜈𝜈1 ∙ 𝐵1−𝜃
�
1
𝑃2
∙ 𝑎𝑎 = 𝑧 �1 +

𝑆1 ∙ 𝐹(∙)
𝑎𝑎 − 𝑧

�

1
𝑃2

. 

 
(61) 

(61)を整理すると、次の方程式が得られる。 

�1 +
𝑆1 ∙ 𝐹(∙)
𝑎𝑎 − 𝑧 �

1
𝑃2
∙ 𝑧 = 𝑄4 ∙ 𝑎𝑎. 

(62) 

 
𝑚𝑙 について、(53)より、 

𝑚𝑙 =
𝜍 ∙ 𝜈𝜈2 ∙ 𝑎𝑎𝜃 − 𝜈𝜈1 ∙ 𝜂1 ∙ ℎ𝜃

2𝜈𝜈1 ∙ 𝜂2𝑙 ∙ ℎ𝜃
 

=
1

2𝜂2𝑙
�
𝜈𝜈2
𝜈𝜈1
∙ �
ℎ
𝑎𝑎
�
−𝜃

∙ 𝜍 − 𝜂1�. 

(63) 

  

= 𝑄2 

= 𝑆1 

= 𝑄4 

= 𝑆0 

= 𝑄3 
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 (54)、(62)、(63)を整理すると、以下のようになる。 
𝑐𝑙：  c𝑙 − 𝑐̅ = 𝑄0

𝑃0 ∙ (1 −𝜑𝑙)𝑃1 ∙ 𝑎𝑎𝑃2 ∙ 𝑧𝑃1 , 
(64) 

𝑧：  �1 +
𝑆1 ∙ 𝐹(∙)
𝑎𝑎 − 𝑧

�

1
𝑃2
∙ 𝑧 = 𝑄4 ∙ 𝑎𝑎, 

(65) 

𝑚𝑙：  𝑚𝑙 =
1

2𝜂2𝑙
�
𝜈𝜈2
𝜈𝜈1
∙ �
ℎ
𝑎𝑎
�
−𝜃

∙ 𝜍 − 𝜂1�, 

(66) 

where 

P0 =
1

1 − 𝛾1(1− 𝜃𝜃)
, 

P1 =
𝛾2(1− 𝜃𝜃)

1 − 𝛾1(1− 𝜃𝜃)
, 

P2 =
𝜃𝜃

1 − 𝛾1(1− 𝜃𝜃), 

Q0 =
𝛾1

𝛬 ∙ (1− 𝜃𝜃) ∙ 𝜈𝜈1 ∙ 𝐵1−𝜃
, 

Q1 = 𝛾2 ∙ 𝑄0
𝑃0𝛾1(1−𝜃), 

Q2 = �𝜇𝑙(1− 𝜑𝑙)−𝑃2+1
𝑙

, 

Q3 = 𝛿𝑧𝑘 + �𝜇𝑙
𝑙

∙ 𝜑𝑠𝑙 , 

Q4 = �
𝑄1 ∙ 𝑄2

𝑄3 ∙ 𝛬 ∙ (1− 𝜃𝜃) ∙ 𝜈𝜈1 ∙ 𝐵1−𝜃
�
1
𝑃2

, 

δ𝑧𝑘 = 𝛿𝑧 − 𝛿𝑘 , 
𝜑𝑠𝑙 = 𝜑𝑙 − 𝜓𝑙 + 𝜓𝑙𝛿𝑘 − 𝜑𝑙𝛿𝑧, 

S0 = 𝛼2�𝜇𝑙
𝑙

(1 −𝜔𝑙)𝛼1(1− 𝜓𝑙)𝛼2(1− 𝜏𝑙)𝛼3 , 

S1 =
𝑆0
𝑄3

. 

(67) 
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ゆえに、プログラムにて解くべき基本構成式は以下のとおりとなる。 
𝑐𝑙：  c𝑙 − 𝑐̅ = 𝑄0

𝑃0 ∙ (1 −𝜑𝑙)𝑃1 ∙ 𝑎𝑎𝑃2 ∙ 𝑧𝑃1 , 

𝑧：  �1 +
𝑆1 ∙ 𝐹(∙)
𝑎𝑎 − 𝑧

�

1
𝑃2
∙ 𝑧 = 𝑄4 ∙ 𝑎𝑎, 

𝑚𝑙：  𝑚𝑙 =
1

2𝜂2𝑙
�
𝜈𝜈2
𝜈𝜈1
∙ �
ℎ
𝑎𝑎
�
−𝜃

∙ 𝜍 − 𝜂1�, 

𝑏： 𝑏(𝑡) = 𝑎𝑎(𝑡)− 𝑧(𝑡), 
s.t. 

𝑎𝑎(𝑡 + 1) = 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 
𝐴𝑙(𝑡) = 𝐹(𝐵(𝑡), (1−𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇)− {𝛿𝑘 + (1− 𝛿𝑘) ∙ 𝜓𝑙}𝑎𝑎(𝑡)− 𝑐𝑙(𝑡)

− 𝜂𝑙 �𝑚𝑙(𝑡)� − {(1− 𝜓𝑙)(1− 𝛿𝑘)− (1− 𝜑𝑙)(1− 𝛿𝑧)}𝑧(𝑡), 

ℎ(𝑡 + 1) = ℎ(𝑡) + 𝐻𝑙(𝑡), 
𝐻𝑙(𝑡) = −𝛿ℎ ∙ ℎ(𝑡) + 𝜍 ∙ 𝑚𝑙(𝑡), 
𝜂𝑙(𝑚𝑙) = 𝜂0 + 𝜂1 ∙ 𝑚𝑙 + 𝜂2𝑙 ∙ (𝑚𝑙)2, 

where （下記の項の変数は、外生変数、シミュレーション計算、定数の設定等で所与となる。） 

P0 =
1

1 − 𝛾1(1− 𝜃𝜃)
, 

P1 =
𝛾2(1− 𝜃𝜃)

1 − 𝛾1(1− 𝜃𝜃)
, 

P2 =
𝜃𝜃

1 − 𝛾1(1− 𝜃𝜃)
, 

Q0 =
𝛾1

𝛬 ∙ (1− 𝜃𝜃) ∙ 𝜈𝜈1 ∙ 𝐵1−𝜃
, 

Q1 = 𝛾2 ∙ 𝑄0
𝑃0𝛾1(1−𝜃), 

Q2 = �𝜇𝑙(1− 𝜑𝑙)−𝑃2+1
𝑙

, 

Q3 = 𝛿𝑧𝑘 + �𝜇𝑙
𝑙

∙ 𝜑𝑠𝑙 , 

Q4 = �
𝑄1 ∙ 𝑄2

𝑄3 ∙ 𝛬 ∙ (1− 𝜃𝜃) ∙ 𝜈𝜈1 ∙ 𝐵1−𝜃
�
1
𝑃2

, 

δ𝑧𝑘 = 𝛿𝑧 − 𝛿𝑘 , 
𝜑𝑠𝑙 = 𝜑𝑙 − 𝜓𝑙 + 𝜓𝑙𝛿𝑘 − 𝜑𝑙𝛿𝑧, 

S0 = 𝛼2�𝜇𝑙
𝑙

(1 −𝜔𝑙)𝛼1(1− 𝜓𝑙)𝛼2(1− 𝜏𝑙)𝛼3 , 

S1 =
𝑆0
𝑄3

. 

(68)  
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2.3.7 プログラム上での計算方法 

 𝑐𝑙、𝑚𝑙の一階条件式は陽関数であるのに対し、𝑧の一階条件式は陰関数となっている。そのため、

以下のような手順で解を求める。 
 
① (68)の外生変数に初期値を代入（インプット）する。 

𝑐𝑙：  c𝑙 − 𝑐̅ = 𝑄0
𝑃0 ∙ (1− 𝜑𝑙)𝑃1 ∙ 𝑎𝑎𝑃2 ∙ 𝑧𝑃1 , 

𝑧：  �1 +
𝑆1 ∙ 𝐹(∙)
𝑎𝑎 − 𝑧

�

1
𝑃2
∙ 𝑧 = 𝑄4 ∙ 𝑎𝑎, 

𝑚𝑙：  𝑚𝑙 =
1

2𝜂2𝑙
�
𝜈𝜈2
𝜈𝜈1
∙ �
ℎ
𝑎𝑎
�
−𝜃

∙ 𝜍 − 𝜂1�, 

 

𝑏： 𝑏(𝑡) = 𝑎𝑎(𝑡)− 𝑧(𝑡), 
s.t. 

𝑎𝑎(𝑡 + 1) = 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 
𝐴𝑙(𝑡) = 𝐹(𝐵(𝑡), (1−𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇)− {𝛿𝑘 + (1− 𝛿𝑘) ∙ 𝜓𝑙}𝑎𝑎(𝑡)− 𝑐𝑙(𝑡)

− 𝜂𝑙 �𝑚𝑙(𝑡)� − {(1− 𝜓𝑙)(1− 𝛿𝑘)− (1− 𝜑𝑙)(1− 𝛿𝑧)}𝑧(𝑡), 

ℎ(𝑡 + 1) = ℎ(𝑡) + 𝐻𝑙(𝑡), 
𝐻𝑙(𝑡) = −𝛿ℎ ∙ ℎ(𝑡) + 𝜍 ∙ 𝑚𝑙(𝑡), 
𝜂𝑙(𝑚𝑙) = 𝜂0 + 𝜂1 ∙ 𝑚𝑙 + 𝜂2𝑙 ∙ (𝑚𝑙)2. 

 

② さらに(68)に𝑎𝑎(0)、h(0)を与える。 

⇒ 𝑚𝑙の一階条件式（陽関数）より、 𝑚𝑙が求まる。 

𝑚𝑙：  𝑚𝑙 =
1

2𝜂2𝑙
�
𝜈𝜈2
𝜈𝜈1
∙ �
ℎ
𝑎𝑎
�
−𝜃

∙ 𝜍 − 𝜂1�. 

③ 𝑧の一階条件式（陰関数）をニュートン法により解く。 

⇒𝑧が求まる。 

𝑧：  �1 +
𝑆1・𝐹(∙)
𝑎𝑎 − 𝑧 �

1
𝑃2
・𝑧 = 𝑄4・𝑎𝑎. 

 
④ 𝑧を𝑐𝑙の一階条件式（陽関数）に代入する。 

⇒𝑐𝑙が求まる。 
𝑐𝑙：  c𝑙 − 𝑐̅ = 𝑄0

𝑃0 ∙ (1− 𝜑𝑙)𝑃1 ∙ 𝑎𝑎𝑃2 ∙ 𝑧𝑃1 . 
 

⑤ 𝑎𝑎(𝑡) ≔ 𝑏(𝑡) + 𝑧(𝑡)に前段で求めた𝑎𝑎とzの値を代入する。 

⇒𝑏が求まる。 

𝑏： 𝑏(𝑡) = 𝑎𝑎(𝑡) − 𝑧(𝑡). 
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⑥ 𝜂𝑙(𝑚𝑙) = 𝜂0 + 𝜂1 ∙ 𝑚𝑙 + 𝜂2𝑙 ∙ (𝑚𝑙)2に前段で求めた𝑚𝑙の値を代入する。 

⇒𝜂𝑙(𝑚𝑙)の値が求まる。 
𝜂𝑙(𝑚𝑙) = 𝜂0 + 𝜂1 ∙ 𝑚𝑙 + 𝜂2𝑙 ∙ (𝑚𝑙)2. 

 

⑦ 計算で得られた 𝑚𝑙、z、𝑐𝑙、𝑏、𝜂𝑙(𝑚𝑙)を𝐴𝑙、𝐻𝑙に代入する。 

𝐴𝑙(𝑡) = 𝐹(𝐵(𝑡), (1 −𝜔𝑙)ℎ(𝑡), (1− 𝜓𝑙)𝑏(𝑡), (1− 𝜏𝑙)𝑇)− {𝛿𝑘 + (1 − 𝛿𝑘) ∙ 𝜓𝑙}𝑎𝑎(𝑡)− 𝑐𝑙(𝑡)

− 𝜂𝑙 �𝑚𝑙(𝑡)� − {(1− 𝜓𝑙)(1− 𝛿𝑘)− (1− 𝜑𝑙)(1− 𝛿𝑧)}𝑧(𝑡), 

𝐻𝑙(𝑡) = −𝛿ℎ ∙ ℎ(𝑡) + 𝜍 ∙ 𝑚𝑙(𝑡). 

 
⑧ 𝐴𝑙、𝐻𝑙が求まることにより、次年度の𝑎𝑎、hが算出される。 

𝑎𝑎(𝑡 + 1) = 𝑎𝑎(𝑡) + 𝐴𝑙(𝑡), 
ℎ(𝑡 + 1) = ℎ(𝑡) + 𝐻𝑙(𝑡). 

 
⑨ (68)に𝑎𝑎(t+1)、h(t + 1)を与える。 

⇒ 𝑚𝑙の一階条件式（陽関数）より、 𝑚𝑙が求まる。 

𝑚𝑙：  𝑚𝑙 =
1

2𝜂2𝑙
�
𝜈𝜈2
𝜈𝜈1
∙ �
ℎ
𝑎𝑎
�
−𝜃

∙ 𝜍 − 𝜂1�. 

⑩ 以後、③～⑨の繰り返し。（計算期間が終了するまで続ける） 
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第 2 編 DR2AD model Ver1.4 のアプリケーション使用方法 

3 About DR2AD Ver1.4 APPLICATION（DR2AD model Ver.1.4 アプリの概要） 

3.1 What DR2AD model Ver1.4 be able to do （アプリで何ができるか) 

DR2AD model (Ver1.4) が可能な機能について解説する。アプリケーションの出力は、政策説

明・政策決定者判断用と分析用・実務担当者判断用の大きく 2 種類に分けられる。政策説明・政

策決定者判断用は、マクロ経済指標等による大局的なディシジョンメイキングのための活用が可

能である。一方で、分析用・実務担当者判断用では、階層間の家計指標を用いて、社会的格差等

の社会問題の分析のための活用が可能となっている。 
 

表 3-1 出力分類（概要） 

使用用途 経済指標 出力形式 

政策説明 

・政策決定者判断 

マクロ経済指標による大局的な

政策判断に利用 

GDP、災害規模、災害頻度、

災害被害率など 

グラフ 

CSV ファイル 

分析用 

・実務担当者判断 

家計指標や所得階層別データ

による家計の生活水準を詳細

に分析 

一人当たり GDP（個人所得）、

消費、物的投資、金融資産、人

的資本、教育時間、人的投資

など 

CSV ファイル 
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3.2 アプリケーションの事前準備 

3.2.1 動作環境 

 
動作環境は、マスワークス社のサイトを参照のこと。 
http://jp.mathworks.com/products/matlab/choosing_hardware.html 

 
■Operating Systems 

MATLAB performance is similar on Windows®, Mac OS® X, and Linux® 
 
■32-bit or 64-bit? 

On Windows computers, using 64-bit Windows and the 64-bit version of MATLAB is the 
right choice for most situations, because it can access the larger amounts of memory in 
modern computers (see Memory section), and support for 32-bit Windows will end in the 
next couple of years. Refer to the Platform Road Map for more information. Also refer to 
Adopting 64-bit Windows for a more detailed discussion of migrating to 64-bit Windows. 

On Mac and Linux computers, the 64-bit version of MATLAB is the only version 
available. 

 
■推奨のスペック 

32-Bit and 64-Bit MATLAB and Simulink Product Families 
Operating Systems Processors Disk Space RAM Graphics 
Windows 8.1 

Windows 8 

Windows 7 
Service Pack 1 

Windows Vista 
Service Pack 2 

Windows XP 
Service Pack 3 

Windows XP x64 
Edition Service 
Pack 2 

Windows Server 
2012 

Windows Server 
2008 R2 Service 
Pack 1 

Windows Server 
2008 Service 
Pack 2 

Windows Server 
2003 R2 Service 
Pack 2 

Any Intel or AMD x86 
processor supporting 
SSE2 instruction set* 

1 GB for MATLAB only, 
3–4 GB for a typical 
installation 

1024 MB 
(At least 2048 MB 
recommended) 

No specific 
graphics card is 
required. 
Hardware 
accelerated 
graphics card 
supporting 
OpenGL 3.3 with 
1GB GPU memory 
recommended. 

Learn moreabout 
system 
requirements for 
MATLAB Graphics 

 

http://jp.mathworks.com/products/matlab/choosing_hardware.html�
http://jp.mathworks.com/help/matlab/creating_plots/system-requirements-for-matlab-graphics.html�
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3.2.2 事前準備 

本プログラムの実行に当たっては以下が必要となる。 
 

① MATLB 2014b  
② DR2AD model ver1.4 プログラム一式 

③ Sample excel file(Excel file can be modified for further analysis) 

④ World bank data catalog 
⑤ Statistic data for target country 
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3.2.3 DR2AD model (ver1.4) の起動 

 MATLAB コード版である DR2AD model (ver1.4)を起動させるための操作手順を以下に示

す。 
 
①下図に示す【DR2ADModel】ファイルをクリックする。 

 
 
 
②下図に示す画面が立ち上がる。 

 

 
 
③エディター画面のメニューにある実行ボタンをクリック 
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④下図に示す GUI 画面が立ち上がる。 
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3.2.4 DR2AD model (ver1.4) のアプリケーション化（ver1.4⇒ver2.4） 

MATLAB コード版である DR2AD model (ver1.4)を動作環境に依存せずに利用するためには、

Mathworks 社の MATLAB Compiler を使用する必要がある。MATLAB Compiler にて DR2AD 
model (ver1.4)をコンパイルすることにより、スタンドアローン型のアプリケーションの構築が

できる。 
なお、DR2AD model (ver1.4)のアプリケーション版を DR2AD model (ver2.4)と呼ぶものとす

る。 
MATLAB Compiler の詳細などについては、MathWorks 社のホームページを参照のこと。 
 
<参考：MATLAB Compiler (MathWorks 社)> 
http://jp.mathworks.com/products/compiler/ 
 

 
 
 

  



 

39 

4 HOW TO USE APPLICATION（アプリケーションの使い方） 

本章では、以下に従って、アプリケーションの操作方法について解説する。 
 

図 4-1 Application Usage Procedure 

 
  

Launching the application 

Configuring the application 

Operating the application 
(1) Selecting parameter files 
 1）Socio Economic parameters 
 2）Disaster parameters 
(2) Selecting/Specifying the calculation conditions 
 1）Selecting the Occurrence of Natural Disasters  
 2）Specifying the number of Monte Carlo iterations 
 3）Specifying the calculation period 
 4）Specifying the condition of Natural disaster(s) 
 5）Selecting whether to display the above calculation conditions or not 
(3) Saving the results in the folder 
(4) Executing the calculation 



 

40 

4.1 Preparation 

4.1.1 アプリケーションの起動 

下図に示す【DR2ADModel】ファイルをクリックする。 
 

 

図 4-2 アプリケーション・ファイルの起動 

下図に示す画面が立ち上がる。 
 

   

図 4-3 アプリケーション・ファイルの起動 
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4.2 アプリケーションの構成 

プログラムは下記の実行フローに従って実行される。 
 

 
図 4-4 Ver2.4 アプリケーションの実行フロー 

 
① Input Data の読み込み 

② 計算条件の指定 

（災害発生の有無、モンテカルロシミュレーションの回数、計算期間、災害種の指定、

計算条件の表示） 
③ 計算結果の保存場所の指定 

④ 計算の実行 

 
  

1.Input Data の読み込み 

3.計算結果の保存場所の指定 

2.計算条件の指定 

4.計算の実行 
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4.3 アプリケーションの操作 

アプリケーションの操作方法について説明する。 
 

4.3.1 Input Dataの読み込み 

Input Data の設定方法について記述する。なお、具体のデータの入力値の設定方法について

は 5 章にて詳述する。 
パラメータは下表に示すとおり、Socio Economic Parameters と Disaster Parameters の 2

つに大別され、さらに Socio Economic Parameters については原則として値を再設定しない

Deep Parameters と各国のデータを入力するマクロ経済データ及び家計データに分類される。 
Input data は、エクセル上で各国のデータを記入し、これをアプリケーションで読む必要が

ある。ただし、初期設定としてホンジュラスを対象としたサンプルデータがすでに記入されて

いるため、各国のデータを独自に設定しなくても、計算を実行することが可能である。また、

サンプルデータとして、そのほかに 4 カ国分のデータを掲載しており、これらを使用すること

も可能である。 
各パラメータの初期値および概要については次ページ以降のとおりとなる。 

 

表 4-1 Input Data のデータ種別 

データ種別 データ例 データの設定 

Socio Economic 
Parameters 

Deep 
Parameter 

相対的危険回避度、

減耗率など 固定値 

マクロ経済 
データ 総人口、GDP など 

第 3 編で詳述 
家計データ 消費、貯蓄、人的投

資、物的投資など 

Disaster 
Parameters 災害データ 人的被害率、物的被

害率など 第 3 編で詳述 
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表 4-2 Input Data の一覧 

Parameter 
name Description Data source Sample 

value 

J The number of income class <fixed data> 5 

L 
The number of disaster classes (not 
including the no-disaster state) <fixed data> 4 

rho Time preference rate Recommended value 0.12 

theta Degree of relative risk aversion Recommended value 2 

cbar The subsistence level of consumption Recommended value 0 

deltaz Depreciation rate of physical asset <fixed data> 0.1 

deltak 
Depreciation rate of production 
capital <fixed data> 0.02 

gb Exogenous technological growth rate Recommended value 0.042 

iota 
Compensation coefficient between 
the human capital investment and 
the years of education. 

Those parameters are defined by 
the assumption. 
There will be no effect to the 
model when you use 1. 

1 

Pop0 Initial population World Bank data (by Country) 6762426 

GDP0 
Initial GDP US$ (2004, from World 
bank HP, 2005US$) World Bank data (by Country) 9120240790 

alpha1 Share parameter for human capital Social Account Matrix/Input 
Output Table 

0.45 

alpha2 Share parameter for physical capital Social Account Matrix/Input 
Output Table 

0.47 

alpha3 Share parameter for land 
Social Account Matrix/Input 
Output Table 

0.08 

c0 
Initial consumption per capita: Data 
of Households' survey 2004 

Household Survey /JICA Poverty 
Profile 

93 
243 
448 
787 

2564 

h0 
Initial human capital per capita 
(using mean years of schooling as a 
proxy variable) 

UNDP data (Mean years of 
schooling)/Household Survey 
/JICA Poverty Profile 

3.3 
4.2  
5.0 
6.0 
6.9 

z0 
Initial physical asset investment per 
capita as flow variable 

Household Survey /JICA Poverty 
Profile 

112 
293 
540 
949 

3091 

b0 Initial financial assets per capita World Bank data (by Country) 

321 
842 

1554 
2732 
8899 

T0 Initial land per capita World Bank data (by Country) 

0.02 
0.05 
0.08 
0.15 
0.48 

m0 Initial education time per capita 
Household Survey /JICA Poverty 
Profile 

0.33 
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Parameter 
name Description Data source Sample 

value 

deltah Depreciation rate of human capital World Bank data (by Country) 0.004 

eta0 
Coefficient of human investment cost 
function 

INSTITUTE for STATISTICS, 
UNESCO/World Development 
Indicator, World Bank 

0 

eta1 
Coefficient of human investment cost 
function 

INSTITUTE for STATISTICS, 
UNESCO/World Development 
Indicator, World Bank 

0 

eta2M 
Coefficient of human investment cost 
function 

INSTITUTE for STATISTICS, 
UNESCO/World Development 
Indicator, World Bank 

205.8 

eta2Mvector 

0<h<=6 
6<h<=9 
9<h<=11 

11<h<=15 
15<h<=17 
17<h<=20 

20<h<=60 

INSTITUTE for STATISTICS, 
UNESCO/World Development 
Indicator, World Bank 

205.8 
245.3 
381.3 

1092.6 
1504.3 
1918.7 
5347.2 
20000 
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表 4-3 Reference of Input Data of Disaster Parameters 

Parameter name Description Data source 

omegaV_DISASTER  
(1 or 2) 

Human capital damage 
rate due to disaster by 
rank 

Human capital damage: 
Desinventar / UNISDR 
population : 
World Bank data (by Country) 

phiV_DISASTER 
(1 or 2) 

Physical assets damage 
rate due to disaster by 
rank 

Physical assets damage： 
Desinventar / UNISDR 
Household: 
Household Survey / JICA Poverty 
Profile 

psiV_DISASTER 
(1 or 2) 

Production capital 
damage rate due to 
disaster by rank 

Set following the relationship between 
Capital damage rate and Physical 
assets damage rate  

tauV_DISASTER 
(1 or 2) 

Damage rate of land due 
to disaster by rank 

There are no disaster in this case 
study 

mu 
Probability of disaster 
occurrence by rank 

UNISDR database Desinventar 
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表 4-4 Input Data List of sheet1 on Disaster Parameters (Disaster1 =FLOOD)  

Parameter name Sample value 

Disaster Rank Rank 0 Rank1 Rank 2 Rank 3 Rank 4 
mu 0.500 0.464 0.019 0.011 0.007 

DRR Without 
omegaV_DISASTER1 0 0.110046 0.298150 0.400638 0.475017 

phiV_DISASTER1 0 0.000191 0.000488 0.000634 0.000749 
psiV_DISASTER1 0 0.000840 0.002149 0.002789 0.003294 
tauV_DISASTER1 0 0 0 0 0 

DRR Soft 
omegaV_DISASTER1 0 0 0 0 0 

phiV_DISASTER1 0 0.000191 0.000488 0.000634 0.000749 
psiV_DISASTER1 0 0.000840 0.002149 0.002789 0.003294 
tauV_DISASTER1 0 0 0 0 0 

DRR Hard1 
omegaV_DISASTER1 0 0 0.078125 0.273375 0.402195 

phiV_DISASTER1 0 0 0.000153 0.000474 0.000656 
psiV_DISASTER1 0 0 0.000671 0.002084 0.002886 
tauV_DISASTER1 0 0 0 0 0 

DRR Hard2 
omegaV_DISASTER1 0 0 0 0.099688 0.313246 

phiV_DISASTER1 0 0 0 0.000200 0.000541 
psiV_DISASTER1 0 0 0 0.000881 0.002380 
tauV_DISASTER1 0 0 0 0 0 

DRR Hard1+soft 
omegaV_DISASTER1 0 0 0 0 0 

phiV_DISASTER1 0 0 0.000153 0.000474 0.000656 
psiV_DISASTER1 0 0 0.000671 0.002084 0.002886 
tauV_DISASTER1 0 0 0 0 0 

DRR Hard2+soft 
omegaV_DISASTER1 0 0 0 0 0 

phiV_DISASTER1 0 0 0 0.000200 0.000541 
psiV_DISASTER1 0 0 0 0.000881 0.002380 
tauV_DISASTER1 0 0 0 0 0 
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表 4-5 Input Data List of sheet2 on Disaster Parameters (Disaster2 =EARTHQUAKE) 

Parameter name Sample value 

Disaster Rank Rank 0 Rank1 Rank 2 Rank 3 Rank 4 

mu 0.5 0.468048 0.015625 0.009615 0.006711 
DRR Without 

omegaV_DISASTER2 0 0.0003 0.000928 0.001243 0.001485 

phiV_DISASTER2 0 0.001339 0.003731 0.005008 0.005959 

psiV_DISASTER2 0 0.005893 0.016416 0.022035 0.026222 

tauV_DISASTER2 0 0 0 0 0 

DRR Soft 

omegaV_DISASTER2 0 0.0003 0.000928 0.001243 0.001485 

phiV_DISASTER2 0 0.001339 0.003731 0.005008 0.005959 

psiV_DISASTER2 0 0.005893 0.016416 0.022035 0.026222 

tauV_DISASTER2 0 0 0 0 0 

DRR Hard1 

omegaV_DISASTER2 0 0 0.000139 0.000719 0.00116 

phiV_DISASTER2 0 0 0.000914 0.003369 0.004995 

psiV_DISASTER2 0 0 0.004019 0.014823 0.021976 

tauV_DISASTER2 0 0 0 0 0 

DRR Hard2 

omegaV_DISASTER2 0 0 0 0.000175 0.000813 

phiV_DISASTER2 0 0 0 0.001179 0.003873 

psiV_DISASTER2 0 0 0 0.005188 0.017041 

tauV_DISASTER2 0 0 0 0 0 

DRR Hard1+soft 
omegaV_DISASTER2 0 0 0.000139 0.000719 0.00116 

phiV_DISASTER2 0 0 0.000914 0.003369 0.004995 

psiV_DISASTER2 0 0 0.004019 0.014823 0.021976 

tauV_DISASTER2 0 0 0 0 0 

DRR Hard2+soft 
omegaV_DISASTER2 0 0 0 0.000175 0.000813 

phiV_DISASTER2 0 0 0 0.001179 0.003873 

psiV_DISASTER2 0 0 0 0.005188 0.017041 

tauV_DISASTER2 0 0 0 0 0 
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（1）Socio Economic Parameters 

ここでは社会的経済データを挿入する。 
Browse をクリックして、指定したエクセルファイルを読み込む。 

 

 

図 4-5 Socio Economic Parameters のファイル指定 

 
エクセルファイルの設定は、以下の 2 つのケースが存在する。 
Case1 では、すでに値が設定済のサンプルエクセルファイルを使用することができる。一方で、

Case2 では各国の独自データを設定することができる。 
 

Case1 規定値・サンプルデータ 

Case2 各国の独自データ 
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< CASE 1: Default value or Sample data> 
データを各自で設定しない場合は、以下の 5 つのサンプルファイルのいずれかを選ぶことで、

計算を実行することができる。 

Excel File name SEPara_Sample 
HONDURAS 

SEPara_Sample 
PAKISTAN 

SEPara_Sample 
PERU 

SEPara_Sample 
GUATEMALA 

SEPara_Sample 
COSTARICA 

J 5 5 5 5 5 
L 4 4 4 4 4 

rho 0.12 0.12 0.12 0.12 0.12 
theta 2 2 2 2 2 
cbar 0 0 0 0 0 

deltaz 0.1 0.1 0.1 0.1 0.1 
deltak 0.02 0.02 0.02 0.02 0.02 

gb 0.042 0.042 0.042 0.042 0.042 
iota 1 1 1 1 1 
Pop0 6762426 155151394 27403845 12367800 4246336 
GDP0 9120240790 101704136879 70530831291 26352121441 18855016400 

alpha1 0.45 0.52 0.38 0.38 0.45 

alpha2 0.47 0.4 0.54 0.54 0.47 

alpha3 0.08 0.08 0.08 0.08 0.08 

c0 

93 
243 
448 
787 

2564 

208 
289 
369 
480 
924 

295 
583 
926 

1457 
3777 

241 
545 
889 

1427 
3820 

462 
1032 
1613 
2575 
6574 

h0 

3.3 
4.2  
5.0 
6.0 
6.9 

3.2 
3.9  
4.2 
4.4 
5.6 

8.4 
8.4  
8.4 
8.4 
8.4 

3.5 
3.5  
3.5 
3.5 
3.5 

7.9 
7.9  
7.9 
7.9 
7.9 

z0 

112 
293 
540 
949 

3091 

186 
259 
331 
429 
827 

306 
605 
962 

1513 
3923 

364 
825 

1345 
2158 
5779 

498 
1112 
1738 
2775 
7084 

b0 

321 
842 

1554 
2732 
8899 

1297 
1801 
2306 
2992 
5765 

1101 
2176 
3458 
5440 
14104 

1277 
2892 
4713 
7564 
20256 

1793 
4005 
6259 
9993 

25513 

T0 

0.02 
0.05 
0.08 
0.15 
0.48 

0.06 
0.09 
0.11 
0.15 
0.28 

0.03 
0.05 
0.09 
0.14 
0.35 

0.02 
0.05 
0.08 
0.13 
0.36 

0.01 
0.02 
0.03 
0.05 
0.13 

m0 0.33 0.18 0.31 0.31 0.26 

deltah 0.004 0.005 0.005 0.005 0.005 

eta0 0 0 0 0 0 

eta1 0 0 0 0 0 

eta2M 205.8 100.9 632 310 1001.9 

eta2Mvector 

205.8 
245.3 
381.3 

1092.6 
1504.3 
1918.7 
5347.2 
20000 

100.9 
120.3 
187.3 
536.4 
651.4 
820.0 

2064.6 
20000 

555.4 
632.0 
665.4 
1164.8 
1412.9 
1679.8 
3860.1 
20000 

310.0 
369.8 
575.6 

1653.3 
2275.5 
2904.4 
8097.9 
20000 

880.3 
1001.9 
1056.8 
1858.0 
2256.9 
2685.6 
6183.3 
20000 
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<CASE 2: country’s original data> 
社会的経済データは、以下のエクセルデータとして整理される。Socio Economic Parameters

ファイルを開いて、黄色枠を記入する。 
各国の個別の事象をみる場合は、下図のエクセルのデータを、黄色の枠で記入された部分に記入

する。なお個別のパラメータの説明は前頁の表を参照されたい。 

 

 

 

 

 

図 4-6 Socio Economic Parameters のエクセルシート状での入力 

  

Deep 
parameters 
原則固定値 

Social 
economic 

Parameters 
各国の事情に応

じて数字を入力 

パラメータの内容 

Editable data 

Auto-filled data 

Parameters uneditable 
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（2）Disaster Parameters 

ここでは災害被害データを挿入する。 
 

 

図 4-7 Disaster Parameters のファイル指定 

 
エクセルファイルの設定は、以下の 2 つのケースが存在する。 
Case1 では、すでに値が設定済のサンプルエクセルファイルを使用することができる。一方で、

Case2 では各国の独自データを設定することができる。 
 

Case1 規定値・サンプルデータ 

Case2 各国の独自データ 
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<CASE 1 : Default value or Sample data> 
データを各自で設定しない場合は、以下の 5 つのサンプルファイルのいずれかを選ぶことで、計算を実行することができる。 

表 4-6 Input Data Sample List 1

  

without DRR soft hard1 hard2 without DRR soft hard1 hard2 without DRR soft hard1 hard2

GUATE MALA
（FLOOD）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 43.0% 1/2～1/23 1.44% 0.00% 0.00% 0.00% 0.89% 0.89% 0.00% 0.00% 3.93% 3.93% 0.00% 0.00%

2 4.3% 1/23～1/56 2.82% 0.00% 1.83% 0.00% 1.62% 1.62% 1.18% 0.00% 7.13% 7.13% 5.20% 0.00%

3 1.8% 1/56～1/112 3.61% 0.00% 3.30% 2.32% 2.09% 2.09% 1.94% 1.46% 9.20% 9.20% 8.55% 6.43%

4 0.9% 1/112～1/200 4.26% 0.00% 4.11% 3.81% 2.51% 2.51% 2.45% 2.28% 11.05% 11.05% 10.76% 10.03%

COSTA RICA
（FLOOD）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.5% 1/2～1/56 0.15% 0.00% 0.00% 0.00% 0.03% 0.03% 0.00% 0.00% 0.13% 0.13% 0.00% 0.00%

2 1.8% 1/56～1/96 0.41% 0.00% 0.09% 0.00% 0.08% 0.08% 0.02% 0.00% 0.36% 0.36% 0.08% 0.00%

3 1.0% 1/96～1/143 0.55% 0.00% 0.37% 0.12% 0.11% 0.11% 0.07% 0.02% 0.49% 0.49% 0.32% 0.11%

4 0.7% 1/143～1/200 0.65% 0.00% 0.55% 0.42% 0.13% 0.13% 0.11% 0.08% 0.58% 0.58% 0.48% 0.37%

PAKISTAN（FLOOD） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.6% 1/2～1/60 0.23% 0.00% 0.00% 0.00% 0.16% 0.16% 0.00% 0.00% 0.72% 0.72% 0.00% 0.00%

2 1.7% 1/60～1/100 0.68% 0.00% 0.13% 0.00% 0.32% 0.32% 0.21% 0.00% 1.43% 1.43% 0.92% 0.00%

3 1.0% 1/100～1/146 0.92% 0.00% 0.57% 0.17% 0.42% 0.42% 0.38% 0.27% 1.84% 1.84% 1.67% 1.17%

4 0.7% 1/146～1/200 1.11% 0.00% 0.89% 0.65% 0.49% 0.49% 0.47% 0.44% 2.15% 2.15% 2.08% 1.93%

PERU（FLOOD） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.0% 1/2～1/48 0.19% 0.00% 0.00% 0.00% 0.03% 0.03% 0.00% 0.00% 0.15% 0.15% 0.00% 0.00%

2 2.1% 1/48～1/87 0.49% 0.00% 0.16% 0.00% 0.07% 0.07% 0.04% 0.00% 0.30% 0.30% 0.19% 0.00%

3 1.1% 1/87～1/136 0.64% 0.00% 0.48% 0.21% 0.09% 0.09% 0.08% 0.05% 0.38% 0.38% 0.35% 0.24%

4 0.7% 1/136～1/200 0.75% 0.00% 0.66% 0.55% 0.10% 0.10% 0.10% 0.09% 0.46% 0.46% 0.44% 0.40%

HONDURAS（FLOOD） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.4% 1/2～1/54 11.00% 0.00% 0.00% 0.00% 0.02% 0.02% 0.00% 0.00% 0.08% 0.08% 0.00% 0.00%

2 1.9% 1/54～1/94 29.82% 0.00% 7.81% 0.00% 0.05% 0.05% 0.02% 0.00% 0.21% 0.21% 0.07% 0.00%

3 1.1% 1/94～1/142 40.06% 0.00% 27.34% 9.97% 0.06% 0.06% 0.05% 0.02% 0.28% 0.28% 0.21% 0.09%

4 0.7% 1/142～1/200 47.50% 0.00% 40.22% 31.32% 0.07% 0.07% 0.07% 0.05% 0.33% 0.33% 0.29% 0.24%

Country（Disaster） Rank rate Proba.

Damage rate of financial assetsDamege rate of human capital damage rate of physical asstes
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表 4-7 Input Data Sample List 2

  

without DRR soft hard1 hard2 without DRR soft hard1 hard2 without DRR soft hard1 hard2

GUATE MALA
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 45.7% 1/2～1/43 0.19% 0.19% 0.00% 0.00% 0.31% 0.31% 0.00% 0.00% 1.35% 1.35% 0.00% 0.00%

2 2.3% 1/43～1/82 0.48% 0.48% 0.18% 0.00% 0.78% 0.78% 0.25% 0.00% 3.43% 3.43% 1.09% 0.00%

3 1.2% 1/82～1/133 0.63% 0.63% 0.50% 0.24% 1.03% 1.03% 0.75% 0.32% 4.51% 4.51% 3.32% 1.41%

4 0.8% 1/133～1/200 0.75% 0.75% 0.67% 0.57% 1.21% 1.21% 1.06% 0.87% 5.33% 5.33% 4.67% 3.82%

COSTA RICA
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.4% 1/2～1/54 0.46% 0.46% 0.00% 0.00% 0.44% 0.44% 0.00% 0.00% 1.95% 1.95% 0.00% 0.00%

2 1.9% 1/54～1/95 1.29% 1.29% 0.33% 0.00% 1.18% 1.18% 0.34% 0.00% 5.20% 5.20% 1.51% 0.00%

3 1.1% 1/95～1/142 1.72% 1.72% 1.18% 0.40% 1.58% 1.58% 1.13% 0.44% 6.95% 6.95% 4.96% 1.95%

4 0.7% 1/142～1/200 2.05% 2.05% 1.72% 1.33% 1.87% 1.87% 1.61% 1.29% 8.21% 8.21% 7.10% 5.67%

PAKISTAN
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.7% 1/2～1/61 0.03% 0.03% 0.00% 0.00% 0.53% 0.53% 0.00% 0.00% 2.34% 2.34% 0.00% 0.00%

2 1.6% 1/61～1/101 0.10% 0.10% 0.02% 0.00% 1.41% 1.41% 0.41% 0.00% 6.20% 6.20% 1.82% 0.00%

3 1.0% 1/101～1/146 0.14% 0.14% 0.08% 0.02% 1.87% 1.87% 1.34% 0.53% 8.24% 8.24% 5.92% 2.34%

4 0.7% 1/146～1/200 0.16% 0.16% 0.13% 0.10% 2.23% 2.23% 1.91% 1.53% 9.79% 9.79% 8.42% 6.75%

PERU
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 45.4% 1/2～1/39 0.54% 0.54% 0.00% 0.00% 0.63% 0.63% 0.00% 0.00% 2.79% 2.79% 0.00% 0.00%

2 2.6% 1/39～1/77 1.32% 1.32% 0.55% 0.00% 1.60% 1.60% 0.51% 0.00% 7.03% 7.03% 2.22% 0.00%

3 1.3% 1/77～1/128 1.75% 1.75% 1.40% 0.71% 2.06% 2.06% 1.56% 0.69% 9.04% 9.04% 6.87% 3.05%

4 0.8% 1/128～1/200 1.99% 1.99% 1.86% 1.64% 2.42% 2.42% 2.14% 1.80% 10.63% 10.63% 9.40% 7.90%

HONDURAS
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.8% 1/2～1/64 0.03% 0.03% 0.00% 0.00% 0.13% 0.13% 0.00% 0.00% 0.59% 0.59% 0.00% 0.00%

2 1.6% 1/64～1/104 0.09% 0.09% 0.01% 0.00% 0.37% 0.37% 0.09% 0.00% 1.64% 1.64% 0.40% 0.00%

3 1.0% 1/104～1/149 0.12% 0.12% 0.07% 0.02% 0.50% 0.50% 0.34% 0.12% 2.20% 2.20% 1.48% 0.52%

4 0.7% 1/149～1/200 0.15% 0.15% 0.12% 0.08% 0.60% 0.60% 0.50% 0.39% 2.62% 2.62% 2.20% 1.70%

Country（Disaster） Rank rate Proba.

Damage rate of financial assetsDamege rate of human capital damage rate of physical asstes
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<CASE 2: country’s original data> 
 
災害被害データは以下のエクセルデータとして整理される。Disaster Parameter ファイルを開

いて、黄色枠を記入する。 
各国の個別の事象をみる場合は、下図のエクセルのデータを黄色の枠で記入された部分に記入

する。青枠部分は自動で計算される値のため入力が不要となる。 
また、災害種 1、災害種 2 それぞれ別の災害を指定することができるため、それぞれの災害が

持つ発生確率および被害率を入力することで複合災害を扱うことが可能である。なお個別のパラ

メータの説明は前頁の表を参照されたい。 
 

 

 

 

図 4-8 Disaster Parameters のエクセルシート上での入力 

 
  

災害規模別発生確率 

対策ケース別災害規模別

各種被害率 

自動で計算される部分 

Editable data 

Auto-filled data 

Uneditable Parameters 

災害種別の設定 
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4.3.2 計算条件の指定 

以下には、エクセルのデータにおける計算条件の設定について説明する。 

(1) 災害発生の有無 

災害発生の有無を指定することができる。規定値では災害が発生するとする。自然災害が発

生しない場合の GDP の推移が理論的かどうかを検証する必要がある場合は、No を選択する

ことで確認することが可能である。 
 

(2) モンテカルロシミュレーション回数の指定 

モンテカルロシミュレーションの回数を任意で設定することが可能である。1000 回を規定

値とする。 
 

(3) 計算期間の設定 

プログラムの計算期間を任意で設定することが可能である。20 年を既定値とする。 
モデルの計算安定性を確保するため、最初の 3 年間は差異を調整するためのモデルの助走期

間として設定している。助走期間を含めた計算結果は csv ファイルにて確認することが可能で

ある。 
 

(4) 災害種の指定 

2 種類までの災害を設定可能である。いずれかの単一災害にするか、2 種類の複合災害にす

るかを指定する。規定値では災害１が設定されている。 
 

(5) 計算条件の表示 

アウトプットの図や CSV ファイルに、「計算日時」、「対象国」、「災害種」、「モンテカルロ

シミュレーション回数」を表示可能である。規定値は計算条件が表示されるように指定されて

いる。 
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図 4-9 災害種の選択による設定 
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(6) 計算条件の表示の有無の指定 

グラフ上に計算条件を表示するか非表示とするかを設定することが可能である。規定値では

計算条件が表示されるように指定されている。 
 

 
図 4-10 計算条件の表示設定 
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4.3.3 計算結果の保存場所の指定 

計算結果の保存場所を指定することが可能である。画像および計算結果(csv 形式)が指定した

フォルダに保存される。下図では対象のファイルが DR2ADver.2.4 内の”test”と指定されて

いる。 
 

 

図 4-11 保存場所の指定 
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4.3.4 計算の実行 

計算の実行ボタンを押すと、自動的に計算が実行され、指定したフォルダに結果が保存され

る。 
 

 

図 4-12 アプリケーションの計算実行画面 
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5 出力 

本章では、DR2AD model (Ver2.4) の出力について解説する。出力は、政策説明・政策決定

者判断用と分析用・実務担当者判断用の大きく 2 種類に分けられる。政策説明・政策決定者判断

用は、マクロ経済指標等による大局的なディシジョンメイキングのための活用が可能である。一

方で、分析用・実務担当者判断用では、階層間の家計指標を用いて、社会的格差等の社会問題の

分析のための活用が可能となっている。 

 

表 5-1 出力分類（概要）：表-5 の再掲 

使用用途 経済指標 出力形式 

政策説明 

・政策決定者判断 

マクロ経済指標による大局的な

政策判断に利用 

GDP、災害規模、災害頻度、

災害被害率など 

グラフ 

CSV ファイル 

分析用 

・実務担当者判断 

家計指標や所得階層別データ

による家計の生活水準を詳細

に分析 

一人当たり GDP（個人所得）、

消費、物的投資、金融資産、人

的資本、教育時間、人的投資

など 

CSV ファイル 

*CSV ファイルの出力値の見方については次項に記載する。 

 
 

 

 以下の表で CSV ファイルの出力値の見方を解説する。 

■CSVファイルの出力値の見方 

表 5-2 SV ファイルの出力値の見方 

 
 

 

 
 
 

* CSV ファイルに助走期間を表示させているが、基本的には使用しない。 

 

<File> GDP_DRR.csv <Date> 2015/7/14 <Country> Pakistan <Disaster Type> Flood+Earthquake <MonteCar lo(times)> 100
[From above] Period (year) Without Soft Hard1 Hard2 Hard1+Soft Hard2+Soft *GDP (average)

-2 -1 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
9.92E+10 1.06E+11 1.14E+11 1.22E+11 1.31E+11 1.40E+11 1.51E+11 1.62E+11 1.75E+11 1.88E+11 2.04E+11 2.20E+11 2.38E+11 2.58E+11 2.80E+11 3.04E+11 3.31E+11 3.60E+11
9.93E+10 1.07E+11 1.14E+11 1.22E+11 1.31E+11 1.40E+11 1.51E+11 1.62E+11 1.75E+11 1.89E+11 2.04E+11 2.20E+11 2.38E+11 2.58E+11 2.81E+11 3.05E+11 3.31E+11 3.61E+11
1.00E+11 1.08E+11 1.17E+11 1.25E+11 1.35E+11 1.46E+11 1.58E+11 1.70E+11 1.84E+11 1.99E+11 2.16E+11 2.34E+11 2.55E+11 2.77E+11 3.01E+11 3.28E+11 3.57E+11 3.89E+11
1.00E+11 1.08E+11 1.17E+11 1.26E+11 1.35E+11 1.46E+11 1.58E+11 1.70E+11 1.85E+11 2.00E+11 2.17E+11 2.35E+11 2.56E+11 2.78E+11 3.03E+11 3.29E+11 3.58E+11 3.90E+11
1.00E+11 1.08E+11 1.17E+11 1.25E+11 1.35E+11 1.46E+11 1.58E+11 1.70E+11 1.84E+11 1.99E+11 2.16E+11 2.34E+11 2.55E+11 2.77E+11 3.01E+11 3.28E+11 3.57E+11 3.89E+11
1 00E+11 1 08E+11 1 17E+11 1 26E+11 1 35E+11 1 46E+11 1 58E+11 1 70E+11 1 85E+11 2 00E+11 2 17E+11 2 35E+11 2 56E+11 2 78E+11 3 03E+11 3 29E+11 3 58E+11 3 90E+11

助走期間（3 年間） 
（利用しないデータ） 

計算期間 
（利用するデータ） 

データの凡例 
（下記例の場合、データ 1 行目から順に、期、対策なし、ソフト対策、ハード 1、 
ハード 2、ハード 1+ソフト、ハード 2+ソフト、シナリオ A、シナリオ B を示す。） 

ファイル名、日付、国名、災害

種、モンテカルロシミュレーシ

ョン回数を示す。 

… 
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表 5-3 出力分類（詳細） 

 

DR2AD MODEL ver2.4 出力内容 凡例
◎ 画像+csv保存 ○ 画像保存 ● csｖ保存

対策なし
ソフト対

策
ハード1 ハード2

ハード1+
ソフト

ハード2+
ソフト

シナリオ
1（対策
なし-

ハード1）

シナリオ
2（対策
なし-

ハード1-
ハード2）

GDP_DRR.png 対策別ＧＤＰの推移 ◎ ◎ ◎ ◎ ◎ ◎

GDP_DRR_ratio.png 対策別ＧＤＰの推移（対策なし基準） ◎ ◎ ◎ ◎ ◎ ◎

GDP_Scenario.png ＧＤＰのシナリオ分析 ◎ ◎ ◎ ◎ ◎ ◎

GDP_Scenario_ratio.png ＧＤＰのシナリオ分析（対策なし基準） ◎ ◎ ◎ ◎ ◎ ◎

DisasterClass_Average.png 災害の平均規模

DisasterClass_Average_Ratio.png 災害の平均規模（割合）

DisasterClass_Histogram.png 災害の規模別発生回数

DisasterClass_Histogram_Ratio.pn災害の規模別発生回数（割合）

DisasterRate_Human.png 災害被害率（人的資本） ◎ ◎ ◎ ◎ ◎ ◎

DisasterRate_Phisical.png 災害被害率（物的資本） ◎ ◎ ◎ ◎ ◎ ◎

DisasterRate_Financial.png 災害被害率（生産資本） ◎ ◎ ◎ ◎ ◎ ◎

DisasterRate_Land.png 災害被害率（土地） ◎ ◎ ◎ ◎ ◎ ◎

GDP_Capita_y_**.png 1人あたりＧＤＰの推移 ● ● ● ● ● ● ● ● ●

Consumption_c_**.png 階層別の消費の推移 ● ● ● ● ● ● ● ● ●

EducationTime_m_**.png 階層別の教育投資時間の推移 ● ● ● ● ● ● ● ● ●

FinancialAsset_b_**.png 階層別の金融資産の推移 ● ● ● ● ● ● ● ● ●

HumanCapital_h_**.png 階層別の人的資本の推移 ● ● ● ● ● ● ● ● ●

HumanInvestmentCost_eta_**.pn 階層別の人的投資費用の推移 ● ● ● ● ● ● ● ● ●

PhysicalAsset_z_**.png 階層別の物的資産の推移 ● ● ● ● ● ● ● ● ●

GDP_Monte_Average.png ＧＤＰの推移（平均値） ○

GDP_Monte.png ＧＤＰの推移（モンテカルロシミュレーション） ◎

政策説明・政策決定者判断

分析用・実務担当者判断

その他参考

対策別

階層別概要グラフ名使用用途

◎

◎

◎

◎
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5.1 政策説明・政策決定者のための出力内容 

 ここでは出力内容について下記の例を用いて説明する。 
対象国 ホンジュラス 
対象災害 洪水 

5.1.1 防災対策別GDP 

防災対策別の GDP の長期的成長を分析する。防災対策は、以下の 6 種類を想定する。 
 

① 対策なし 
② ソフト対策 
③ ハード対策 1 
④ ハード対策 2 
⑤ ハード対策 1 + ソフト対策 
⑥ ハード対策 2 + ソフト対策 

 
災害種（洪水、地震など）により、ソフト対策やハード対策の投資効果が異なるため、その

ベストミックスを探るために有用である。 

表 5-4 防災対策別 GDP の出力例（グラフ） 

防災対策別 GDP（実数値） 防災対策別 GDP（With / Without 比） 

  
上図の例では、防災投資がＧＤＰの成長に重要な影響をもたらすことが確認できる。ホンジ
ュラスの洪水ケースでは人的資本被害率が高いため、ソフト対策がハード対策よりも高い防
災投資効果をもたらす。さらに、ハート対策とソフト対策の組み合わせはより GDP の成長に
対して効果的であり、防災投資をしないケースと比べるとその差が経年的に増加していくこ
とが確認できる。 

 

表 5-5 防災対策別 GDP（With / Without 比）の出力例（CSV ファイル） 

 
*CSV ファイルの-2 期～0 期はモデルの助走期間（3 年間）を示す。 

<File> GDP_DRR_ratio.csv <Date> 2015/7/14 <Country> Pakistan <Disaster Type> Flood+Earthquake <MonteCar lo(times)> 100
[From above] Period (year) Soft/Without Hard1/Without Hard2/Without (Hard1+Soft)/Without (Hard2+Soft)/Without *GDP ratio (with/without)

-2 -1 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
1.0007 1.0007 1.0007 1.001 1.001 1.001 1.0011 1.0011 1.0012 1.0012 1.0012 1.0014 1.0014 1.0014 1.0015 1.0015 1.0016 1.0014 1.0014 1.0015 1.0016 1.0017 1.0016
1.0112 1.0172 1.0229 1.0299 1.0355 1.0403 1.0458 1.0495 1.054 1.0582 1.0613 1.065 1.0691 1.0721 1.0751 1.0774 1.0779 1.0793 1.082 1.0838 1.085 1.0876 1.0882
1.0121 1.0182 1.0243 1.0316 1.0375 1.0423 1.0478 1.0522 1.0569 1.0615 1.065 1.0692 1.0736 1.0771 1.08 1.082 1.0826 1.0841 1.0868 1.0886 1.09 1.093 1.0931
1.0112 1.0173 1.0231 1.03 1.0356 1.0403 1.0458 1.0496 1.0541 1.0584 1.0614 1.0652 1.0692 1.0723 1.0752 1.0775 1.078 1.0794 1.0821 1.0839 1.0853 1.0878 1.0883
1.0121 1.0182 1.0243 1.0316 1.0375 1.0424 1.0479 1.0523 1.057 1.0616 1.065 1.0693 1.0737 1.0771 1.08 1.082 1.0827 1.0842 1.0868 1.0886 1.0901 1.0931 1.0931
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5.1.2 シナリオ別GDP 

シナリオ別の GDP の長期的成長を分析する。シナリオは、以下の 5 種類を想定する。 
 

① 基準年からソフト対策を実施 
② 基準年からハード対策 1 を実施 
③ 基準年からハード対策 2 を実施 
④ 基準年は防災対策なし、6 年後からハード対策 1 を実施（シナリオ A） 
⑤ 基準年は防災対策なし、6 年後からハード対策 1 を実施、11 年後からハード対策 2

を実施（シナリオ B） 

 

シナリオ別に GDP の成長を分析することにより、防災投資の適切なタイミングや投資規模

を探ることが可能である。 
 

表 5-6 シナリオ別 GDP の出力例（グラフ） 

シナリオ別 GDP（実数値） シナリオ別 GDP（With / Without 比） 

  
人的資本の被害率が大きいため、貧困層に対する人的被害を緩和することができるソフト対策
がもっとも効果的であることが分かる。加えて、ハード対策も効果的であることが確認できる。
それぞれの防災対策のシナリオを比較することで、防災投資を早くから始めればはじめるほ
ど、防災対策効果がより大きくなることが確認できる。 

 

表 5-7 シナリオ別 GDP（実数値）の出力例（CSV ファイル） 

 
*CSV ファイルの-2 期～0 期はモデルの助走期間（3 年間）を示す。 

  

<File> GDP_Scenario.csv <Date> 2015/7/14 <Country> Pakistan <Disaster Type> Flood+Earthquake <MonteCar lo(times)> 100
[From above] Period (year) Without Soft Hard1 Hard2 ScenarioA ScenarioB *GDP (average)

-2 -1 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
9.92E+10 1.06E+11 1.14E+11 1.22E+11 1.31E+11 1.40E+11 1.51E+11 1.62E+11 1.75E+11 1.88E+11 2.04E+11 2.20E+11 2.38E+11 2.58E+11 2.80E+11 3.04E+11 3.31E+11 3.60E+11 3.91E+11 4.26E+11 4.65E+11 5.06E+11 5.53E+11
9.93E+10 1.07E+11 1.14E+11 1.22E+11 1.31E+11 1.40E+11 1.51E+11 1.62E+11 1.75E+11 1.89E+11 2.04E+11 2.20E+11 2.38E+11 2.58E+11 2.81E+11 3.05E+11 3.31E+11 3.61E+11 3.92E+11 4.27E+11 4.65E+11 5.07E+11 5.54E+11
1.00E+11 1.08E+11 1.17E+11 1.25E+11 1.35E+11 1.46E+11 1.58E+11 1.70E+11 1.84E+11 1.99E+11 2.16E+11 2.34E+11 2.55E+11 2.77E+11 3.01E+11 3.28E+11 3.57E+11 3.89E+11 4.24E+11 4.62E+11 5.04E+11 5.51E+11 6.02E+11
1.00E+11 1.08E+11 1.17E+11 1.26E+11 1.35E+11 1.46E+11 1.58E+11 1.70E+11 1.85E+11 2.00E+11 2.17E+11 2.35E+11 2.56E+11 2.78E+11 3.03E+11 3.29E+11 3.58E+11 3.90E+11 4.25E+11 4.64E+11 5.07E+11 5.53E+11 6.04E+11
9.92E+10 1.06E+11 1.14E+11 1.22E+11 1.31E+11 1.40E+11 1.51E+11 1.62E+11 1.76E+11 1.91E+11 2.08E+11 2.26E+11 2.46E+11 2.68E+11 2.92E+11 3.19E+11 3.47E+11 3.79E+11 4.13E+11 4.52E+11 4.93E+11 5.39E+11 5.90E+11
9.92E+10 1.06E+11 1.14E+11 1.22E+11 1.31E+11 1.40E+11 1.51E+11 1.62E+11 1.76E+11 1.91E+11 2.08E+11 2.26E+11 2.46E+11 2.68E+11 2.92E+11 3.19E+11 3.48E+11 3.80E+11 4.14E+11 4.53E+11 4.94E+11 5.41E+11 5.92E+11
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5.1.3 災害規模・頻度 

災害規模の平均値及びモンテカルロシミュレーションにて発生した災害頻度を把握する。災

害規模・頻度は、以下の 3 種類を想定する。 
 

① 災害 1 の災害規模・頻度 
② 災害 2 の災害規模・頻度 
③ 複合災害（災害 1+災害 2）の災害規模・頻度 

 
災害規模・頻度を分析することにより、適切な防災投資規模の検討に利用可能である。 

表 5-8 災害規模・頻度の出力例（グラフ） 

災害規模 災害頻度 

  

災害規模が 0 または 1 の災害頻度が高い。つまり、災害規模 1 までを防ぐことが可能な小規模

な防災投資だけでも、多くの災害被害を防ぐことができると想定される。 

参考：複合災害の場合の災害規模と災害発生頻度 (Disaster1 and Disaster2) 

  

表 5-9 災害規模・頻度の出力例（CSV ファイル） 

 
*CSV ファイルの-2 期～0 期はモデルの助走期間（3 年間）を示す。 

 

 

<File> DisasterClass_Average.csv <Date> 2015/7/14 <Country> Pakistan <Disaster Type> Flood+Earthquake <MonteCar lo(times)> 100
[From above] Period (year) Flood Earthquake *average class

-2 -1 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
0.5 0.49 0.44 0.65 0.6 0.57 0.63 0.56 0.56 0.57 0.46 0.63 0.6 0.54 0.59 0.61 0.63 0.49 0.47 0.52 0.52 0.62 0.55

0.59 0.53 0.57 0.67 0.55 0.48 0.54 0.61 0.53 0.61 0.61 0.54 0.62 0.61 0.5 0.52 0.57 0.47 0.57 0.47 0.49 0.54 0.47
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5.1.4 災害被害率 

各年次における防災対策別の災害被害率の平均値を把握する。防災対策別の災害被害率を図

化することにより、各年次における災害被害率が防災対策により、どの程度低減しているのか

を視覚的に把握可能となる。 
 

表 5-10 災害被害率の出力例（グラフ） 

人的被害率 家計被害率 

  

企業被害率 土地被害率 

  

人的被害率をみると、防災対策により被害率が軽減されることがわかる。特に、ソフト対策有効で

あり、平均被害率を０にまで大きく低減させることが分かる。※その他の効果についてはハード対

策が有効だが元の値が小さいため、対策なしとグラフが被っている点に注意が必要 

 

表 5-11 災害被害率の出力例（CSV ファイル） 

 
*CSV ファイルの-2 期～0 期はモデルの助走期間（3 年間）を示す。 

 

<File> DisasterRate_Human.csv <Date> 2015/7/14 <Country> Pakistan <Disaster Type> Flood+Earthquake <MonteCar lo(times)> 100
[From above] Period (year) Without Soft Hard1 Hard2 Hard1+Soft Hard2+Soft *disaster damage rate

-2 -1 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
0.0014387 0.0013497 0.0012879 0.0018436 0.0016048 0.0015301 0.001663 0.0016231 0.0015476 0.0016378 0.0013679 0.001762 0.0016548 0.0015733 0.0016 0.0016357 0.0017038 0.0013191 0.0013022 0.0013893 0.0014601 0.0017386 0.0014546
0.000203 0.000159 0.00018 0.000213 0.000178 0.000152 0.000166 0.000208 0.000171 0.000199 0.000204 0.000183 0.000211 0.000205 0.000158 0.000164 0.000185 0.00015 0.00018 0.00015 0.00016 0.000183 0.000145
6.34E-05 2.60E-05 0.0002135 0.0002262 6.94E-05 7.40E-05 5.91E-05 0.0002482 0.0001774 0.0003036 0.0001793 0.0002122 0.0001421 0.0002188 0.0001183 2.97E-05 0.0001447 2.33E-05 3.47E-05 2.33E-05 0.0002726 0.0002122 1.49E-05
4.57E-06 0 0.0001327 6.88E-05 1.88E-05 1.65E-05 1.65E-05 0.0001225 4.96E-05 0.000134 5.46E-05 9.36E-05 8.67E-05 9.59E-05 6.52E-05 0 4.73E-05 2.28E-06 1.19E-05 2.28E-06 0.0001171 9.36E-05 0
2.43E-05 0 1.03E-05 2.84E-05 1.22E-05 3.70E-06 1.85E-06 6.33E-05 5.55E-06 3.02E-05 3.87E-05 2.73E-05 4.05E-05 3.39E-05 3.70E-06 3.70E-06 3.02E-05 1.03E-05 2.17E-05 1.03E-05 1.22E-05 2.73E-05 1.85E-06
4.57E-06 0 2.28E-06 1.93E-05 2.28E-06 0 0 4.08E-05 0 1.93E-05 2.15E-05 1.19E-05 2.15E-05 1.42E-05 0 0 1.42E-05 2.28E-06 1.19E-05 2.28E-06 2.28E-06 1.19E-05 0
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5.2 分析用・実務担当者のための出力内容 

分析用・実務担当者のために、以下の項目のデータを含んだ CSV ファイルが出力されるため、

データを用いて定量的な分析が可能である。 
① 階層別の 1 人あたり GDP の推移 
② 階層別の消費の推移 
③ 階層別の物的資産の推移 
④ 階層別の金融資産の推移 
⑤ 階層別の人的資本の推移 
⑥ 階層別の教育投資時間の推移 
⑦ 階層別の人的投資費用の推移 
また、データを使用することで、下記のようにグラフ化を行い、挙動を視覚的に分析すること

も可能となる。 

表 5-12 所得階層別の消費量の出力例（CSV ファイル） 

 
*CSV ファイルの-2 期～0 期はモデルの助走期間（3 年間）を示す。 

表 5-13 所得階層別データのグラフ作成例（1/2） 
階層別の 1 人あたり GDP の推移 階層別の消費の推移 

  
階層別の物的資産の推移 階層別の金融資産の推移 

  
防災対策なし時における階層別の家計の期待成長である。階層の逆転は起きていない。 

<File> Consumption_c_Without.csv <Date> 2015/7/14 <Country> Pakistan <Disaster Type> Flood+Earthquake <MonteCar lo(times)> 100
[From above] Period (year) 1st(poorest) 2nd(poor) 3rd(middle) 4th(rich) 5th(richest)

-2 -1 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
210.08 230.96 253.96 278.59 304.05 332.67 364.54 398.65 435.44 476.77 521.34 570.85 625.77 685.5 752.36 828.54 912.43 1004.5 1110.7 1226.3 1357.8 1503.5 1660.3
290.96 313.99 339.91 368 397.19 430.49 467.94 508.19 551.75 600.91 653.99 713.03 778.58 849.79 929.51 1020.3 1120.2 1229.6 1354.4 1488.5 1639.5 1805.4 1984.8
371.19 392.26 417.22 445.05 474.41 508.85 548.3 591.09 637.77 690.93 748.55 812.92 884.6 962.55 1050 1149.2 1257.2 1374.4 1508.4 1652.8 1815.9 1995.3 2189.4
480.13 498.5 522.33 550.14 580.16 616.64 659.35 706.18 757.72 816.98 881.49 953.87 1033.9 1120.3 1216.5 1325.9 1445.4 1575.4 1724.8 1885.9 2068.3 2268.9 2486
917.32 906.78 912.15 928.23 949.71 982.87 1026.6 1077 1134.5 1203.5 1279.7 1366.7 1464.9 1572.3 1693.5 1832.7 1985.4 2152.2 2340.7 2539.5 2760.6 2999.6 3253.3
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表 5-14 所得階層別データのグラフ作成例（2/2） 

階層別の人的資本の推移 階層別の教育投資時間の推移 

  
階層別の人的投資費用の推移 

 
人的投資費用関数を教育水準別（小学校、中学校、高校、大学）のステップ関数として設定し

ているため、教育水準の切り替り時に教育投資時間や人的投資費用にショックが生じる。また、

教育水準が上昇するほど、一単位の人的資本を上昇させるための人的投資費用が大きくなるた

め、人的資本の成長率は人的資本の成長とともに逓減する。 
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5.3 その他の出力内容 

その他の出力としてモンテカルロシミュレーションの結果が出力される。 
 

表 5-15 GDP の出力例（モンテカルロシミュレーションと期待成長） 

GDP（モンテカルロシミュレーション） GDP（期待成長） 

  

1,000 回のモンテカルロシミュレーションにより、GDP の期待成長を算出した例である。 
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第 3 編 DR2AD model（Ver1.4）のデータセットの構築 

6 データセットの構築 

本章では DR2AD model （Ver1.4）における試行に必要なデータセットの内容、および一般的

な設定方法について実際のデータにより解説する。デフォルト値として本アプリケーションに附

属するサンプルエクセルデータの使用ではなく、自国のデータセットを用いて防災投資効果を評

価したい場合は、以下の手順に従ってデータを構築する。 

 
※本アプリケーションでは、附属するサンプルエクセルファイルに表示した 5 カ国以外のデー

タについては、必ずしも動作を保証するものではない。 
 

6.1 事前準備 

6.1.1 用意するデータ 

モデルで使用するデータと主な取得先は下表のとおり整理される。ただし、データの大半は

複数のデータを組み合わせることで生成されるため、詳細については後述する個別のデータの

作成方法を参照されたい。 
 

データ取得先 作成可能データ 

The World Development Indicator Population, GDP0, c, z, etc., 

Input Output table / Social Account matrix Alpha1,2,3 

Household Survey c,b,z  etc., 

Mean years of schooling (UNDP) h, m0 

Institute for Statistic(UNESCO) eta 

 
 

6.1.2 基準年の設定 

モデルの計算期間の基準年を指定する。 
基本的にはモデルの基準年は巨大災害発生年のようなモデルの挙動に著しく影響を与える年

次は避けることが望ましい。 
※なお、サンプルプログラムにおいては、データの取得時間の関係から、2004 年を基準とし

ている。 
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6.1.3 データ収集方法 

ここでは、主なデータ取得先である国際機関（World Bank, UNDP, UNESCE）からのデー

タ収集方法を説明する。 
 

(1) The World Development Indicator (World Bank) 

① Access worldbank.org and click “Data” 

 
 

② Click “By Country” 

 
  

CLICK “DATA”

CLICK “By Country”
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③ Choose a target country 

  

 
④ Click “DOWNLOAD DATA” 

 
  

CLICK “DOWNLOAD DATA”
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⑤ Select “EXCEL” 

 
 

⑥ Download will start shortly 

 
 
 
  

Start Download
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⑦ Select Data tab and you can collect all required data 

 
 
  

Open the EXCEL then 
Choose “Data” tab
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(2) Human Development Reports (UNDP) 

① Access undp.org and click “Data” 

 

 
② Scroll the page down 
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③ Choose a “Mean years of schooling (of adults) (years)” and Click 

 

 
④ Click “Download the data” to start your download 

D  
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⑤ You can find the data sorted by country 
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(3) Institute for Statics (UNESCO) 

① Access uis.unesco.org and click “EDUCATION” 

 

 
② Click “Education Finance” 
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③ Scroll the page down  

 

 
④ Click “Government expenditure per student as % GDP per capita” 
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⑤ Choose the education level such as primary, secondary, etc. 

 

 
⑥ Choose Export and click “Excel” 
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⑦ Click “Export to XLS file” 

 

 
⑧ You can collect data sorted by country 
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6.2 Input Dataの設定例 

プログラムに使用する変数、設定方法および、例示としてホンジュラスのケーススタディでの

設定値を下表に示す。推計や加工が必要なデータについては次節にて別途解説する。 

表 6-1 変数の設定方法およびケーススタディにおける設定例 

Parameter 
name 

Default value Description Data source Reference 

J 5 The number of income group Normally no need to change 85 

L 4 
the number of disaster classes 
(not including the no-disaster 
state) 

Normally no need to change 85 

rho 0.12 original discount rate Normally no need to change 86 
theta 2 degree of relative risk aversion Normally no need to change 86 
cbar 0 subsistence level of consumption Normally no need to change 86 

deltaz 0.1 depreciation rate of household 
asset 

Normally no need to change 86 

deltak 0.02 depreciation rate of production 
capital  

Normally no need to change 86 

gb 0.042 Exogenous technological growth 
rate 

Normally no need to change 87 

iota 1 If 1, no influence. Normally no need to change 87 
Pop0 6762426 Initial population World Bank data (by Country) 88 
GDP0 9120240790 Initial GDP US$ (2004, from 

World bank HP, 2005US$) World Bank data (by Country) 89 

alpha1 0.45 share parameter for human 
capital, h 

Social Account Matrix/Input 
Output Table 

90 

alpha2 0.47 share parameter for physical 
capital, k 

Social Account Matrix/Input 
Output Table 

90 

alpha3 0.08 share parameter for land, ld Social Account Matrix/Input 
Output Table 

90 

c0 

93 
243 
448 
787 

2564 

Initial consumption per capita: 
Data of Households' survey 2004 

Household Survey /JICA 
Poverty Profile 

98 

h0 

3.3 
4.2  
5.0 
6.0 
6.9 

Initial human capital per capita 
(years of education) 

UNDP data (Mean years of 
schooling)/Household Survey 
/JICA Poverty Profile 

99 

z0 

112 
293 
540 
949 

3091 

Initial physical asset investment 
as flow variable 

Household Survey /JICA 
Poverty Profile 

100 

b0 

321 
842 

1554 
2732 
8899 

Initial financial assets per 
individual 

World Bank data (by Country) 102 

T0 

0.02 
0.05 
0.08 
0.15 
0.48 

Initial financial assets per 
individual 

World Bank data (by Country) 104 

m0 0.33 Initial financial assets per 
individual 

Household Survey /JICA 
Poverty Profile 

105 

deltah 0.004 depreciation rate of human 
capital 

World Bank data (by Country) 106 

eta0 0 
 INSTITUTE for STATISTICS, 

UNESCO/World Development 
Indicator, World Bank 

エラー! ブックマー

クが定義されていま

せん。 

eta1 0 
 INSTITUTE for STATISTICS, 

UNESCO/World Development 
Indicator, World Bank 

エラー! ブックマー

クが定義されていま

せん。 
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eta2M 205.8 
  エラー! ブックマー

クが定義されていま

せん。 

eta2Mvect
or 

205.8 
245.3 
381.3 

1092.6 
1504.3 
1918.7 
5347.2 
20000 

0<h<=6 
6<h<=9 
9<h<=11 
11<h<=15 
15<h<=17 
17<h<=20 
20<h<=60 

INSTITUTE for STATISTICS, 
UNESCO/World Development 
Indicator, World Bank 

1 エラー! ブックマ

ークが定義されてい

ません。 

 
表 6-2 Reference of Input Data of Disaster Parameters 
 Description Data source 

omegaV_DISASTER 
(1 or 2) 

Human capital damage 
rate due to disaster by 
rank 

Human capital damage: 
Desinventar / UNISDR 
population : 
World Bank data (by Country) 

phiV_DISASTER 
(1 or 2) 

Physical assets damage 
rate due to disaster by 
rank 

Physical assets damage： 
Desinventar / UNISDR 
Household: 
Household Survey /JICA Poverty 
Profile 

psiV_DISASTER 
(1 or 2) 

Production capital 
damage rate due to 
disaster by rank 

Set following the relationship 
between Capital damage rate and 
Physical assets damage rate  

tauV_DISASTER 
(1 or 2) 

Damage rate of land 
due to disaster by rank 

There are no disaster in this study 

mu 
Probability of disaster 
occurrence by rank 

UNISDR database Desinventar 
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表 6-3 Input Data List of sheet1 on Disaster Parameters (Disaster1 =FLOOD)  

Parameter name Sample value 

Disaster Rank Rank 0 Rank1 Rank 2 Rank 3 Rank 4 
mu 0.500 0.464 0.019 0.011 0.007 

DRR Without 
omegaV_DISASTER1 0 0.110046 0.298150 0.400638 0.475017 

phiV_DISASTER1 0 0.000191 0.000488 0.000634 0.000749 
psiV_DISASTER1 0 0.000840 0.002149 0.002789 0.003294 
tauV_DISASTER1 0 0 0 0 0 

DRR Soft 
omegaV_DISASTER1 0 0 0 0 0 

phiV_DISASTER1 0 0.000191 0.000488 0.000634 0.000749 
psiV_DISASTER1 0 0.000840 0.002149 0.002789 0.003294 
tauV_DISASTER1 0 0 0 0 0 

DRR Hard1 
omegaV_DISASTER1 0 0 0.078125 0.273375 0.402195 

phiV_DISASTER1 0 0 0.000153 0.000474 0.000656 
psiV_DISASTER1 0 0 0.000671 0.002084 0.002886 
tauV_DISASTER1 0 0 0 0 0 

DRR Hard2 
omegaV_DISASTER1 0 0 0 0.099688 0.313246 

phiV_DISASTER1 0 0 0 0.000200 0.000541 
psiV_DISASTER1 0 0 0 0.000881 0.002380 
tauV_DISASTER1 0 0 0 0 0 

DRR Hard1+soft 
omegaV_DISASTER1 0 0 0 0 0 

phiV_DISASTER1 0 0 0.000153 0.000474 0.000656 
psiV_DISASTER1 0 0 0.000671 0.002084 0.002886 
tauV_DISASTER1 0 0 0 0 0 

DRR Hard2+soft 
omegaV_DISASTER1 0 0 0 0 0 

phiV_DISASTER1 0 0 0 0.000200 0.000541 
psiV_DISASTER1 0 0 0 0.000881 0.002380 
tauV_DISASTER1 0 0 0 0 0 
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表 6-4 Input Data List of sheet2 on Disaster Parameters (Disaster2 =EARTHQUAKE) 

Parameter name Sample value 

Disaster Rank Rank 0 Rank1 Rank 2 Rank 3 Rank 4 

mu 0.5 0.468048 0.015625 0.009615 0.006711 
DRR Without 

omegaV_DISASTER2 0 0.0003 0.000928 0.001243 0.001485 

phiV_DISASTER2 0 0.001339 0.003731 0.005008 0.005959 

psiV_DISASTER2 0 0.005893 0.016416 0.022035 0.026222 

tauV_DISASTER2 0 0 0 0 0 

DRR Soft 

omegaV_DISASTER2 0 0.0003 0.000928 0.001243 0.001485 

phiV_DISASTER2 0 0.001339 0.003731 0.005008 0.005959 

psiV_DISASTER2 0 0.005893 0.016416 0.022035 0.026222 

tauV_DISASTER2 0 0 0 0 0 

DRR Hard1 

omegaV_DISASTER2 0 0 0.000139 0.000719 0.00116 

phiV_DISASTER2 0 0 0.000914 0.003369 0.004995 

psiV_DISASTER2 0 0 0.004019 0.014823 0.021976 

tauV_DISASTER2 0 0 0 0 0 

DRR Hard2 

omegaV_DISASTER2 0 0 0 0.000175 0.000813 

phiV_DISASTER2 0 0 0 0.001179 0.003873 

psiV_DISASTER2 0 0 0 0.005188 0.017041 

tauV_DISASTER2 0 0 0 0 0 

DRR Hard1+soft 
omegaV_DISASTER2 0 0 0.000139 0.000719 0.00116 

phiV_DISASTER2 0 0 0.000914 0.003369 0.004995 

psiV_DISASTER2 0 0 0.004019 0.014823 0.021976 

tauV_DISASTER2 0 0 0 0 0 

DRR Hard2+soft 
omegaV_DISASTER2 0 0 0 0.000175 0.000813 

phiV_DISASTER2 0 0 0 0.001179 0.003873 

psiV_DISASTER2 0 0 0 0.005188 0.017041 

tauV_DISASTER2 0 0 0 0 0 
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6.3 Input Dataの設定方法 

Input Data を整理するにあたり、Input Data を Deep Parameter、マクロ経済データ、家計

データ、災害データの 4 種類に区分して整理する。 
 

表 6-5 Input Data のデータ種別 

データ種別 データ例 データの詳細 

Socio Economic 
Parameters 

Deep 
Parameter 

相対的危険回避度、

減耗率など 固定値 

マクロ経済 
データ 総人口、GDP など 

本章で設定方法を

詳述 
家計データ 消費、貯蓄、人的投

資、物的投資など 
Disaster 
Parameters 災害データ 人的被害率、物的被

害率など 
本章で設定方法を

詳述 
 

6.3.1 Deep Parameter 
固定値とするパラメータを本アプリケーションでは Deep Parameter と呼ぶ。 

 

(1) 所得階層数J 

本モデルにおける所得階層数は、世界銀行の階層別所得シェアデータ等の利用可能なデータ

との整合を考慮して 5 階層とする。 
 

所得階層数 J = 5 

 

(2) 災害ランク数L 

災害ランクは 0～4 の 5 ランクが存在するものと仮定する。（災害ランク及びその災害被害

率の具体の設定方法は、APPEMDIX D を参照） 
 

災害ランク数 L = 4 
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(3) 時間選好率ρ 

時間選好率とは、現在の消費を抑制し、将来のために貯蓄するようになる金利水準である。

つまり、現在の消費と将来の消費（貯蓄）を関連付けるものであり、時間選好率が大きいほど

現在の消費を重視する傾向があることを示す。規定値を 0.12 とする。 
 

時間選好率 ρ = 0.12 

 

(4) 相対的危険回避度θ 

家計のリスク選好度を示すものであり、数値が大きいほどリスクを回避する傾向があること

を示す。ここでは、Kraay and Raddatz (2007) を参考に 2 と設定する。 
 

相対的危険回避度 θ = 2 

 

(5) 生存最低必要消費水準cbar 

生存に最低限必要な消費額を示すものであり、貧困の罠を考慮可能とするものである。簡便

化のため、0 と設定する。 
 

生存最低必要消費水準 c� = 0 

 

(6) 物的資産減耗率δz 

毎期の物的資産が減耗する割合である。ここでは、物的資産の償却期間は 10 年であると仮

定し、0.1 と設定する。 
 

物的資産減耗率 δz = 0.1 

 

(7) 生産資本減耗率δk 

毎期の生産資本が減耗する割合である。ここでは、生産資本の償却期間は 50 年であると仮

定し、0.02 を設定する。 
 

生産資本減耗率 δk = 0.02 
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(8) 外生的技術進歩率gb 

全要素生産性の進歩率を示す。ここでは、一人当たり GDP と GDP 成長率の関係から、0.042
とする。（具体の設定方法は APPENDIX Ｂを参照） 

 
外生的技術進歩率 gb = 0.042 

 

(9) 人的資本形成の補正係数ι 

人的投資額と教育年数の関係を補正する係数である。パラメータの特定（キャリブレーショ

ン）の調整のために導入したものであるため、基本的には 1 とする。（1 の場合はモデルに影

響が出ない） 
 

人的資本形成の補正係数 ι = 1 
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6.3.2 社会経済データの整理・設定 

人口や GDP についてデータを収集・整理を行う。生産関数のシェアパラメータについては、

産業連関表や SAM をもとに労働投入、資本投入等の分配比率を設定する。 
 

(1) 階層別人口n 

各所得階層の人口は、世界銀行の階層別所得シェアデータ等の利用可能なデータとの整合を

考慮して、各階層で均等になるよう設定する。 
 

1）必要データ 

 World Bank data (by Country)を使用 
 使用する項目は”Population,total” 

 
 

2）設定方法 

総人口を所得階層数で除することにより導出する。 
 

𝑛 =
POT
ICG

 

𝑛:階層別人口 
POT：総人口 

ICG：所得階層数 
 

3）設定例 

上述の式を用いて、階層別人口を求めた結果を以下の表にまとめる。 
 

表 6-6 階層別人口（2004 年値） 

Country Honduras Pakistan Guatemala Peru Costa Rica 

総人口（人） 6,762,426 155,151,394 12,367,800 27,403,845 4,246,336 
所得階層数 5 5 5 5 5 

階層別人口 n
（人） 

1,352,485 31,030,279 2,473,560 5,480,769 849,267 
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(2) GDP 

GDP の初期値は、外生的技術進歩係数 B0をキャリブレーションする際に用いる。なお、外

生的技術進歩係数 B0については、GDP の初期値を入れることにより自動的に導出されるよう

プログラムされている。 
 
1）必要データ 

 World Bank data (by Country)を使用 
 使用する項目は”GDP (constant 2005 US$)” 

 
 

2）設定方法 

World Bank のデータベースより取得した生データをそのまま用いる。 
 
 

3）設定例 

参考として、各国の GDP を以下の表にまとめる。 
 

表 6-7 GDP（2004 年値） 

Group 
Lower-middle-income  

economies 
Upper-middle-income economies 

Country Honduras Pakistan Guatemala Peru Costa Rica 

GDP 
(constant 
2005 US$) 

9,120,240,790 101,704,136,879 26,352,121,441 70,530,831,291 18,855,016,400 

*Group は世界銀行で用いられている基準にて区分（なお、世界銀行の区分では Lower-middle-income economies は平均所得

が$1,046 から$4,125 までの国家、Lower-middle-income economies は平均所得が$4,126 から$12,745 までの国家としている） 
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(3) 生産関数のシェアパラメータα 

1）必要データ 

 Social Account Matrix または Input Output Table 
 

2）設定方法 

各国の Social Accounting Matrix (SAM) データにおける Wage と Capital、または Input 
Output Table における Wage と Non-Wage Income から生産要素の投入比率を算定し、それ

を生産関数のシェアパラメータとして使用する。 

𝛼1 =
WIN

（WIN + CIN + RIN）
 

𝛼2 =
CIN

（WIN + CIN + RIN）
 

𝛼3 =
RIN

（WIN + CIN + RIN））
 

 
𝛼1：労働投入シェア 
𝛼2:資本投入シェア 
𝛼3:土地投入シェア 

WIN:労働所得 
CIN:資本所得 
RIN:地代所得 

 
 

3）設定例 

ホンジュラスを例に生産関数のシェアパラメータを設定したものを以下に示す。ホンジュ

ラスの SAM データは Lizardo et al. (1999) により整理されたものが存在する。 
 

表 6-8 生産関数のシェアパラメータ（ホンジュラス、1991 年値） 

生産要素 入力値 小計額 合計額 比率 

Urban Wage Earner 
α1 

5606.70 
6917.80 0.45 

Rural Wage Earner 1311.10 

Capital α2 7084.50 7084.50 0.47 

Land α3 不明 不明 0.08※ 
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表 6-9 生産関数のシェアパラメータ 

生産要素 Honduras Pakistan Guatemala Peru Costa Rica 入力値 
Urban Wage 
Earner 

0.45 0.52 0.38 0.38 0.45 α1 
Rural Wage 
Earner 
Capital 0.47 0.4 0.54 0.54 0.47 α2 

Land 0.08 0.08 0.08 0.08 0.08 α3 
※土地のデータに関する情報が不足しているため、各国の土地の比率α3はパキスタンと同率（原則 0.08）と仮定

した。 

*Guatemala と Costa Rica に関してはデータが得られなかったため、仮定値を設定している。 
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Reference: Lizardo et al. (1999) 
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6.3.3 家計データの整理・設定 

次に、消費額、物的資産、金融資産、人的資本等の家計の初期値データを収集・整理する。

所得階層別にデータ把握が可能な場合には、階層別に把握する。 
また、消費のシェアパラメータの初期値データについては、家計調査データを用いて、消費

と物的資産への分配割合を算出して設定する。 
 

(1) 所得分配 

各階層の各所得分配額を把握する。本データは、後述の金融資産等の設定の際に用いる。 
 

1）必要データ 

 World Bank data (by Country)を使用 
 使用する項目は ”GDP (constant 2005 US$)”、 “Income share held by lowest 

20%”、 ”Income share held by second 20%”、 ”Income share held by third 
20%”、”Income share held by fourth 20%”、”Income share held by highest 20%” 

 

表 6-10 所得分配の設定に必要な World Bank data 

Name of Data 

GDP (constant 2005 US$) 
Income share held by lowest 20% 
Income share held by second 20% 
Income share held by third 20% 
Income share held by fourth 20% 
Income share held by highest 20% 
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2）設定方法 

まず、社会経済データにて設定したシェアパラメータαi により GDP を案分して労働所

得・資本所得を得る。次に、階層別のデータを算出するため、所得シェアを使用して労働所

得・資本所得を階層毎に分配する。（証明は APPENDIX C の「参考：所得分配の関係式の導

出」にて説明） 
 

𝛽1 =
GDP ∙ 𝛼1 ∙ 𝑎𝑎

𝑛
 

𝛽2 =
GDP ∙ 𝛼2 ∙ 𝑎𝑎

𝑛
 

𝛽3 =
GDP ∙ 𝛼3 ∙ 𝑎𝑎

𝑛
 

 
𝛽1：階層別一人あたり労働所得 
𝛽2：階層別一人あたり資本所得 
𝛽3：階層別一人あたり地代所得 

𝐺𝐷𝑃：総所得 
𝛼1：労働投入シェア 
𝛼2:資本投入シェア 
𝛼3:土地投入シェア 
𝑎𝑎：所得シェア 
𝑛：階層別人口 

 
※𝛼𝑖は生産関数のシェアパラメータを示す。 
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3）設定例 

ホンジュラスを例に挙げると、以下のように各階層の所得を求めることができる。 

表 6-11 所得分配（ホンジュラス、1994 年値） 

所得分配 GDP (billion $) 𝛼𝑖値 GDP (billion $)×𝛼𝑖値 

労働所得 
6.376 

0.45 2.869 
資本所得 0.47 2.997 

 
算出した労働所得・資本所得を所得シェアで 5 階層に案分し、さらに案分したデータを各

階層の人口で割ることで一人あたりの労働所得・資本所得を算出する。 
 

表 6-12 階層別一人当たり労働所得（ホンジュラス、1994 年値） 

所得階層 
労働所得（全体） 

(billion $) 
所得シェア 

労働所得（階層別） 
(billion $) 

労働所得（一人当たり） 
($) 

1st (poorest) 

2.869 

0.032 0.092 84.4 
2nd (poor) 0.069 0.200 182.9 
3rd (middle) 0.115 0.334 305.6 
4th (rich) 0.192 0.556 509.0 
5th (richest) 0.593 1.717 1573.3 

 

表 6-13 階層別一人当たり資本所得（ホンジュラス、1994 年値） 

所得階層 
資本所得（全体） 

(billion $) 
所得シェア 

資本所得（階層別） 
(billion $) 

資本所得（一人当たり） 
($) 

1st (poorest) 

2.997 

0.032 0.094 86.5 
2nd (poor) 0.069 0.204 187.4 
3rd (middle) 0.115 0.342 313.0 
4th (rich) 0.192 0.569 521.3 
5th (richest) 0.593 1.758 1611.2 

 
 
 
  



 

96 

(2) 家計の支出シェア 

1）必要データ  

 Household Survey （家計調査）あるいは JICA の貧困プロファイル など 
 

2）設定方法 

各国の家計調査データ、貧困プロファイル等を参照し、非耐久財支出(Food, Health, others
など)、耐久財支出(Rent, Housing, Durables など)、教育投資(Education)の 3 種に分割し、

その各シェアを求める。 

𝛨1 =
ℎ1
ℎ

 

𝛨2 =
ℎ2
ℎ

 

 
𝛨1：非耐久財支出シェア 
𝛨2：耐久財支出シェア 
ℎ1：非耐久財支出 
ℎ2：耐久財支出 
ℎ：総支出 

 
3）設定例 

ホンジュラスを例に取ると、Honduras Poverty Assessment, Document of the World 
Bank (2006) に家計支出の内訳が掲載されていたため、そのデータを用いて家計の支出シェ

アを設定した。 

表 6-14 月当たり支出の内訳（ホンジュラス、2004 年値） 

支出区分 支出内訳 小計額 (Lempira) 合計額 (Lempira) 支出比率 

非耐久財 
（消費） 

Food 600 
980 0.69 Health 139 

Others 241 

耐久財 
（物的） 

Rent 177 
353 0.25 Housing 116 

Durables 60 
教育投資 Education 89 89 0.06 
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Reference: Honduras Poverty Assessment, Document of the World Bank (2006) 
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(3) 消費c 

1）必要データ  

 Household Survey （家計調査）あるいは JICA の貧困プロファイル など 
 家計の支出シェア（前段で算出） 

 
2）設定方法 

各国の家計調査データ、貧困プロファイルを参照し、非耐久財支出(Food, Health, others)、
耐久財支出(Rent, Housing, Durables)、教育投資(Education)の 3 種に分割し、その各シェ

アを求める。階層別の家計調査がある場合は、所得シェアではなく、階層別の家計調査結果

のデータを使用する。 
消費 c は、総支出額に（2）で算出した各々の支出シェアを掛け合わせることにより算出す

る。 
ℎ = GDP− Gross Domestic Saving 

𝑐 =
ℎ ∙ 𝛨1 ∙ 𝑎𝑎

𝑛
 

 
ℎ：総支出額 

𝐺𝐷𝑃：総所得 
Gross Domestic Saving：総貯蓄 

c：階層別消費（一人あたり） 
𝛨1：非耐久財支出シェア 

𝑎𝑎：所得シェア 
𝑛：階層別人口 

 
3）設定例 

上述の方法に従い、算出した結果を以下の表に示す。 
 

表 6-15 一人あたり消費 c（2004 年値） 

消費 c Honduras Pakistan Guatemala Peru Costa Rica 

1st (poorest) 93 208 241 295 462 
2nd (poor) 243 289 545 583 1,032 
3rd (middle) 448 369 889 926 1,613 
4th (rich) 787 480 1,427 1,457 2,575 
5th (richest) 2,564 924 3,820 3,777 6,574 
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(4) 人的資本h 

1）必要データ 

 UNDP data (Mean years of schooling) 
 Household Survey （家計調査）あるいは JICA の貧困プロファイル など 

 
2）設定方法 

所得階層別の平均就学年数を人的資本の代理変数として設定する。 
 

3）設定結果 

人的資本の代理変数として、平均就学年数を使用した際の設定結果を以下の表に示す。 
 

表 6-16 人的資本（平均就学年数）の設定値（2004 年値） 

人的資本 h Honduras Pakistan Guatemala Peru Costa Rica 

1st (poorest) 3.3 3.2 3.5 8.4 7.9 
2nd (poor) 4.2  3.9  3.5  8.4  7.9  
3rd (middle) 5.0 4.2 3.5 8.4 7.9 
4th (rich) 6.0 4.4 3.5 8.4 7.9 
5th (richest) 6.9 5.6 3.5 8.4 7.9 

※Guaatemala, Peru, Costa Rica は階層別の平均就学年数データが存在しないため、各階層の初期値は同値であ

ると仮定した。 
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(5) 物的資本z 

1）必要データ  

 Household Survey （家計調査）あるいは JICA の貧困プロファイル など 
 家計の支出シェア（前段で算出） 

 
2）設定方法 

各国の家計調査データ、貧困プロファイルを参照し、非耐久財支出(Food, Health, others)、
耐久財支出(Rent, Housing, Durables)、教育投資(Education)の 3 種に分割し、その各シェ

アを求める。階層別の家計調査がある場合は、所得シェアではなく、階層別の家計調査結果

のデータを使用する。 
物的資本 z は、総支出額に（2）で算出した各々の支出シェアを掛け合わせることにより

算出する。物的資本は、耐久財支出額を利子率で割り、フロー値をストック値へ変換するこ

とで求める。 
 

ℎ = GDP− Gross Domestic Saving 

𝑧 =
ℎ ∙ 𝐻2 ∙ 𝑎𝑎

(𝐼 + DEP + HDR− CDR) ∙ 𝑛
 

 
ℎ：総支出額 

GDP：総所得 
Gross Domestic Saving：総貯蓄 

𝑧：階層別物的資産（一人あたり） 
𝛨2：耐久財支出シェア 

𝑎𝑎：所得シェア 
𝐼：利子率 

DEP：物的減耗率 
HDR：家計被害率 
𝐶𝐷𝑅：企業被害率 
𝑛：階層別人口 
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3）設定例 

上述の方法に従い、算出した結果を以下の表に示す。 
 

表 6-17 一人あたり物的資産 z（2004 年値） 

物的資産 z Honduras Pakistan Guatemala Peru Costa Rica 

1st (poorest) 112 186 364 306 498 
2nd (poor) 293 259 825 605 1,112 
3rd (middle) 540 331 1,345 962 1,738 
4th (rich) 949 429 2,158 1,513 2,775 
5th (richest) 3,091 827 5,779 3,923 7,084 
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(6) 金融資産b 

1）必要データ 

 World Bank data (by Country)を使用 
 使用する項目は ”GDP (constant 2005 US$)”、 “Income share held by lowest 

20%”、 ”Income share held by second 20%”、 ”Income share held by third 
20%”、”Income share held by fourth 20%”、”Income share held by highest 20%” 

表 6-18 金融資産の設定に必要な World Bank data 

Name of Data 

GDP (constant 2005 US$) 
Rental rate(lending rate) 
Income share held by lowest 20% 
Income share held by second 20% 
Income share held by third 20% 
Income share held by fourth 20% 
Income share held by highest 20% 

 

2）設定方法 

（1）で算出した所得分配の関係式から、資本所得は以下のように表される。 
𝐶𝐼 = GDP− 𝛼2 = �𝐼＋PCD� ∙ FA 

 
𝐶𝐼：資本所得 

GDP：総所得 
𝛼2：資本投資シェア 

𝐼：利子率 
PCD：生産資本減耗率 

FA：金融資産 
 
よって、資本所得を利子率と生産資本減耗率の和で割ることにより、金融資産を求めるこ

とができる。 

SFA =
𝐶𝐼 ∙ 𝑎𝑎

(𝐼 + PCD)𝑛
 

 
SFA：階層別金融資産（一人あたり） 

𝐶𝐼：資本所得 
𝐼：利子率 

PCD：生産資本減耗率 
𝑎𝑎：所得シェア 

𝑛：階層別人口  
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3）設定例 

（2）で算出した一人あたり資本所得を利子率と減耗率の和で割り戻すことで一人あたりの

金融資産を算出する。 

表 6-19 一人当たり金融資産（ホンジュラス、2004 年値） 

所得階層 
資本所得（一人当たり） 

($) 
利子率 減耗率 

金融資産（一人当たり） 
($) 

1st (poorest) 70 

0.199 0.02 

321 
2nd (poor) 184 842 
3rd (middle) 340 1,554 
4th (rich) 598 2,732 
5th (richest) 1,947 8,899 

 

表 6-20 一人当たり金融資産（2004 年値） 

金融資産 b Honduras Pakistan Guatemala Peru Costa Rica 

1st (poorest) 321 1297 1277 1101 1793 
2nd (poor) 842 1801 2892 2176 4005 
3rd (middle) 1554 2306 4713 3458 6259 
4th (rich) 2732 2992 7564 5440 9993 
5th (richest) 8899 5765 20256 14104 25513 
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(7) 土地面積T 

1）必要データ 

 World Bank data (by Country)を使用 
 

表 6-21 土地面積の設定に必要な World Bank data 

Name of Data 

GDP (constant 2005 US$) 
Arable Land 
Income share held by lowest 20% 
Income share held by second 20% 
Income share held by third 20% 
Income share held by fourth 20% 
Income share held by highest 20% 

  

2）設定方法 

土地面積Tは農耕地面積と仮定し、所得シェアを用いることにより階層別の値を設定する。

さらに階層別人口で一人あたりの土地面積を算出する。 

𝑇 =
𝐶𝐴 ∙ 𝑎𝑎
SPO

 

 

𝑇：一人当たり土地面積（階層別） 
𝐶𝐴：農耕地面積 

𝑎𝑎：所得シェア 
SPO：所得階層別人口 

 
3）設定例 

上述の方法に従い、ホンジュラスデータにより算出した結果を以下の表に示す。 
 

表 6-22 階層別一人当たり土地面積（ホンジュラス、1994 年値） 

所得階層 
土地面積 
（全体） 

(ha) 
所得シェア 

土地面積 
（階層別） 

(ha) 

土地面積 
（一人当たり） 

(ha) 
1st (poorest) 

1,650,000 

0.032 52,470 0.05 
2nd (poor) 0.069 113,685 0.10 
3rd (middle) 0.115 189,915 0.17 
4th (rich) 0.192 316,305 0.29 
5th (richest) 0.593 977,625 0.90 
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(8) 年間教育時間比率m 

1）必要データ  

 Household Survey （家計調査）あるいは JICA の貧困プロファイル など 
 

2）設定方法 

人的投資は教育時間のデータを利用する。ただし、開発途上国においては統計データが整

備されていない可能性が高い。 
その場合、以下の方法により、代表的個人の年間平均教育比率を設定する。 

 

 就学者は年間を通して教育を受けるものとする。（x 時間×y 日） 

◇仮定 

 勤労者は年間を通して労働を行うとものとする。（x 時間×y 日） 

 
ここで、就学者は年間を通して教育のみを、勤労者は労働のみを行うと仮定すると、一人

当たりの年間平均教育時間比率は以下のように表される。 

𝑚0 ≒
SPO

（SPO + EPO）
=

TET
（TET + TWT）

 

 

𝑚0：年間平均教育時間比率の初期値 
SPO：就学人口 

EPO：就業人口 
𝑇𝐸𝑇：教育時間の合計 
TWT：労働時間の合計 

※就学人口：世界銀行データベースにデータが存在する「Primary」と「Secondary」の生徒数の合計

として設定 

※就業人口：「Primary 入学年齢（5 歳前後）から退職年齢（65 歳）までの合計人口」から「就学人口」

を引いた人口として設定 

 
3）設定例 

人口データを用いて計算した各国の結果以下のようになる。 
 

表 6-23 年間平均教育時間比率の初期値 m0 

Country Honduras Pakistan Guatemala Peru Costa Rica 

年間平均教育時

間比率の初期値

m0 
0.33 0.18 0.31 0.31 0.26 
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(9) 人的資本減耗率δh 

1）必要データ 

 World Bank data (by Country)を使用 

表 6-24 人的資本減耗率の設定に必要な World Bank data 

Name of Data 

Death rate, crude (per 1,000 people) 

Mortality rate, infant (per 1,000 live births) 

Number of infant deaths 

Population, total 
 

2）設定方法 

人的資本減耗率δh は、人的資本保有者の死亡者数を総人口で除することにより得る。

DR2AD model において、人的資本減耗率δhは、知識の陳腐化や労働世代の入れ替わりを反

映するものとしている。 

𝛿ℎ（ ≡ CFR） =
DT − IDT

TPO
 

 
𝛿ℎ：人的資本減耗率 

CFR：死亡率 

DT：死亡者数 
IDT：乳幼児死亡者数 

TPO：総人口 
 

 
3）設定例 

以下、ケーススタディ対象国の 2004 年値を用いて設定した結果を示す。各国の人的資本

減耗率δhともに、概ね 0.4%～0.5%程度となった。 
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表 6-25 人的資本減耗率 𝛿ℎの算定（2004 年値） 

 Honduras Pakistan Guatemala Peru Costa Rica 

Death rate, 
crude (per 
1,000 people) 

5.21 7.45 5.92 5.49 4.02 

Mortality 
rate, infant 
(per 1,000 live 
births) 

26.50 81.60 34.60 23.00 9.20 

Number of 
deaths 35,239 1,155,412 73,168 150,420 17,049 

Number of 
infant deaths 5,160 329,382 14,941 14,105 720 

Population, 
total 6,762,426 155,151,394 12,367,800 27,403,845 4,246,336 

Depletion 
rate δk 0.004 0.005 0.005 0.005 0.004 

※データの出典は、「the World Development Indicator, World Bank」より 
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(10) 人的資本費用関数η 

代表的個人の人的資本（平均就学年数）のレベルに応じた人的投資費用を考慮するため、人

的投資費用関数を教育水準別（小学校、中学校、高校、大学等）に設定した。 
 

1）必要データ 

■INSTITUTE for STATISTICS, UNESCO 
 Duration by level of education 
 Government expenditure per student as % of GDP per capita 

 
■World Development Indicator, World Bank 
 Country and Lending Groups 
 GDP per capita (constant 2005 US$) 

 
2）設定方法 

教育水準別に家計が年間に教育に投じた費用と

教育時間との関係についてのデータがある場合に

はその関係を用いて、人的投資費用関数を推計する。 
データがない場合には、所得グループに応じた教

育支出率を用い簡便的に人的投資費用関数を推計

する。 
設定の手順は以下の通りである。 

 
① 学生一人あたり教育支出率の設定 

（必要データ） 

 Country and Lending Groups 
 Government expenditure per student as % of GDP per capita 

World Bank「Country and Lending Groups」で設定されている国家単位の所得グループ

別に、学生一人あたり教育支出率(% GDP per capita)を算出する。算出した値は、ユニバー

サル値として利用する。 

表 6-26 学生一人あたり教育支出率 (% GDP per capita、2004-2012 年の平均値)（単位：%） 

Income class 

 

Education Level 

Low income 
(GNI per capita 
of $1,045 or 
less) 

Lower middle 
income 
(GNI per capita 
of $1,046 to 
$4,125) 

upper middle 
income 
(GNI per 
capita of 
$4,126 to 
$12,745) 

High income: 
non OECD 
(GNI per capita 
of $12,746 or 
more) 

High income: 
OECD 
(GNI per capita 
of $12,746 or 
more) 

Primary 12.5 13.8 17.0 15.5 20.8 
Lower secondary 17.9 16.4 19.4 18.9 24.2 
Upper secondary 62.7 25.7 20.5 21.2 26.7 
Tertiary 215.1 74.3 36.3 28.9 29.4 

  

1)のデータ項目を国

独自で保有している 

1)のデータ項目を国独

自で保有していない 

 

 
①学生一人あたり教

育支出率の設定 

②学生一人あたり教

育支出額の設定（各

国固有値） 

③人的投資費用関数の設定 

④教育水準別の人的投資費用関数の設定 

年間教育時間と年

間教育支出額のデ

ータを取得 
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② 学生一人あたり教育支出額の設定（各国固有値） 

（必要データ） 

 GDP per capita (constant 2005 US$) 
 
①で求めた学生一人あたり教育支出率(% GDP per capita)を各国固有の GDP per 

capita に掛け合わせることで、各国固有の学生一人あたり教育支出額（$）を算出する。 
 

USD = EOR ∙ GDP 𝑝𝑒𝑟 𝑐𝑎𝑎𝑝𝑖𝑡𝑎𝑎(USD) 
 

𝑈𝑆𝐷：学生一人あたり教育支出額 
EOR：学生一人あたり教育支出率（％𝐺𝐷𝑃 𝑝𝑒𝑟 𝑐𝑎𝑎𝑝𝑖𝑡𝑎𝑎） 

 

表 6-27 GDP per capita (2004-2012 年の平均) (単位：USD)  

Country Honduras Pakistan Guatemala Peru Costa Rica 

GDP per capita 
(constant 2005 US$) 1,490 731 2,248 3,242 5,150 

Income class Lower-mid
dle-income 

Lower-mid
dle-income  

Lower-mid
dle-income  

Upper-mid
dle-income 

Upper-mid
dle-income 

 
 

表 6-28 学生一人あたり教育支出額（単位：USD） 

Country Honduras Pakistan Guatemala Peru Costa Rica 

Primary 205.8 100.9 310.0 555.4 880.3 

Lower 

secondary 
245.3 120.3 369.8 632.0 1001.9 

Upper 

secondary 
381.3 187.3 575.6 665.4 1056.8 

Tertiary 1092.6 536.4 1653.3 1154.8 1858.0 
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③ 人的投資費用関数の設定 
②で求めた学生一人あたり教育支出額を用いて人的投資費用関数を設定する。人的投資

費用関数は、縦軸に教育支出額η、横軸に就学年数の伸び m を取る。 
就学年数の伸び m は、一年間を通じて教育を受けた場合は m = 1、全く教育を受けなか

った場合は m = 0 となる。 
人的投資費用関数は、就学年数の伸び m が大きくなるほど教育支出額ηが乗数的に増

大するものと仮定し、その関数形は二次関数とする。人的投資費用関数の形状は他にも指

数型やロジスティック型も考えられるが、二次関数とすることで就学年数の伸び m に関

する一階条件式が解析的に解けるようになり、モデルの安定性や扱い易さが向上する。 
以下、パキスタンのデータを用いて、人的投資費用関数を設定した例である。 

表 6-29 人的投資費用関数の設定値（ホンジュラスを例に） 

Pakistan 
教育支出額 η ($) 

(2004-2012 平均値) 
就学年数の伸び m 

(years) 
人的投資費用関数 

η (m)  ($) 
Primary 205.8 1 η(m)=205.8 ㎡ 

Lower secondary 245.3 1 η(m)=245.3 ㎡ 

Upper secondary 381.3 1 η(m)=381.3 ㎡ 

Tertiary 1092.6 1 η(m)=1092.6 ㎡ 

 

 

図 6-1 人的投資費用関数の設定（ホンジュラスを例に） 

  

就学年数の伸び
m (years) 

教育支出額η($) 

1 

Tertiary 
η(m)=1092.6 ㎡ 

0 

Upper secondary 
η(m)=381.3 ㎡ 

Lower secondary 
η(m)=245.3 ㎡ 

Primary 
η(m)=205.8 ㎡ 

1092.6 

381.3 

245.3 

205.8 
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④教育水準別の人的投資費用関数の設定 

（必要データの使用） 

 Duration by level of education 
 

国別の教育水準別の標準在籍期間（duration）を参考に、教育水準別の人的投資費用関

数の使用範囲を定める。 
 

 
3）設定例 

以下の表に人的資本のレベルを考慮した人的投資費用関数を整理する。表中の Range of 
Human Capital の範囲は、標準在籍期間（duration）を基に設定している。 

 

表 6-30 人的投資費用関数（ステップ関数型） 

 
※Tertiary (Master)、Tertiary (Doctor)、Post-tertiary に関しては、Primary から Tertiary (Bachelor)までのデ

ータを基に回帰分析により導出 

  

Honduras Pakistan Guatemala Peru Costa Rica

Primary y = 205.8 ㎡ y = 100.9 ㎡ y = 310.0 ㎡ y = 555.4 ㎡ y = 880.3 ㎡ 0≦h≦6

Lower secondary y = 245.3 ㎡ y = 120.3 ㎡ y = 369.8 ㎡ y = 632.0 ㎡ y = 1001.9 ㎡ 6<h≦9

Upper secondary y = 381.3 ㎡ y = 187.3 ㎡ y = 575.6 ㎡ y = 665.4 ㎡ y = 1056.8 ㎡ 9<h≦11

Tertiary (Bachelor) y = 1092.6 ㎡ y = 536.4 ㎡ y = 1653.3 ㎡ y = 1164.8 ㎡ y = 1858.0 ㎡ 11<h≦15

Tertiary (Master) y = 1504.3 ㎡ y = 651.4 ㎡ y = 2275.5 ㎡ y = 1412.9 ㎡ y = 2256.9 ㎡ 15<h≦17

Tertiary (Doctor) y = 1918.7 ㎡ y = 820.0 ㎡ y = 2904.4 ㎡ y = 1679.8 ㎡ y = 2685.6 ㎡ 17<h≦20

Post-tertiary y = 5347.2 ㎡ y = 2064.6 ㎡ y = 8097.9 ㎡ y = 3860.1 ㎡ y = 6188.3 ㎡ 20<h≦60

Country
DurationEducation Level
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6.3.4 災害データ 

(1) 設定の手順 

災害データを用いた設定は以下の手順により実施する。 
 

1）対象とする災害の特定 

分析対象とする災害を最大２つ選定する（例：洪水、地震）。 
 

2）対象とする災害種 

分析対象国の UNISDR の DesInventar 等の災害データを用い、人的被害、家屋被害、

生産設備被害、土地被害の４つの被害率を設定する。 

HSR =
∑(DT + MS + IJ + 𝐸𝑉𝑉𝐶 + MO + AFP)

TPO
 

HDR =
CHN
THN

 𝑜𝑟 
AHN
THN

 

PDR =
PD

PDS
 

LDR =
DFL ∙ FA

FL
 

 

HSR：人的被害率 
DT：死者数 

MS：行方不明者数 
IJ：負傷者 

𝐸𝑉𝑉𝐶：避難者数 
MO：移動人口 
AFP：被災者数 

TPO：総人口 
HDR：家屋被害率 
CHN：倒壊家屋数 
AHN：影響家屋数 

THN：家屋総数 
PDR：生産設備被害率 
PD：生産設備被害額 

PDS：生産設備ストック額 
𝐿𝐷𝑅：土地被害率 

DFL：被災農地 
FA：森林面積 

FL：農耕地面積 
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※総家屋数のデータがないときは、世帯数を家屋総数のかわりに用いることも考えられ

る。 
※生産設備のストック額が把握できないときは、World Bank Indicators より各年の国

内総貯蓄を用いることが考えられる。 

表 6-31 被害データの存在状況 

 
  

EM-DAT DesInventar
Netcat-
SERVICE

Sigma
(Swiss Re)

死者数（人） ○ ○ － ○
負傷者（人） ○ ○ ○ ○
行方不明者（人） － ○ － ○
避難者数（人） － ○ － －
移動人口（人） － ○ － －
被災者数（人） － ○ － －
倒壊家屋数（戸数） － ○ － －
影響家屋数（戸数） － ○ － －

生産設備被害 被害額・損失額（米ドル） ○ ○ △ △
土地被害 農地、森林（ha） － ○ － －

○：数量が示されている　△：数量はあるが限定的　－：数量データなし

災害データベースの
災害被害指標

modelにinput
すべき被害指標

データ存在状況

人的被害

物的被害
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3）被害関数の推計 

過去に発生した被害データ等を用い、追加的な対策を行わなかった場合の被害関数を推

計する。 
被害率は災害が発生しなかったもしくは、ほぼ影響がなかった場合（ランク０）、災害が

発生した場合の 4 ランク（ランク１～４）の発生確率および被害率を設定する。 
ランク別の被害率は、発生確率を考慮して設定する（Appendix C 参照）。 

 
4）対策実施時の被害率の設定 

対策を実施した場合の災害種別ランク別の被害率を設定する。 
ハードソフトの対策効果をインプットすることで、それら対策効果のみならず、対策の

組み合わせや、対策時期の違いによる効果が計測できる。 
本バージョンでは土地被害率の対策効果は考慮しない（入力不可）。 
  

＜対策メニュー＞ 

対 策 名 対策効果 

対策なし 確率規模別に応じた被害率を設定 

ソフト対策実施 
災害発生時に予警報等による死亡や負傷等の被害の軽減が図ら

れるなど、人的被害のみ軽減できるソフト対策の効果 
 

ハード対策実施 1 堤防の整備等のインフラ整備により、人的被害のみならず、物

的被害、生産設備被害の低減が期待できるハード対策（２種類

設定可能） 
 

ハード対策実施 2 

ハード対策あり 1 
+ソフト対策 上記対策の組み合わせによる効果 

ハード対策あり 2 
+ソフト対策 上記対策の組み合わせによる効果 

シナリオ A 5 年目まで対策なし、5 年目以降はハード対策 1 を実施した場合

の効果 

シナリオ B 5 年目まで対策なし、5 年目以降はハード対策 1 を実施、10 年

目以降はハード対策 2 を実施した場合の効果 
※網掛け部の被害率を設定する必要がある。具体の被害率の設定方法は Appendix D-Ⅲを参照

のこと。 
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（2）設定例 

ケーススタディでは、災害として洪水と地震を対象に被害率を設定した。 
ハード対策 1 ではランク 1 の被害を防ぐことができ、ハード対策２では、ランク 2 の対策

を防げるものと設定した。対策に伴い、被害関数がスライドすることで、ランク 2、3、4 の

被害も軽減されるものとした。 
ソフト対策は、洪水時には人的被害が 0、地震時には効果がないものと設定した。 
1）洪水 

 
 

赤：対策なし、黄色：ハード対策１、青：対策２ 

図-6-2 人的被害関数（左）と家屋被害関数（右） 

 

表 6-32 ランク別人的被害・家計被害・生産設備被害設定結果（パキスタンの洪水を例に） 

 

 

 

0.00%

0.20%

0.40%

0.60%

0.80%

1.00%

1.20%

1.40%

0 50 100 150 200

パキスタン（洪水）

0.00%

0.10%

0.20%

0.30%

0.40%

0.50%

0.60%

0 50 100 150 200

パキスタン（洪水）

対策なし ソフト対策
ハード

対策あり1
ハード

対策あり2

パキスタン（洪水） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00%

1 46.6% 1/2～1/60 0.23% 0.00% 0.00% 0.00%

2 1.7% 1/60～1/100 0.68% 0.00% 0.13% 0.00%

3 1.0% 1/100～1/146 0.92% 0.00% 0.57% 0.17%

4 0.7% 1/146～1/200 1.11% 0.00% 0.89% 0.65%

国（災害） ランク 発生確率 確率

人的被害

対策なし ソフト対策
ハード

対策あり1
ハード

対策あり2

パキスタン（洪水） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00%

1 46.6% 1/2～1/60 0.16% 0.16% 0.00% 0.00%

2 1.7% 1/60～1/100 0.32% 0.32% 0.21% 0.00%

3 1.0% 1/100～1/146 0.42% 0.42% 0.38% 0.27%

4 0.7% 1/146～1/200 0.49% 0.49% 0.47% 0.44%

国（災害） ランク 発生確率 確率

家計被害

対策なし ソフト対策
ハード

対策あり1
ハード

対策あり2

パキスタン（洪水） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00%

1 46.6% 1/2～1/60 0.72% 0.72% 0.00% 0.00%

2 1.7% 1/60～1/100 1.43% 1.43% 0.92% 0.00%

3 1.0% 1/100～1/146 1.84% 1.84% 1.67% 1.17%

4 0.7% 1/146～1/200 2.15% 2.15% 2.08% 1.93%

国（災害） ランク 発生確率 確率

生産設備被害

確率年 確率年 

被害率 被害率 
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2）地震 

 
 
赤：対策なし、黄色：ハード対策１、青：対策２ 

図-6-3 人的被害関数（左）と家屋被害関数（右） 

 

表 6-33 ランク別人的被害・家計被害・生産設備被害設定結果（パキスタンの地震を例に） 

 

 
 

 

0.00%

0.02%

0.04%

0.06%

0.08%

0.10%

0.12%

0.14%

0.16%

0.18%

0.20%

0 50 100 150 200

パキスタン（地震）

0.00%

0.50%

1.00%

1.50%

2.00%

2.50%

3.00%

0 50 100 150 200

パキスタン（地震）

対策なし ソフト対策
ハード

対策あり1
ハード

対策あり2

パキスタン（地震） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00%

1 46.7% 1/2～1/61 0.03% 0.03% 0.00% 0.00%

2 1.6% 1/61～1/101 0.10% 0.10% 0.02% 0.00%

3 1.0% 1/101～1/146 0.14% 0.14% 0.08% 0.02%

4 0.7% 1/146～1/200 0.16% 0.16% 0.13% 0.10%

国（災害） ランク 発生確率 確率

人的被害

対策なし ソフト対策
ハード

対策あり1
ハード

対策あり2

パキスタン（地震） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00%

1 46.7% 1/2～1/61 0.53% 0.53% 0.00% 0.00%

2 1.6% 1/61～1/101 1.41% 1.41% 0.41% 0.00%

3 1.0% 1/101～1/146 1.87% 1.87% 1.34% 0.53%

4 0.7% 1/146～1/200 2.23% 2.23% 1.91% 1.53%

国（災害） ランク 発生確率 確率

家計被害

対策なし ソフト対策
ハード

対策あり1
ハード

対策あり2

パキスタン（地震） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00%

1 46.7% 1/2～1/61 2.34% 2.34% 0.00% 0.00%

2 1.6% 1/61～1/101 6.20% 6.20% 1.82% 0.00%

3 1.0% 1/101～1/146 8.24% 8.24% 5.92% 2.34%

4 0.7% 1/146～1/200 9.79% 9.79% 8.42% 6.75%

国（災害） ランク 発生確率 確率

生産設備被害

確率年 確率年 

被害率 

 

被害率 
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APPENDIX 

APPENDIX A: RESTRICTIONS OF THIS MODEL 

DR2AD model（Ver1.4）は、様々な国のデータを用いてケーススタディを実施した場合におい

ても、安定的に解を算出できるよう開発が進められた。DR2AD model（Ver1.4）ではモデルの安

定性を向上させるために、次のような制約条件を置いている。 
Ⅰ 最適値関数の係数の計算方法の簡便化 

DR2AD model（Ver1.4）の最適値関数は以下を仮定している。 

𝑉𝑉(𝑎𝑎, ℎ) = 𝜈𝜈0 + 𝜈𝜈1 ∙ 𝑎𝑎1−𝜃 + 𝜈𝜈2 ∙ ℎ1−𝜃 

ただし、𝑎𝑎は総資産、ℎは人的資本、𝜃𝜃は相対的危険回避度を表す。𝜈𝜈𝑖 ∈ {𝜈𝜈0, 𝜈𝜈1, 𝜈𝜈2}は最適値関数

の係数である。本来、最適値関数の係数𝜈𝜈𝑖は、一生涯のうちに取り得る可能性のある変数の全組

合せを考慮して回帰的に決定するものである。しかし、プログラム・アルゴリズムが非常に難解

となるため、Ver1.4 では基準年のデータ（ある一時点のデータ）を利用してキャリブレーション

により最適値関数の係数を求めた。そのため、長期的な経済成長の水準が基準年のデータに引き

摺られてしまう点が制約となる。 
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【本来の求め方（下記の例はCollocation Methodにより解いた場合）】 

 

【簡便化した求め方（今回）】 

  

V a h c m z 

V11 a1 h1 c11 m11 z11 

V12 a1 h2 c12 m12 z12 

… … … … … … 

Vkk ak hk ckk m12 z12 

a1 

 
総資産 a 

h1 

 

基準年の総資産 a、人的資
本 h、消費 c、教育時間 m、
物的投資 z を統計データ
より求める。 

ak 

 

hk 

 

基準年の統計データに合致する
ような最適値関数の係数νi をキ
ャリブレーションにより一階条
件式から求める。 

基準年をベースとする最
適値関数が求まる。 

人的資本 h 

ν0 =ν0 (a,h,c,m,z) 

ν1 =ν1 (a,h,c,m,z) 

ν2 =ν2 (a,h,c,m,z) 

a1 

 

人的資本 h 

総資産 a 

h1 

 

総資産 a と人的資本 h のグ
リッドを切り、各々の a と h
に対応する最適な消費 c、教
育時間 m、物的投資 z を一
階条件式により求める。 

ak 

 

hk 

 

考えられる全ての a と h に対応
する V の値を算出する。 

回帰分析により、最適値
関数の係数νi を求める。 

𝑉𝑉(𝑎𝑎,ℎ) = 𝜈𝜈0 + 𝜈𝜈1 ∙ 𝑎𝑎1−𝜃𝜃 + 𝜈𝜈2 ∙ ℎ1−𝜃𝜃  

𝑉𝑉(𝑎𝑎,ℎ) = 𝜈𝜈0 + 𝜈𝜈1 ∙ 𝑎𝑎1−𝜃𝜃 + 𝜈𝜈2 ∙ ℎ1−𝜃𝜃  
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Ⅱ モデル助走区間の導入 

DR2AD model（Ver1.4）は、期初の 3 年間をモデルの助走区間として設定している。 
DR2AD model（Ver1.4）は、代表的個人の完全合理的な行動を仮定しているため、シミュレー

ション結果は最適な資源配分を達成している。一方で、現実に得られる統計データは、不完全合

理的な行動の結果を含んでいるため、最適な資源配分が達成されたものではない。そのため、期

初のシミュレーション結果と期初にインプットする統計値との間に資源配分に関する不整合が生

じた。 
その結果として、不完全合理的な行動の初期値から合理的な行動結果に移行するまで 2～3 年要

しているケースが見られた。それゆえ、期初の 3 年間をモデルの助走期間として設定し、期初に

生じる不整合を棄却することとしている（アプリケーションの出力グラフは、助走期間の 3 年間

は削除されたものとなっている）。 
 

   
図 A-1 助走区間なし              図 A-2 助走区間あり 

 
上右図の助走区間ありの例では、計算期間を 23 年とし、期初の 3 年間を除く 4 期目から 23 期

目までの計算結果をグラフに出力したものである。4 期目以降、挙動が暴れる例は発生していな

い。 
 

  

期初に生じる

不整合 
期初 3 年間を除く期間で出力 
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APPENDIX B: HOW TO SET EXOGENIOUS TECHNOLOGICAL RATE 

 
Ⅰ EXOGENIOUS TECHNOLOGICAL RATE CO-EFFICIENT 

 

防災投資を検討する上で災害年の GDP の実績とモデルの GDP が合致するように、外的な技術

成長を表す変数である技術進歩係数 B0を設定する。 
 
技術進歩係数B0は生産関数をもとに、GDPを予測する際に補正値として設定する変数であり、

下記のように規定される。 
 

    𝐵0 =
GDP0

𝐻(0)𝛼1𝐾(0)𝛼2 𝑇(0)𝛼3 

 
技術成長要素 B は技術進歩率 gb に合わせて、毎年一定の成長をすると仮定しているため、 

𝐵(𝑡) = 𝐵0 ∙ (1 + 𝑔𝑏)𝑡−1 
と設定される。 
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Ⅱ EXOGENIOUS TECHNOLOGICAL RATE  

 
(1) 生産関数の残差より推計する方法 

 
TFP growth rate（以降 gb とする）は、生産関数の残差として推計する方法が一般的に用い

られる。 
 
ケーススタディでは、ホンジュラスの gb の時系列データを用いて、gb 成長関数を推計した。

基準年は 2004 年（計算期間は統計データの利用可能な 2005 年～2011 年まで）とした。 
結果、gb は、GDP の成長とともに減少する傾向が確認され、将来的にはマイナス値となる

回帰式も見られた。 
 
 

 

 
図 B-1 gb の推計 

  

TFP rate gb
t: Period 0 1 2 3 4 5 6 7
Y: GDP 9,120,240,790 9,672,095,584 10,307,270,097 10,945,102,350 11,408,284,210 11,130,848,997 11,546,149,370 11,989,031,445
N: Total population 6,762,426 6,898,825 7,037,428 7,178,436 7,322,368 7,469,844 7,621,204 7,776,669
H: Human stock (mean years of schooling) 33,812,130 32,424,478 33,779,654 35,174,336 37,344,077 38,843,189 41,154,502 42,771,680
K: Capital stock 19,405,645,752 21,612,568,226 24,684,226,554 27,383,427,502 26,635,781,164 24,160,164,907 25,758,669,483 27,146,308,804
T: Land stock 1,050,000 1,050,000 1,050,000 1,050,000 1,018,000 1,020,000 1,020,000 1,020,000
ω: Human damage rate 0.006 0.012 0.002 0.009 0.049 0.005 0.012 0.002
ψ: Capital damage rate 0.000 0.010 0.000 0.000 0.000 0.000 0.000 0.000
τ: Land damage rate 0.013 0.157 0.057 0.070 0.213 0.049 0.099 0.006
{ (1-ω) H } ^α1: Human stock share 2,636 2,579 2,640 2,681 2,703 2,809 2,875 2,939
{ (1-ψ) K } ^α2: Capital stock share 61,487 64,348 68,771 72,177 71,248 68,091 70,144 71,878
{ (1-τ) T } ^α3: Land stock share 3.0 3.0 3.0 3.0 3.0 3.0 3.0 3.0
B0: TFP coefficient 18.6 19.5 18.8 18.8 20.0 19.3 19.1 18.8
α1: Share parameter
α2: Share parameter
α3: Share parameter

TFP rate gb 0.049 0.006 0.003 0.018 0.008 0.005 0.001

Data 2004 2005 2006 2007 2008 2009 2010 2011
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(2) ＧＤＰの伸びによる技術進歩率の設定 

 
gb の設定方法として、簡易的に GDP の伸び率と技術進歩の伸びが同率と見直して設定する

ことも考えられる。 
その際、国毎の経済格差が gb の大きさに影響することが考えられるため、同様の経済規模の

国でグルーピングして推計を行うことが考えられる。 
 
今回のケーススタディにおいては、対象 5 カ国をグルーピングし設定を行うこととする。 
分析対象国 5 カ国における 1 人あたり GDP と、GDP 成長率の推移を 1960～2013 年にかけ

ての全データをプロットした結果、下図の通り、GDP の規模によらず、各国の成長率の平均は

約 4％となった。今回のケーススタディでは 4％を gb の値として用いることとした。 
 

 

図 B-2 分析対象国の一人あたり GDP と成長率の推移 

 
  

-15%

-10%

-5%

0%

5%

10%

15%
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分析対象国の１人あたりＧＤＰと成長率の推移（1960-2013）

Costa Rica Guatemala Honduras Pakistan Peru

（US$/人）

約4％ 
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APPENDIX C: DETERMINATION OF DISASTER PARAMETERS 

 
今回のケーススタディにおける被害率の設定方法を参考として示す。 
手順Ｉ、Ⅱ、Ⅲを順次実施し、ランク別の被害率を設定する。 
 

＜設定フロー＞ 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Ⅰ 各種被害率の設定 

１．災害種別として、地震、洪水を想定。 
２．災害種別に、①人的被害率、②家計被害率、③生産設備被害率を設定する 

※土地の被害率は扱っていない 
３．以下の２つの被害率についてランク別の被害率を設定する 

① HSR =
HS

TPO
 

② HDR =
𝐷𝐻𝑁
𝐹𝑁

 

 

HSR：人的被害率 
HS：人的被害（死亡・負傷等） 

TPO：人口 
HDR：家計被害率 
DHN：被害家屋数 

𝐹𝑁：世帯数 
 

 
 

 

手順Ⅰ 

 
 
手順Ⅱ 

手順Ⅲ 
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使用する統計データ ・被害データ：DesInventar（UNISDR） 
・人口データ：WDI（World Bank）等 

 
４．生産設備被害率を、家計被害率を用いて設定 

③生産設備被害＝家計被害率の 4.4 倍 で設定 

 
 

  

※ 𝐴 = 𝐵 + 𝐶 
  𝐴：生産設備被害率 
  𝐵：事業所被害 
  𝐶：生産設備被害率 
生産設備被害率＝事業所被害+公共施設被害＝1+3.4＝4.4 
  事業所被害１（＝家屋被害の１倍） 
  公共施設被害３.４（＝一般資産被害（家屋+事業所）の 1.7 倍＝（１+１）×1.7＝２×1.7） 
  一般資産被害の 1.7 倍は、日本の治水経済調査マニュアルの算定比率を引用 
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Ⅱ 被害率のランク分けの設定 

 

１．災害種別被害率別に、イベント毎の被害率をＡの被害率の考え方に基づき設定 
２．災害種別被害率別に、非毎年データの被害率を確率統計解析 
３．確率統計解析結果より、確率規模別の被害率分布曲線（指数分布）を描画 
４．期待被害率＝被害率×被害発生確率が同等なるように、確率規模 1/200 までの曲率分布曲

線を４つのランクに分割し、各ランクの被害率を設定 
 
＜ランク別の被害率の設定＞ 

 
  

1/2

別途確率統計処理により
推計された確率規模別の

被害率により推計

1/4 1/8 1/30 1/60 1/100 1/200

被害率 被害発生確率

1

1/2 1/4 1/8 1/30 1/60 1/100 1/200

×

1/2

ランク別の被害率×被
害発生確率＝期待被害
率の面積が等しくなるよ
うにランク1～4を設定

1/4 1/8 1/30 1/60 1/100 1/200

被害率曲線

＝

確率規模 確率規模

確率規模

ランク0＝災害なし
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Ⅲ 対策効果の設定 

 
対策効果については、ソフト対策については、洪水は 100％人的被害を防げるものとし、地

震については効果がないものとした。 
２つのハード対策については、下図のように対策効果を設定した。 

 
＜ハード対策実施時の対策効果の考え方＞ 

 
 
＜対策実施時の被害率の軽減効果の設定＞ 
 地 震 洪 水 

ソフト対策 ハード対策 ソフト対策 ハード対策 

人的被害率 効果なし 対策なし時の被
害関数をスライ
ドさせ、ランク１
の災害による被
害を０にできる
効果（ハード対策
２の場合はラン
ク２まで被害０） 

100％減 
対策なし時の被害
関数をスライドさ
せ、ランク１の災害
による被害を０に
できる効果（ハード
対策２の場合はラ
ンク２まで被害０） 

家屋被害率 効果なし 効果なし 

生産設備被害率 効果なし 効果なし 

 
  

1/2 1/5 1/30 1/50 1/100 1/200

被害率

確率年

ハード対策1の
計画対象規模

ハード対策2：災害ランク2の計画
対象規模の災害被害を0にできる

ハード対策1：災害ランク1の計画
対象規模の災害被害を0にできる

対策なしの際の被害率曲線

ハード対策2の
計画対象規模
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APPENDIX D: SAMPLE DATA SET (FIVE COUNTRIES) 

今回構築したアプリケーションのサンプルデータ（５カ国）のデータセットを以下に示す。 
Ⅰ Socio Economic Parameter 

Category Country HONDURAS PAKISTAN PERU GUATEMALA COSTARICA 

Deep 
Parameters 

J 5 5 5 5 5 

L 4 4 4 4 4 

rho 0.12 0.12 0.12 0.12 0.12 
theta 2 2 2 2 2 
cbar 0 0 0 0 0 

deltaz 0.1 0.1 0.1 0.1 0.1 
deltak 0.02 0.02 0.02 0.02 0.02 

gb 0.042 0.042 0.042 0.042 0.042 
iota 1 1 1 1 1 

Socio 
Economic 

Parameters 

Pop0 6762426 155151394 27403845 12367800 4246336 
GDP0 9120240790 10170413687

9 
70530831291 26352121441 18855016400 

alpha1 0.45 0.52 0.38 0.38 0.45 
alpha2 0.47 0.4 0.54 0.54 0.47 
alpha3 0.08 0.08 0.08 0.08 0.08 

Household 
Parameters  

c0 93 
243 
448 
787 

2564 

208 
289 
369 
480 
924 

295 
583 
926 

1457 
3777 

241 
545 
889 

1427 
3820 

462 
1032 
1613 
2575 
6574 

h0 3.3 
4.2  
5.0 
6.0 
6.9 

3.2 
3.9  
4.2 
4.4 
5.6 

8.4 
8.4  
8.4 
8.4 
8.4 

3.5 
3.5  
3.5 
3.5 
3.5 

7.9 
7.9  
7.9 
7.9 
7.9 

z0 112 
293 
540 
949 

3091 

186 
259 
331 
429 
827 

306 
605 
962 

1513 
3923 

364 
825 

1345 
2158 
5779 

498 
1112 
1738 
2775 
7084 

b0 321 
842 

1554 
2732 
8899 

1297 
1801 
2306 
2992 
5765 

1101 
2176 
3458 
5440 

14104 

1277 
2892 
4713 
7564 

20256 

1793 
4005 
6259 
9993 

25513 
T0 0.02 

0.05 
0.08 
0.15 
0.48 

0.06 
0.09 
0.11 
0.15 
0.28 

0.03 
0.05 
0.09 
0.14 
0.35 

0.02 
0.05 
0.08 
0.13 
0.36 

0.01 
0.02 
0.03 
0.05 
0.13 

m0 0.33 0.18 0.31 0.31 0.26 

deltah 0.004 0.005 0.005 0.005 0.005 

eta0 0 0 0 0 0 

eta1 0 0 0 0 0 

eta2M 205.8 100.9 632 310 1001.9 

eta2Mvect
or 

205.8 
245.3 
381.3 

1092.6 
1504.3 
1918.7 
5347.2 
20000 

100.9 
120.3 
187.3 
536.4 
651.4 
820.0 

2064.6 
20000 

555.4 
632.0 
665.4 
1164.8 
1412.9 
1679.8 
3860.1 
20000 

310.0 
369.8 
575.6 

1653.3 
2275.5 
2904.4 
8097.9 
20000 

880.3 
1001.9 
1056.8 
1858.0 
2256.9 
2685.6 
6183.3 
20000 
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Ⅱ Disaster parameters 
表 D-1 Input Data Sample List 1

 

without DRR soft hard1 hard2 without DRR soft hard1 hard2 without DRR soft hard1 hard2

GUATE MALA
（FLOOD）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 43.0% 1/2～1/23 1.44% 0.00% 0.00% 0.00% 0.89% 0.89% 0.00% 0.00% 3.93% 3.93% 0.00% 0.00%

2 4.3% 1/23～1/56 2.82% 0.00% 1.83% 0.00% 1.62% 1.62% 1.18% 0.00% 7.13% 7.13% 5.20% 0.00%

3 1.8% 1/56～1/112 3.61% 0.00% 3.30% 2.32% 2.09% 2.09% 1.94% 1.46% 9.20% 9.20% 8.55% 6.43%

4 0.9% 1/112～1/200 4.26% 0.00% 4.11% 3.81% 2.51% 2.51% 2.45% 2.28% 11.05% 11.05% 10.76% 10.03%

COSTA RICA
（FLOOD）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.5% 1/2～1/56 0.15% 0.00% 0.00% 0.00% 0.03% 0.03% 0.00% 0.00% 0.13% 0.13% 0.00% 0.00%

2 1.8% 1/56～1/96 0.41% 0.00% 0.09% 0.00% 0.08% 0.08% 0.02% 0.00% 0.36% 0.36% 0.08% 0.00%

3 1.0% 1/96～1/143 0.55% 0.00% 0.37% 0.12% 0.11% 0.11% 0.07% 0.02% 0.49% 0.49% 0.32% 0.11%

4 0.7% 1/143～1/200 0.65% 0.00% 0.55% 0.42% 0.13% 0.13% 0.11% 0.08% 0.58% 0.58% 0.48% 0.37%

PAKISTAN（FLOOD） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.6% 1/2～1/60 0.23% 0.00% 0.00% 0.00% 0.16% 0.16% 0.00% 0.00% 0.72% 0.72% 0.00% 0.00%

2 1.7% 1/60～1/100 0.68% 0.00% 0.13% 0.00% 0.32% 0.32% 0.21% 0.00% 1.43% 1.43% 0.92% 0.00%

3 1.0% 1/100～1/146 0.92% 0.00% 0.57% 0.17% 0.42% 0.42% 0.38% 0.27% 1.84% 1.84% 1.67% 1.17%

4 0.7% 1/146～1/200 1.11% 0.00% 0.89% 0.65% 0.49% 0.49% 0.47% 0.44% 2.15% 2.15% 2.08% 1.93%

PERU（FLOOD） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.0% 1/2～1/48 0.19% 0.00% 0.00% 0.00% 0.03% 0.03% 0.00% 0.00% 0.15% 0.15% 0.00% 0.00%

2 2.1% 1/48～1/87 0.49% 0.00% 0.16% 0.00% 0.07% 0.07% 0.04% 0.00% 0.30% 0.30% 0.19% 0.00%

3 1.1% 1/87～1/136 0.64% 0.00% 0.48% 0.21% 0.09% 0.09% 0.08% 0.05% 0.38% 0.38% 0.35% 0.24%

4 0.7% 1/136～1/200 0.75% 0.00% 0.66% 0.55% 0.10% 0.10% 0.10% 0.09% 0.46% 0.46% 0.44% 0.40%

HONDURAS（FLOOD） 0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.4% 1/2～1/54 11.00% 0.00% 0.00% 0.00% 0.02% 0.02% 0.00% 0.00% 0.08% 0.08% 0.00% 0.00%

2 1.9% 1/54～1/94 29.82% 0.00% 7.81% 0.00% 0.05% 0.05% 0.02% 0.00% 0.21% 0.21% 0.07% 0.00%

3 1.1% 1/94～1/142 40.06% 0.00% 27.34% 9.97% 0.06% 0.06% 0.05% 0.02% 0.28% 0.28% 0.21% 0.09%

4 0.7% 1/142～1/200 47.50% 0.00% 40.22% 31.32% 0.07% 0.07% 0.07% 0.05% 0.33% 0.33% 0.29% 0.24%

Country（Disaster） Rank rate Proba.

Damage rate of financial assetsDamege rate of human capital damage rate of physical asstes
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表 D-2 Input Data Sample List 2 

without DRR soft hard1 hard2 without DRR soft hard1 hard2 without DRR soft hard1 hard2

GUATE MALA
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 45.7% 1/2～1/43 0.19% 0.19% 0.00% 0.00% 0.31% 0.31% 0.00% 0.00% 1.35% 1.35% 0.00% 0.00%

2 2.3% 1/43～1/82 0.48% 0.48% 0.18% 0.00% 0.78% 0.78% 0.25% 0.00% 3.43% 3.43% 1.09% 0.00%

3 1.2% 1/82～1/133 0.63% 0.63% 0.50% 0.24% 1.03% 1.03% 0.75% 0.32% 4.51% 4.51% 3.32% 1.41%

4 0.8% 1/133～1/200 0.75% 0.75% 0.67% 0.57% 1.21% 1.21% 1.06% 0.87% 5.33% 5.33% 4.67% 3.82%

COSTA RICA
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.4% 1/2～1/54 0.46% 0.46% 0.00% 0.00% 0.44% 0.44% 0.00% 0.00% 1.95% 1.95% 0.00% 0.00%

2 1.9% 1/54～1/95 1.29% 1.29% 0.33% 0.00% 1.18% 1.18% 0.34% 0.00% 5.20% 5.20% 1.51% 0.00%

3 1.1% 1/95～1/142 1.72% 1.72% 1.18% 0.40% 1.58% 1.58% 1.13% 0.44% 6.95% 6.95% 4.96% 1.95%

4 0.7% 1/142～1/200 2.05% 2.05% 1.72% 1.33% 1.87% 1.87% 1.61% 1.29% 8.21% 8.21% 7.10% 5.67%

PAKISTAN
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.7% 1/2～1/61 0.03% 0.03% 0.00% 0.00% 0.53% 0.53% 0.00% 0.00% 2.34% 2.34% 0.00% 0.00%

2 1.6% 1/61～1/101 0.10% 0.10% 0.02% 0.00% 1.41% 1.41% 0.41% 0.00% 6.20% 6.20% 1.82% 0.00%

3 1.0% 1/101～1/146 0.14% 0.14% 0.08% 0.02% 1.87% 1.87% 1.34% 0.53% 8.24% 8.24% 5.92% 2.34%

4 0.7% 1/146～1/200 0.16% 0.16% 0.13% 0.10% 2.23% 2.23% 1.91% 1.53% 9.79% 9.79% 8.42% 6.75%

PERU
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 45.4% 1/2～1/39 0.54% 0.54% 0.00% 0.00% 0.63% 0.63% 0.00% 0.00% 2.79% 2.79% 0.00% 0.00%

2 2.6% 1/39～1/77 1.32% 1.32% 0.55% 0.00% 1.60% 1.60% 0.51% 0.00% 7.03% 7.03% 2.22% 0.00%

3 1.3% 1/77～1/128 1.75% 1.75% 1.40% 0.71% 2.06% 2.06% 1.56% 0.69% 9.04% 9.04% 6.87% 3.05%

4 0.8% 1/128～1/200 1.99% 1.99% 1.86% 1.64% 2.42% 2.42% 2.14% 1.80% 10.63% 10.63% 9.40% 7.90%

HONDURAS
（EARTHQUAKE）

0 50.0% ～1/2 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

1 46.8% 1/2～1/64 0.03% 0.03% 0.00% 0.00% 0.13% 0.13% 0.00% 0.00% 0.59% 0.59% 0.00% 0.00%

2 1.6% 1/64～1/104 0.09% 0.09% 0.01% 0.00% 0.37% 0.37% 0.09% 0.00% 1.64% 1.64% 0.40% 0.00%

3 1.0% 1/104～1/149 0.12% 0.12% 0.07% 0.02% 0.50% 0.50% 0.34% 0.12% 2.20% 2.20% 1.48% 0.52%

4 0.7% 1/149～1/200 0.15% 0.15% 0.12% 0.08% 0.60% 0.60% 0.50% 0.39% 2.62% 2.62% 2.20% 1.70%

Country（Disaster） Rank rate Proba.

Damage rate of financial assetsDamege rate of human capital damage rate of physical asstes
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APPENDIX E: PROGRAMING ALGORITHM FLOW 

 
以上により構築したプログラムは下記の計算アルゴリズムに従って実行される。 

プログラムのアルゴリズムは下記に示すとおりである。 
 
Ⅰ プログラム全体の計算アルゴリズムフロー 
 

 
  

Main14MonteCarlo 

 

EconomicGrowthMonteCarlo 
 

終了 

開始 

SocioEconomicParameters 

 

Calibration14 
 

DisasterClassProcessMonteCarlo 
 

DisasterProbability 

  

DisasterDamageRate 

  

DR2ADModel 

(GUI) 

全防災対策のｷｬﾘ
ﾌﾞﾚｰｼｮﾝの完了 

Figure14MonteCarlo 

No 

パ
ラ
メ
ー
タ
の
入
力
（
社
会
経
済
・
災
害
被
害
率
・
災
害
発
生
確
率
デ
ー
タ
） 

最適値関数の 

キャリブレーション 

災害発生パターン 

の決定 

社会的最適化問題 

Yes 
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Ⅱ キャリブレーションの計算アルゴリズムフロー 

 

 
 

  

Calibration14 

終了 

ニュートン法 

誤差の範囲内か 

開始 

Read data 

係数𝜈𝜈0,𝜈𝜈1,𝜈𝜈2の算出 

係数𝜈𝜈0,𝜈𝜈1,𝜈𝜈2の算出 

 

Yes 

No 

キャリブレーション 
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Ⅲ 災害ランクの決定アルゴリズムフロー 

 

 
 

  

DisasterClassProcessMonteCarlo 

開始 

Read data 

乱数 xの発生 

t 期の災害規模の決定 

災害規模 0 災害規模 1 災害規模 2 災害規模 3 災害規模 4 

終了 

𝑡 <= 𝑇𝑇𝑇 − 1 

期毎の計算 

1 ≤ 𝑥 < ∑ 𝜇𝑙1
𝑙=0   ∑ 𝜇𝑙1

𝑙=0 ≤ 𝑥 < ∑ 𝜇𝑙2
𝑙=0   

∑ 𝜇𝑙2
𝑙=0 ≤ 𝑥 < ∑ 𝜇𝑙3

𝑙=0   

∑ 𝜇𝑙4
𝑙=0 ≤ 𝑥 ≤ 1  

Disaster2 

災害種が複数 

Yes 

No 

∑ 𝜇𝑙3
𝑙=0 ≤ 𝑥 < ∑ 𝜇𝑙4

𝑙=0   
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Ⅳ 経済成長の計算アルゴリズムフロー 

 

 

EconomicGrowthMonteCarlo 

No 

No 

Yes 

Yes 

開始 

Read data 

c𝑙∗, m𝑙∗, 𝑧∗の導出 

𝑡 <= 𝑇𝑇𝑇 − 1 

期毎の計算 

𝑏∗の導出 

𝐴𝑙∗, 𝐻𝑙∗の導出 

災害ランク𝑙(𝑡)の決定 

 

T+1 期の初期値 

𝑎𝑎(𝑡 + 1),ℎ(𝑡 + 1)の決定 

 

終了 

階層別の計算

𝑗 <= 𝐽 
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